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Introduction Read this Instruction Manual 
thoroughly before using the 
product.

Thank you for purchasing Shimadzu analytical instrument 
workstation "LabSolutions" (hereafter referred to as "the 
software" or "LabSolutions").

This manual describes the procedures for operating this 
product. Read this manual thoroughly before using the 
product and operate the product in accordance with the 
instructions in this manual.

Also, keep this manual for future reference.

This manual assumes that the reader is knowledgeable of 
basic operations of Windows. For the operation of Windows, 
refer to the instruction manual that comes with that product.

Important • If the user or usage location changes, ensure that this 
Instruction Manual is always kept together with the 
product.

• If this manual is lost or damaged, immediately contact your 
Shimadzu representative to request a replacement.

• To ensure safe operation, contact your Shimadzu 
representative if product installation, adjustment, or re-
installation (after the product is moved) is required.

© 2010-2017 Shimadzu Corporation All rights reserved.
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Notice • LabSolutions software expands/limits its functions and 
controllable instruments according to the LabSolutions 
license. Please note that, depending on your license, 
some functions or instruments in this manual are not 
shown, or some windows styles in this manual may differ 
from those in the software.

• Information in this manual is subject to change without 
notice and does not represent a commitment on the part of 
the vendor.

• Any errors or omissions which may have occurred in this 
manual despite the utmost care taken in its production will 
be corrected as soon as possible, although not necessarily 
immediately after detection.

• All rights are reserved, including those to reproduce this 
manual or parts thereof in any form without permission in 
writing from Shimadzu Corporation.

• Microsoft and Windows are registered trademarks of 
Microsoft Corporation in the United States and/or other 
countries.
Adobe, Adobe logo and Adobe Reader are trademarks or 
registered trademarks of Adobe Systems Incorporated in 
the United States and/or other countries.
Other company names and product names mentioned in 
this manual are trademarks or registered trademarks of 
their respective companies. The TM and  symbols are 
omitted in this manual.

• Replacement parts for this product will be available for a 
period of seven (7) years after the product is discontinued. 
Thereafter, such parts may cease to be available. Note, 
however, that the availability of parts not manufactured by 
Shimadzu shall be determined by the relevant 
manufacturers.

Original version is approved in English.
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 List of Instruction Manuals

 Indications Used in Instruction Manuals
Cautions and Notes are indicated using the following conventions, and the following symbols are 
used in this manual:

Instruction Manuals

Name Content

Getting Started Guide This manual follows an actual data acquisition procedure to 
describe basic methods of operation for first-time users. 
Read this manual to learn basic operations of the software.

Operators Guide This manual describes overall operations and handy 
functions in more details, such as the software's system 
configuration, data analysis, batch processing, confirmation 
of data acquisition results, and report functions.

System Users Guide This manual describes system administration and data 
management of the software. Refer to this manual as 
necessary.

Installation & Maintenance 
Guide

This manual describes installation and maintenance of the 
software.

Data Acquisition & Processing 
Theory Guide

This manual describes peak detection and quantitation of 
sample components. 
Refer to this manual as necessary.

Help Clicking the on-screen [Help] button or pressing the [F1] key 
displays a description of on-screen parameters, answers to 
specific questions or solutions to various problems. Also, 
clicking the [Help] button on the error message window 
displays the details of the error or solutions to the error. Be 
sure to refer to Help before contacting us.

Indication Meaning

! CAUTION Indicates a potentially hazardous situation which, if not 
avoided, may result in minor to moderate injury or equipment 
damage.

Emphasizes additional information that is provided to ensure 
the proper use of this product.

^ Reference Indicates the location of related reference information.

[ ] Indicates the names of buttons, menu options, setting 
options, windows/sub-windows, and icons that are displayed 
in a window.
Example: Click [OK].
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Warranty Shimadzu provides the following warranty for this product.

1. Period: Please contact your Shimadzu representative for information about the 
period of this warranty.

2. Description: If a product/part failure occurs for reasons attributable to Shimadzu 
during the warranty period, Shimadzu will repair or replace the 
product/part free of charge (including USB dongles). However, in the 
case of products which are usually available on the market only for a 
short time, such as personal computers and their peripherals/parts, 
Shimadzu may not be able to provide identical replacement products.

3. Limitation of 
Liability:

(1) In no event will Shimadzu be liable for any lost revenue, profit or 
data, or for special, indirect, consequential, incidental or punitive 
damages, however caused regardless of the theory of liability, 
arising out of or related to the use of or inability to use the product, 
even if Shimadzu has been advised of the possibility  of such 
damage.

(2) In no event will Shimadzu’s liability to you, whether in contract, tort 
(including negligence), or otherwise, exceed the amount you paid 
for the product. 

4. Exceptions: Failures caused by the following are excluded from the warranty, even 
if they occur during the warranty period.

1) Improper product handling

2) Repairs or modifications performed by parties other than Shimadzu 
or Shimadzu designated companies

3) Product use in combination with hardware or software other than 
that designated by Shimadzu

4) Computer viruses leading to device failures and damage to data 
and software, including the product's basic software

5) Power failures, including power outages and sudden voltage drops, 
leading to device failures and damage to data and software, 
including the product's basic software

6) Turning OFF the product without following the proper shutdown 
procedure leading to device failures and damage to data and 
software, including the product's basic software

7) Reasons unrelated to the product itself

8) Product use in harsh environments, such as those subject to high 
temperatures or humidity levels, corrosive gases, or strong 
vibrations

9) Fires, earthquakes, or any other act of nature, contamination by 
radioactive or hazardous substances, or any other force majeure 
event, including wars, riots, and crimes

10)Product movement or transportation after installation

11) Consumable items
Note: Recording media such as floppy disks and CD/DVD-ROMs 
are considered consumable items.

* If there is a document such as a warranty provided with the product, or there is a separate contract agreed upon 
that includes warranty conditions, the provisions of those documents shall apply.

* Warranty periods for products with special specifications and systems are provided separately.

* The license cannot be reissued if you lose the license certificate or the USB dongle.
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1What is LabSolutions?

This software is a workstation for high-performance liquid chromatograph systems(hereafter referred 
to as "LC") or  for gas chromatograph systems(hereafter referred to as "GC") . 

It enables control of LC or GC from a personal computer (PC), and perform tasks such as 
chromatogram data acquisition, data analysis, reports generations, and data management. 

This chapter introduces the main features and functions of the software. 

1.1 Features

 Abundant Functions with Simple Operations

Assistant Bar

Click an icon on the assistant bar to change the display to the target operation sub-window. Icons 
displayed on the assistant bar can be customized to support a wide variety of operations. 

Data Explorer

The file content is displayed by dragging-and-dropping the file from the [Data Explorer] sub-window onto 
the target sub-window. 

Outstanding file management functions are provided for copying, moving, and deleting files, and for 
browsing the history information of files. 

Batch Table Wizard

Batch Tables for sequential analysis of multiple samples are easily set  by following the on-screen 
instructions. 

Compound Table Wizard

Peak integration parameters for chromatograms through to Compound Tables for quantitative calculation 
can be easily made by following on-screen instructions. 

Data Browser

The [Data Browser] window enables import and browsing of up to 64 data files.

Quant Browser

The [Quant Browser] window enables browsing of multiple quantitative calculation results that were 
acquired using the same method.

 Enhanced Identification and Quantitative Processing Functions

This software supports a variety of identification methods such as window, band, spectrum similarity, 
absolute retention time and relative retention time. There are 6 different quantitative calculation methods 
that include the external and internal standard methods, and 7 types of calibration curves such as linear 
and exponential. 
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 Highly Flexible Report Format

The report format function offers a high degree of flexibility by allowing creation of reports such as 
chromatograms, calibration curves, quantitative results, summary reports, and data analysis reports. 

This software has a substantial selection of pre-installed report format templates, making it easier to create 
the desired report format. 

 Enhanced GLP/GMP Support Functions

The software contains functions that provide sure and efficient compliance with reliability requirements 
mandated in various regulations such as GLP/GMP and FDA 21CFR Part 11. 

FDA 21 CFR Part11 Compliance

The electronic record and electronic signature functions of this software comply with the requirements of 
21 CFR Part 11.

Information such as data measurement methods, schedules, date/time, operator name, and 
chromatograms can all be saved at once, and human and machine readable data can be saved together 
as required for compliance with Part 11.

When used in combination with the optional CLASS-Agent Manager, this software meets the Part 11 
requirements for electronic records and electronic signatures for review, approval and long-term storage of 
data.

User Administration

The Shimadzu User Authentication Tool administers users on the Shimadzu network. Account policies 
such as the minimum number of characters in passwords, password update interval, and permitted number 
of entry attempts are set to prevent illegal accessing. 

System Administration

The software is also has an audit trail function and log browser function for sure and efficient operation of 
the system. The audit trail function records a history of changes to instrument parameters and data 
processing parameters, and the log browser function allows for a quickly search of the system operation 
history. 

 Ensuring File Compatibility

Method files and data files from previous version workstations (LCsolution, GCsolution, CLASS-LC10, 
CLASS-GC10 etc.) can be loaded directly to this software. Also, files in the international standard AIA 
(ANDI) format are supported. 

The functions have been efficiently arranged to allow the extensive range of functions to be easily put to 
effective use. 
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1.2  Basic Knowledge

1

1.2 Basic Knowledge

The software is comprised of the following programs:

Each of these programs are opened from the [LabSolutions Main] window.

This section describes how to open the [LabSolutions Main] window and the functions contained therein. 

 Open the [LabSolutions Main] Window

The  (LabSolutions) icon is displayed on the Desktop. 

1 Verify that the [LabSolutions Service] icon in the Systray on the Taskbar displays a 

green chromatogram. 

A yellow chromatogram in the [LabSolutions Service] icon indicates that the software is still initializing. Wait 
for the chromatogram to turn green. A red chromatogram in the [LabSolutions Service] icon indicates that an 
error has occurred. Restart the PC. 

2 Double-click the  (LabSolutions) icon on the Desktop. 

3 Select a registered user ID from the [User ID] list, enter the [Password] and click [OK]. 

Select [Admin] in the [User ID] list for the first login to the system, and click [OK]. 

Program Name Contents

[Realtime Analysis] program Used to enter the data acquisition parameters and acquire the data. 

[Offline Editor] program Allows other method files and batch files to be edited during data 
acquisition, and can register a single or batch data acquisition to the data 
acquisition queue. 

[Postrun Analysis] program Analyzes the acquired data to detect the peaks of chromatogram and 
perform quantitative calculations on these peaks. 

[Browser] program Allows importing and browsing of up 64 data files. 

[Security Policy Settings] program
[User Administration] program

Administers the system security and user accessibility to the software. 
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The [LabSolutions Main] window opens. 

 [LabSolutions Main] Window

The [LabSolutions Main] window displays an icon bar and a box for selecting a specific operation of a 
selected icon. 

• Depending on the specific user’s rights, the program icons in the icon bar of the [LabSolutions Main] 
window are sometimes not displayed or are disabled. 

• Click  at the top right corner of the sub-window to close the [LabSolutions Main] window. 

Icon Bar Explanation

Click this icon to display icons for each of the instruments connected to the PC. Tables or icons can 
be displayed in the [Instruments] sub-window. Right-click on the [Instruments] sub-window, and click 
[Table View] from the displayed menu. The display changes to the table display. 
Double-click an instrument icon to open the [Realtime Analysis] program. The [Realtime Analysis] 
program is used to set the data acquisition parameters, acquire data and check the operating status 
of the instruments. 

[Table View]

Click this icon to open either the [Postrun Analysis] program to analyze data or the [Browser] 
program to display chromatograms and statistical calculation results from multiple data files. 

Click this icon to perform system administration functions related to the security policy, user 
administration, system settings, and validation. 

Click this icon  to select a specific PDF formatted Instruction Manual or the Help files. 
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 Basic Functions of the [Realtime Analysis] and [Postrun Analysis] Programs

This section describes the [Data Acquisition] window in the [Realtime Analysis] program. 

No. Explanation

1 The title bar displays the name of the currently running program, window name, currently loaded file name, 
logged in user name, and other information. 

2 The menu bar displays the menus that are enabled according to the current window and rights of the logged in 
user. 

3 The toolbar displays icons for frequently used menu items and icons for operating analytical instrument. 

4 Different sub-windows such as [Data Acquisition] and [Realtime Batch] can be displayed in this section of the 
[Realtime Analysis] program. 
Sub-windows such as [Data Analysis], [PDA Data Analysis], [Calibration Curve], and [Report] are displayed in 
the [Postrun Analysis] program. Use the tabs under each sub-window or the icons in the assistant bar to 
change the displayed window. 

5 The [Instrument Monitor] displays the status of the instruments and the parameter settings.

6 The [Output Window] displays a history of data acquisition operations and error messages that occur.

7 The [Data Explorer] sub-window displays the currently selected folder with the project file types (extensions) 
selectable from the lower tabs. The content of files is displayed by dragging-and-dropping the file in the [Data 
Explorer] sub-window onto the data analysis sub-window. 

8 The assistant bar displays icons for the frequently used data acquisition operations. Click an icon on the 
assistant bar to change the data analysis sub-window. Icons displayed on the assistant bar can be customized 
to support a wide variety of operation flows. 

9
Click  to exit the program. 

1

2

3

9

8

7

6

4

5
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1.3 File Formats

The software uses the following file formats to handle acquired data and related information:

• Method files

• Data files

• Report format files

• Batch files

• UV spectrum files

• Other files

This section describes each of the file formats. 

1.3.1 Method Files
Method files store information such as instrument parameters and data processing parameters. 

The file extension for method files is “.lcm” for LC, and is “.gcm” for GC.

Method files store the following information.

1.3.2 Data Files
The software stores the method files, batch files and report format files, chromatogram data, and 
quantitation results in a single data file. This is called an “All-In-One” structure and, since the data 
acquisition and analysis parameters are referenced from the same data file, it ensures the traceability of 
data.

The file extension for data files is “.lcd” for LC, and is “.gcd” for GC.

• The report formats are also saved to the data file. Click [Data Report] on the [File] menu, then select 
[Print] to print the acquisition results of the currently loaded data file according to the report format stored 
with that data.
The report format can be edited by clicking the [Data Report] icon in the [Data Analysis] assistant bar to 
display the [Report] window. Click [Save Report Format File As] on the [File] menu to save the edited 
format for use with other data reports.

• When postrun analysis is performed on chromatogram data, the new data processing parameters are 
saved to the data file. [Apply to Method] on the [Data Analysis] assistant bar or [PDA Data] assistant bar 
must be clicked to save the parameters and allow them to be applied to other chromatogram data. 

^ Reference
Refer to "6.7 Save (Export) to Method Files" P.174 for more information.

Stored Information Explanation

System Configuration 
Information

System configuration information is saved in the method files to allow for review of the 
instrument parameters.

Instrument Parameters This information includes the instrument parameters for each instrument and also the 
baseline evaluation results.

Data Processing 
Parameters

Calibration curve information, column performance parameters, QA/QC parameters, 
peak integration parameters, identification parameters, quantitative parameters, and 
Compound/Group Tables are all saved in the method file. 

Sub-Window Properties The chromatogram XY range setting, whether the status bar is displayed or hidden, 
etc. are also saved in the method file.
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1.3.3 Report Format Files
Items such as pictures or logos and placeholders for chromatograms, results and etc., are pasted into the 
blank format and it is saved for future printing of data acquisition results.

The file extension for report format files is “.lsr”.

If a report format file is set at the time of data acquisition or postrun analysis, the results can be 
immediately printed according to that format.

^ Reference
Refer to "8 Report Function" P.225 for information on how to set the batch file.

1.3.4 Batch Files
Data such as sample information and quantitative calculation conditions, are saved to a batch file during 
sequential measurement of multiple samples.

The item displayed in the Batch Table and the overall batch processing parameters are also saved to the 
batch files.

The file extension for batch files is “.lcb” for LC, and is “.gcb” for GC.

^ Reference
Refer to "4 Realtime Batch" P.65 for information on how to set the batch file.

1.3.5 UV Spectrum Files
The software uses the JCAMP format with the file extension of “.jcm” for the UV spectrum file.

When peak identification using the similarity of UV spectra is performed, jcm files are included in the 
Compound Table as standard spectrum.

The “.jcm” files can also be registered as spectra to the UV library files. 

1.3.6 Other Files
The software uses the following files in addition to those described above.

File Name Contents

UV Library Files These files contain multiple UV spectrum data. They are used to perform library 
searches on the spectrum information for unknown samples.
The file extension is “.llb”.

Browsing Files These files store information such as compound information displayed in [Quantitative 
Results View] and the names of method and data files loaded in the [Quant Browser] 
window.
The file extension is “.lcq”.

Layout Files These files store information such as data file names and display layouts loaded in 
[Data Browser].
The file extension is “.lyt”.

System Configuration Files These files hold the link information for the PC and analytical instruments, names of the 
instruments that make up the system, and information on consumables. These file 
names are not used for regular operations.

PDF Files This files contain electronic versions of printed reports.
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2LC Data Acquisition

This chapter describes the basic flow of operations from entrance of the data acquisition parameters 
to the performance of a single run data acquisition on the LC. 

2.1 [Data Acquisition] Window

Two views of the [Data Acquisition] window are available, the [Chromatogram View] is used to display 
chromatograms and instrument status information and the [Instrument Parameters View] is used to display 
the parameters set for each instrument. 

2.1.1 Open the [Data Acquisition] Window

1 Click the  icon.

2 Select and double-click the instrument that will be used for data acquisition. 

The [Realtime Analysis] program opens. 
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3 Click the  (Data Acquisition) icon on the [Main] assistant bar. 

If the  (Data Acquisition) icon is not displayed, click  on the title of the assistant bar. 

4 Ensure that [Ready] is displayed on the status display in the [Data Acquisition] window. 

If [Not Connected] is displayed on the status display, refer to "3.2 The Instrument Is Not Properly 
Recognized" in the Installation & Maintenance Guide. 
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2.1  [Data Acquisition] Window
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2.1.2 [Data Acquisition] Window Description
This section describes how to view and use the [Data Acquisition] window. 

No. Explanation

1 Displays the [Standard] toolbar, [Data Acquisition] toolbar, [Instrument Control] toolbar,  [LC Control] toolbar, 
and [PDA Control] toolbar. 

2 Displays chromatograms and the instrument status curves. 
A [PDA] tab is displayed when a PDA is configured. 

^ Reference
Refer to "2.3.1 Monitor the Chromatograms and Instrument Status Curves" P.15  to display the status 
information of instruments. 

3 Displays the instrument status and parameter settings. 

4 Click  to transfer the data acquisition settings set in [Instrument Parameters View] to the analytical 

instrument. 

^ Reference
Refer to "2.2.2 Analytical Instrument Startup" P.14 for details. 

5 Displays the instrument parameters for data acquisition. 
In the [Normal] sub-window, the main data acquisition parameters are set on the [Simple Settings] and [LC 
Time Prog.] tabs. 
In the [Advanced] sub-window, the tab for each configured instrument module is displayed so that data 
acquisition parameters can be set in more detail. 

6 Switches between the full screen and normal display. 

[Chromatogram View]2

6

Toolbar1

5 [Instrument Parameters View] 3 [Instrument Monitor]4
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2.2 Enter Data Acquisition Parameters

Enter the data acquisition parameters in [Instrument Parameters View]. 

The parameters are saved to the method file and used to perform data acquisition. 

This section describes the operations in the [Instrument Parameters View]. 

2.2.1 Set the Instrument Parameters
[Instrument Parameters View] has two sub-windows, [Normal] and [Advanced]. 

In the [Normal] sub-window, the main data acquisition parameters are set on the [Simple Settings] and [LC 
Time Prog.] tabs. In the [Advanced] sub-window, a tab for each configured instrument module is displayed 
so that data acquisition parameters can be set in more detail. 

This section describes how to set the data acquisition parameters and create a method file. 

1 Click [Normal] to open the [Normal] sub-window. 

2 Click the [Simple Settings] tab and enter the data acquisition parameters. 

Set the [LC Stop Time], pump flow rate and initial concentration for gradient systems, oven temperature, 
detector wavelength and other parameters. 

• Enter the data acquisition time from one sample injection to the next sample injection at [LC Stop 
Time]. 

• Click [Apply to All acquisition time] to set the [End Time] for each detector to the same value as [LC 
Stop Time]. 

• Deselect [Oven] when the oven is not used.

To switch the detector lamp off, make this setting on the respective detector in the [Advanced] sub-
window. 
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3 Click the [LC Time Prog.] tab, and enter the concentration gradient conditions. 

Enter [Time], [Module], [Command], and [Value] in the time program to change the concentration gradient 
and valve during data acquisition.
Click [Draw curve] to draw the gradient condition in the time program in a graph. 

The time entered in the [Time] column of the time program corresponds to the time elapsed since the 
start of analysis. Enter a value of at least 0.01 min. 

4 Click [Save Method File As] on the [File] menu. 

The [Save Method File As] window is displayed.

5 Enter the file name, and click [Save]. 

A method file is created with the specified file name and the new instrument parameters are saved to the 
file. 

• The [Autopurge] tab is displayed when an autosampler is used. 
Refer to "2.3.2 Auto-Purge the Pump and Autosampler" P.19 for details. 

• If a new method file is made and the rack set at [Sample Rack] on the [Autosampler] tab does not match 
the actual rack in use, an error message is displayed and data acquisition cannot be started.
Click [Detect Rack] on the [Autosampler] tab in the [Advanced] sub-window to correct the rack selection.
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2.2.2 Analytical Instrument Startup
This section describes how to transfer (download) instrument parameters to an analytical instrument and 
the procedure for starting the instrument. 

1 Drag-and-drop the desired method file onto the [Data Acquisition] window from the 
[Data Explorer] sub-window. 

If the [Data Explorer] sub-window is not displayed, click the  (Toggle Data Explorer) button on 

the tool bar. 

The content of the method file is displayed in the [Data Acquisition] window. 

2 Check the instrument parameters, and click . 

The instrument parameters are transferred to the analytical instrument. 

3 Click the  (Instrument On/Off) button on the toolbar. 

Pump solvent delivery and oven temperature control are started. 

If the instrument is already activated when the method file is downloaded, operations are started 
using the downloaded instrument parameters. 
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2.3  Data Acquisition Preparation
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2.3 Data Acquisition Preparation

This section describes the procedures to perform before starting data acquisition, such as auto-purging of 
the pump and autosampler, and verification of column equilibration (baseline check). 

2.3.1 Monitor the Chromatograms and Instrument Status Curves
This section describes how to monitor chromatograms displayed in [Chromatogram View] and instrument 
status curves. 

 Chromatogram Display Settings

The chromatogram display scale can be changed. 

This section describes how to monitor chromatograms on multiple channels. 

1 Right-click on the graph in [Chromatogram View], and click [Display Settings]. 
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2 Click the [LC] tab and enter the necessary parameters. 

1 Click [Overlay] to draw chromatograms overlaid. 

2 Enter the detector intensity range for the Y-axis. 
Click [Normalize] so that the intensity range falls within the minimum and maximum values of the 
currently displayed chromatogram. 

3 Select the detector (or channel in Dual Mode) and the display unit for the Y-axis. 

The intensity range of each detector (or channel in Dual Mode) cannot be set in the [Overlay] 
mode.

1

2

3
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3 Click the [General] tab, enter the necessary parameters, and click [OK]. 

1 Select [Sample Name], [Sample ID] and [Data Comment]. 

The sample information is displayed in the status display of the [Data Acquisition] window. 

2 Enter the [Time Range] for the X axis display range. 
Click [Normalize] to set the display range of the X-axis to either the [LC Stop Time] currently set in 
the method file or the longest detector acquisition time. 

4 Click the  (Save) button on the toolbar. 

The time range and intensity range are saved to the method file. 

• Settings other than the time range and intensity range are stored to memory for each user and 
instrument. 

• The [PDA] and [UV Spectrum] tabs are displayed when a PDA detector is used. 

• Click [Plot] to monitor the multi chromatograms of the PDA detector. 
When the plot is started, the system status changes to [Plot]. 
Click [Stop] again to stop the plot. 

• The reference chromatogram is drawn overlaying [Chromatogram View]. 
Click [Open Reference Data File] in the [File] menu to select and display the reference 
chromatogram. 

1

2
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 Display Instrument Status Curves

The instrument status curves that can be displayed on the graph in [Chromatogram View] include [Pump 
Press.], [Oven Temp.], [Room Temp.], and [Detector Cell Temp.]. 

1 Right-click on the graph in [Chromatogram View], and click [Display Settings]. 

2 Click the [Status] tab, enter the necessary parameters, and click [OK]. 

1 Select the desired display items in [Draw Status Curve].  

2 Set the display range for each status item.

3 Select the type of status to display on the intensity axis on the right of the graph. 

1

2

3
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The selected status is displayed on the graph. 

Settings are stored to memory for each user and instrument. 

2.3.2 Auto-Purge the Pump and Autosampler
The mobile phase in the pump and the autosampler syringe rinse solution can be automatically purged. 

A function is also provided to deliver solvent at a lower mobile phase flow rate after the autopurge ends 
until the column oven reaches its preset temperature. 

Autopurge is executed in the following order: purging of pump  purging of autosampler  purging at 
initial concentration conditions (when pump mode is other than Isocratic)  warm up. 

The [Autopurge] tab is displayed when an autosampler is used. 

1 Click the [Autopurge] tab in [Instrument Parameters View], and set the autopurge 

conditions for the pump. 

1 Select the lines to be purged from the [Mobile Phase Name] list. 

2 Enter a [Purge Time] for each line. 

1 2
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2 Set the autopurge conditions for the autosampler. 

1 Select [Autosampler] . 

2 Enter the [Purge Time]. 

3 Set the [Warm-up] conditions. 

1 Enter the [Wait time] and [Flow]. 

• [Warm up] is used to deliver solvent at a lower flow rate after purging of the autosampler ends 
until the oven reaches its preset temperature. 

• Enter “0” min at [Wait time] to disable the [Warm up] function. 

4 Click the  (Save) button on the toolbar. 

The settings are saved to the method file. 

21

1
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5 Click the  (Autopurge) button on the toolbar. 

Autopurge is started. 

• Click the  (Purge autosampler) button on the toolbar. The purge is executed by [Purge Time] set on 

the [Autosampler] tab. 

• After the autopurge ends, column equilibration can be checked using the baseline check function. 

^ Reference
Refer to "2.3.3 Check the Baseline" P.21 for information on the baseline check procedure. 

2.3.3 Check the Baseline
Use the baseline check function to determine whether the baseline noise and drift values are within the 
preset time and at or below the threshold for each channel. 

1 Click [Baseline Check Parameters] from the [Method] menu in the [Data Acquisition] 

window. 

2 Set the baseline check parameters, and click [OK]. 

1 Select the noise calculation method.

2 Select [Noise] and [Drift]. 

3 Enter the time and threshold used for checking [Noise] and [Drift]. 

4 Enter a [Maximum Time] to performing repeat the evaluation if the checks “fail”. 

Select a [Failure Action] to be taken in the event of a baseline check failure. The [Failure Action] 
parameter is used when [Baseline Check] is used in the Batch Table. 

3 Click the  (Save) button on the toolbar. 

The settings are saved to the method file. 

1

4
2 3
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4 Click on the  (Baseline Check) button on the toolbar. 

The baseline check is initiated, and the results of the baseline check are displayed after measurement 
ends. 

• The results of the baseline check are saved in the C:\LabSolutions\Log\Baseline folder. 

• PDA baseline check cannot be performed for a channel set to [Max Plot] in the [Wavelength] 
column of the [Multi Chrom] tab in the [Data Processing Parameters] sub-window. 

2.3.4 Calculate the Baseline Slope (Slope Test)
When the Slope Test is performed, the baseline of the chromatogram is measured to automatically 
calculate the Slope value. 

The calculation results of the Slope Test can be set as the Slope value for the peak integration parameters. 

1 Right-click on the graph in the [Chromatogram View], and click [Slope Test]. 

2 Click [Set to Parameter] to enter the on-screen value into the data processing 

parameters. 

The data processing parameter [Slope] value is set. 

The Slope value is generally rounded up to value that is larger than the calculated value. 
For example, a Slope value of “1988” is changed to “2000”. 
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3 Click the  (Save) button on the toolbar. 

The Slope value is saved to the method file. 

The Slope Test cannot be executed during data acquisition or during PDA plotting. 

2.3.5 Check the Condition of Consumables (System Check)
Check the system to verify that it is in good condition before starting data acquisition by checking the use 
frequency of the instrument consumables (i.e. the system check). 

Users are required to have the [Run System Check] rights to execute the system check. 

1 Click the  (System Check) icon on the [Main] assistant bar. 

2 Select the items to check, and click [Run]. 

1 Select [Consumables Check]. 

2 Select [LC Check]. 

3 Click [Advanced], and select the items to perform the system check on. 

4 Select [Report Out] to automatically print the system check results. 

• When using the LC-2010/LC-2010HT, logs recorded on instruments can be displayed in result 
reports. Up to 50 logs (30 on the CMD) can be displayed. 

• When using a photodiode array detector, the [PDA] tab is displayed. 

• If [Advanced Report] is selected, the system check is executed on all items. 

• Click [Advanced] in the [System Check] sub-window, and select [UV Detector Wavelength Check] 
to simultaneously check the wavelength on the UV detector.

1
2
4 3
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3 After the system check ends, click [View Results]. 

The [System Check Results] sub-window opens. 

• Click [Print] in the [System Check Results] sub-window to print the system check results. 

• The system check results are saved to a file named according to the following rule:
“SysChk#_YYYYMMDDHHMMSS.lcs” (where, “#” is the system number.) 

• To check the results of previous system checks, click [Load] in the [System Check Results] sub-window, 
and select the desired results. 

• Set [System Check] in a Batch Table, to check the use frequency of instrument consumables before 
starting data acquisition. Refer to "4.2.3 Batch Table Parameters" P.80 for details.

• Realtime batch can be canceled according to the results of the system check by using the Batch Table 
action function.

• The system check is based on the consumable criteria of each instrument. Check consumable criteria in 
the [System Check] sub-window by clicking [System Check] in the [Properties] sub-window of each 
instrument. 

• Click [Reset] to open the [Consumables Reset] sub-window. 
Reset the consumables when they have been replaced. 

• Users are required to have the [Edit System Configuration] rights to set system check criteria. 
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2.3.6 Control Toolbar
Change instrument status such as pump solvent delivery on/off, autosampler purge and rinse, heater 
control on/off, and detector zero correction using the [LC Control] toolbar or [PDA Control] toolbar. 

The displayed buttons vary depending on the system configuration of the instrument. 

[LC Control] toolbar

[PDA Control] toolbar

Button Name Explanation

Instrument On/Off Turns the ACTIVATE feature of the SCL-10Avp/SCL-10Asp system 
controller on/off.
This button controls the pump and column oven for the CBM-20A/20Alite.

Controller LCD On/Off Turns the LCD of the SCL-10Avp/SCL-10Asp system controller on/off. 

Controller Lock/Unlock Locks or unlocks keypad control of the SCL-10Avp/SCL-10Asp system 
controller. Only software control is permitted when keypad control is 
locked. This button is used to prevent operational errors. 

Pump On/Off Turns the solvent delivery pump on/off. 

Purge autosampler Executes an autosampler purge according to the [Purge Time] set on the 
[Autosampler] tab in [Instrument Parameters View]. 

Rinse autosampler Rinses the autosampler and sampling needle. 

Oven On/Off Turns the column heater oven on/off. 

Zero Detector A Returns the signal intensity of detector A to zero. 

PDA Detector Lamp On/Off Turns the PDA detector lamp on/off. 

Zero PDA Detector Returns the signal intensity of the PDA detector to zero. 
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If the toolbar is hidden, use the right-click popup menu on the menu bar, and select the desired toolbar from 
the displayed menu. 

2.3.7 Instrument Monitor
[Instrument Monitor] displays the instrument status and parameter settings. The instrument settings can be 
changed without changing the instrument parameters in the method file by entering a value in the [Setting] 
cell.

This section describes the procedure for changing the pump flow rate [PumpA. Flow]. 

If the [Instrument Monitor] is not displayed, click the  (Toggle Instrument Monitor) button on the toolbar. 

1 Click the [Pump A Total Flow] cell in the [Setting] column, and enter the new pump flow 

rate. 

2 Press the [Enter] key. 

The flow rate is changed. 

• Change the displayed status items in [Instrument Monitor] in the [Table Style] sub-window. Right-
click on [Instrument Monitor], and select [Table Style] from the displayed menu. 

• If the value in the [Setting] column is changed in [Instrument Monitor], it is not saved to method 
file. 
Details of changes made are recorded in the operation log, and can be checked in the [Log 
Browser] sub-window. 
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2.4 Single Run

There are two ways of acquiring data, by single run (only one data acquisition), or by realtime batch 
(sequential analysis of multiple samples). 

This section describes the procedure for a single run. 

Verify that [Ready] is displayed on the status display. 

^ Reference
Refer to "4 Realtime Batch" P.65 for information on sequential analysis of multiple samples. 

2.4.1 Execute Single Run
Execute single run from the [Data Acquisition] window. 

1 Click the  (Start Single Run) icon on the [Acquisition] assistant bar. 

2 Set the acquisition conditions, and click [OK].

1 Enter the data file name. 

2 Select [Auto-increment], and the number type. 
The data file name is automatically appended with an incremental number. 

Example: “TEST-001.lcd”

When [Auto-increment] is selected, the file is not overwritten even if the file name was previously 
used. 

3 Enter the position of the sample for [Vial#]. 

1
2

3
4
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Enter “-1” to acquire data without injecting samples from the autosampler. 

4 Enter the sample injection volume.

Single run is started. 
During data acquisition, the [LabSolutions Service] icon in the Systray on the Taskbar flashes green. 

Data acquisition ends when the data acquisition time in the method file has elapsed. 

Do not turn the PC off while the [LabSolutions Service] icon is flashing. 

2.4.2 Change the End Time During Data Acquisition
The data acquisition time can be changed during data acquisition. 

This section describes the procedure for changing the data acquisition time. 

• During data acquisition, [LC Stop Time] on the [Simple Settings] tab in [Method View] cannot be changed. 

• If the acquisition time is changed using [Change Acquisition Time], a record is created in the operation 
log. 

1 Click [Change Acquisition Time] on the [Acquisition] menu. 

2 Enter an [Acquisition Time], and click [OK]. 

• If multiple detectors are used, click [All Times Change] to changes the data acquisition time to the 
longest detector acquisition time. 

• If [Change to Minimum Value] is selected, click [All Times Change] to change the data acquisition 
time to the shortest detector acquisition time. 

• Click [Apply to Method File] to apply the new acquisition time to the method file and use it for all 
subsequent data acquisitions. 

• You can not change the value as an analysis time that already passed.
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2.4.3 Stop Single Run
Single run can be stopped in the midway to end acquisition earlier than the preset end time. 

1 Click the  (Stop) icon on the [Acquisition] assistant bar. 

Data acquisition is stopped, and a data file is created for the data so far. 

2.5 Check Analysis Results During Data Acquisition 
(Snapshot)

Execute snapshot during data acquisition to display and process the data obtained since acquisition was 
started. 

This section describes the procedure for executing a snapshot during data acquisition. 

1 Click the  (Snapshot) icon on the [Acquisition] assistant bar. 

The data obtained so far is displayed in the [Data Analysis] window. 

2.5.1 Update Snapshots
Use snapshot update to load cumulative acquired data from a continuing data acquisition after snapshot 
has been executed. 

1 Click the  (Update for Snapshot) button on the toolbar in the [Data Analysis] window. 

The snapshot is updated to display the latest chromatogram. 

Provisional
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2.6 Automatic Instrument Startup

Use  (Startup) to automatically start the instrument at a specified date and time. 

1 Click the  (Startup) button on the toolbar. 

2 Enter the date and time to start the instrument, and click [OK]. 

1 Set the date and time to start the instrument. 

2 Select [Method File], and enter the method file name. The method file can also be selected by 
clicking . 

When the method file is not specified, the analytical instruments are started up by the 
parameters already downloaded to the instrument (i.e. parameters used in the previous data 
acquisition) when a startup is performed. 

The instrument starts up at the specified date and time. 

• If startup is executed in a batch file(s) registered to the batch queue, the startup begins after 
processing of the previously registered batch file(s) ends. 
For details on the procedure for changing the execution order of batch files registered to the batch 
queue, refer to "4.5 Data Acquisition Using the Batch Queue Function" P.98. 

• Startup can also be set in realtime batch. 
For details, refer to "4.4.2 Start Data Acquisition at a Specified Date and Time (Startup)" P.89. 

1

2
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2.7 Automatic Instrument Shutdown

Use [Shutdown] to automatically shut down the instrument after data acquisition ends. 

1 Click the  (Shutdown) button on the toolbar. 

2 Set the date and time to shut down the instruments, and click [OK]. 

1 Select [Shutdown Method File], and enter the method file name. The method file can also be 
selected by clicking . 

When a method file is not specified, the analytical instruments are shut down by the parameters 
already downloaded to the instruments when a shutdown is performed. 

2 Enter the time that the instrument is operated by the instrument parameters of the specified method 
file. 

The analytical instruments shut down when the [Cool down Time] elapses. 

• If shutdown is executed in a batch file(s) registered to the batch queue, the shutdown begins after 
processing of the registered batch file(s) ends. 
For details on the procedure for changing the execution order of batch files registered to the batch 
queue, refer to "4.5 Data Acquisition Using the Batch Queue Function" P.98. 

• Shutdown can also be set in realtime batch. 
For details, refer to "4.4.3 Shutdown Analytical Instruments After Data Acquisition (Shutdown)" 
P.90.

1

2



2  LC Data Acquisition

32   Operators Guide

2.8 Change the Sampling Time (Period) or Frequency 
(Rate)

The sampling time (period) can be set matched to the peak shape of the chromatogram to acquire. 

Decreasing the sampling time (i.e. increasing the sampling frequency) enables narrower sharp peaks to be 
detected. However, in this case, more noise might be detected, possibly preventing correct peaks from 
being detected. 

This section describes how to set the sampling time (period). 

1 Click [Advanced] in [Instrument Parameters View]. 

2 Click the [Data Acquisition] tab, and set the sampling time of the detector. 

1 Select the unit to set ([Hz] or [msec]) from [Sampling]. 

2 Select the setting value from the list. 

3 Click the  (Save) button on the toolbar. 

The settings are saved to the method file. 

• The sampling time (period) is the signal interval to record to the data file, and becomes the data 
points of chromatograms. 
Note that data files increase in size the smaller the sampling time (i.e. larger the sampling 
frequency) becomes. 

• The sampling time (period), and data processing parameter [Width] and detector [Response] 
(time constant) values also affect peak detection. 

1 2



 Operators Guide   33

2.9  Daily Inspection of LC Hardware

2

 Setting the Data Sampling Time at [Sampling]

Set the sampling time to match the peak shape of the chromatogram. 

The base period is the signal interval sent to the PC from the detector. Set the base period in the [Properties] 
sub-window for the detector in the [System Configuration] sub-window. 

2.9 Daily Inspection of LC Hardware

Expected data acquisition results sometimes cannot be obtained even if each of the instruments on the LC 
system are not malfunctioning. 

Trouble can be prevented by inspecting each of the instruments before starting data acquisition, while 
waiting for the baseline to stabilize, and after data acquisition ends. This section describes check points in 
daily inspection. 

 Before Starting Data Acquisition

Initial Value Base Period of each detector set in the [System Configuration] sub-window

Setting range Base Period 1 to 10 times of 20 msec to 1000 msec range
(In Dual Mode, 1 to 10 times of 100 msec to 1000 msec range)

Recommended 
values

20 msec to 60 msec

Set 1 tenth of data processing parameter [Width] to be used as the upper limit (so that 10 
or more data points fall within the minimum half-width value of the measured peak). For 
example, in cases where data processing is performed at Width = 1 (sec), set so that the 
sampling time is sufficiently shorter than 100 msec. 

Check Point Remarks

Be sure to filter the mobile phase. A suction filter in the solvent delivery pump is used to prevent inflow of dirt 
(solids) into the flowpath. However, since filter pores are 10 microns in 
diameter, particles smaller than this diameter pass through the filter, resulting in 
clogging or dirtying of the flowpath and column. We recommend filtering the 
flowpath with a membrane filter with a pore diameter of about 0.45 microns. 

Return the mobile phase to room 
temperature before use. 

If the temperature of the mobile phase is different from the room temperature, 
the baseline may not stabilize and may drift, air bubbles may be generated, or 
other troubles are likely to occur while the mobile phase is settling to room 
temperature. 
Note, that if water and organic solvents mix together, the temperature of the 
mixed solution sometimes changes considerably from the room temperature. 

In the case of a low-pressure 
gradient system, fill the flowpaths 
with mobile phase using all 4 
solutions. 

Air bubbles in the gradient valve or from the solvent delivery pump up to the 
gradient valve may cause the retention time to fluctuate or be uneven. For this 
reason, fill the flowpath of each line with mobile phase. 
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Pay attention 
to substitution 
of the mobile 
phase

When substituting 
with compatible 
mobile phase 

Follow the procedure below to substitute the mobile phase:

1. Pour the substitute mobile phase into a clean beaker (about 200 mL in 
size). 

2. After drawing out the suction filter from the reservoir bottle, and putting it in 
the beaker in step (1) above, vibrate the filter section to rinse the suction 
filter. 

3. Turn the drain valve counterclockwise to open the valve. 

4. Press  on the solvent delivery pump. (Solvent is delivered about for 
3 minutes at a flow rate of 8 mL/min, though this depends on the 
instrument settings.) 

5. Insert the suction filter into a new mobile phase reservoir bottle, and press 

 on the solvent delivery pump. Next, press  to deliver 
solvent and substitute the flowpath up to the column connection port. 

6. Close the drain valve. 

7. Connect the column, and turn the column oven on. (The oven starts to be 
controlled.) 

8. Deliver solvent at half the data acquisition flow rate. 

9. When the column oven temperature stabilizes, deliver solvent at the data 
acquisition flow rate. 

When substituting 
with incompatible 
mobile phase

Substitute the mobile phase with an intermediate solution (e.g. 2-propanol) that 
is compatible with the old and new mobile phases, and then replace the 
intermediate solution with the new mobile phase. Follow the procedure above. 

When substituting 
the buffer solution 
mobile phase

When using a buffer solution for one or both of the new and old mobile phases, 
first substitute with distilled water as the intermediate solution, and then 
substitute with the new mobile phase. After purging with distilled water, deliver 
distilled water for a while (at least 20 mins at a flow rate of 1 mL/min). 
During this operation, also rinse the plunger seal using the seal auto-rinsing kit. 
This is needed to prevent deposition of salt in the buffer solution. 
Note that crystals and leftover lees sometimes cannot be removed if 2-
propanol or other organic solvent is passed along the flowpath before rinsing 
with distilled water. 

Prime the suction tube with water if 
it is not filled with mobile phase. 

Prime the suction tube if it is not filled with mobile phase or if large air bubbles 
can be seen inside. 

1. Open the drain valve, and connect a 20 ml syringe to the drain tube ASSY 
outlet port. 

2. Press . 

3. Pull on the syringe with large force in a purged state. 

Purge the instrument before using 
it. 

Air bubbles sometimes occur in the head of the solvent delivery pump when 
data acquisition has not been performed for some time or when the difference 
between day and night temperatures is large. Purging the pump removes air 
bubbles, preventing defective solvent delivery or other trouble. 

1. Turn the drain valve counterclockwise to open the valve. 

2. Press  on the solvent delivery pump (for 3 minutes at a flow rate of 
8 mL/min). 

3. Close the drain valve. 

Check Point Remarks
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 While Waiting for Baseline Stabilization

Check the rinse solution of the seal 
auto-rinsing kit. 

When a mobile phase containing buffer solution or phosphoric acid is used, be 
sure to rinse the plunger seal. Use distilled water for the seal ringing solution, 
and exchange the rinsing solution periodically (once every 2 or 3 days). 
Otherwise, germs and bacteria will breed in the distilled water. 
When using a solution incompatible with distilled water as the mobile phase, do 
not rinse seals with distilled water. 

Check the autosampler rinse 
solution. 

Use an autosampler rinse solution that is the same as the mobile phase. 
However, be sure to remove any salt from the rinse solution. Also, since the 
rinse solution contacts the mobile phase inside the high-pressure valve, select 
a solution that does not cause deposition of salt due to contact with liquid. 

Purge the autosampler's 
measuring pump. 

Air bubbles sometimes occur in the head of the measuring pump when data 
acquisition has not been performed for some time or when the difference 
between day and night temperatures is large. Purging the pump removes air 
bubbles, preventing uneven peak area values or other troubles. To purge the 

measuring pump, press . 

To stop the purge, press  again. 

Firmly close the autosampler door. After closing the autosampler door, make sure that the door is firmly held 
against the magnets on the instrument body. 

Check the column oven preset 
temperature. 

The CTO-20A(30A) and CTO-20AC can be controlled from "room temperature 
+10 C" and "room temperature -10 C", respectively. Note, however, that 
when room temperature is around 26 C, the CTO-20A cannot be controlled 
stably with the temperature set to 35 C. 

Check the wavelength accuracy of 
the UV-VIS detector. 

The SPD-20A/20AV automatically checks the wavelength using the emission 
lines of 253.7 nm (Hg lamp) and 656.1 nm (D2 lamp) after the instrument is 
turned on. A warning message is displayed if the wavelengths are deviating. 
When "CHECK NO GOOD" is displayed, execute "WAVE ADJ" with the cell 
filled with water to check the wavelength again. If "CHECK NO GOOD" is 
displayed again, this indicates an instrument malfunction. 
In the case of the SPD-M20A, fill the cell with water, and check the wavelength 
in the [Wavelength Check] sub-window of the [PDA Utility] sub-window. 

Check Point Remarks

Check Point Remarks

Check for liquid leaks. Start solvent delivery, and make sure that all flowpaths, such as piping 
connections, are free of liquid leaks. If liquid is leaking, re-tighten the leaking 
spot, or replace consumables. On the 20A series, visual checks are basically 
not required since each instrument is provided with a liquid leak sensor. 

Check the pump pressure. Good data acquisition results cannot be obtained if the pressure of the 
solvent delivery pump is unstable. Pump pressure stability varies according to 
the pressure value and type of mobile phase. The following are reference 
fluctuation widths:
LC-20AD, LC-20AB,LC-20ADXR, LC-30AD: within 0.2 MPa
LC-20AT: within 0.3 MPa
Purge the pump when pressure fluctuation is large. If this does not remedy 
large pressure fluctuation, probable causes are dirt in the check valve or 
liquid leaks from the plunger seal. 
For more details, refer to the Instruction Manual for the respective instrument. 
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 After Data Acquisition Ends

!Caution

Precautions When Selecting and Handling Mobile Phase Solvent

Do not use the following solvents when PEEK resin is used for piping. 

Doing so might cause the intensity of the PEEK resin to drop, resulting in piping splitting and solvent 
spurting out. 

Note, however, that there is no problem in temporarily using a low-concentration water solution with an 
acetone concentration of 0.5% or less for checking low gradient performance. 

Check the baseline. Make sure that the baseline is stable as in normal operation. 
The following are probable causes of the baseline not stabilizing within the 
preset stabilization time:

· Abnormally large noise
A probable cause of this is air bubbles entering the detector cell and not 
being able to escape. Rinse the inside of the cell since this kind of trouble 
is likely to occur when it is dirty. 
Also, replace the lamp if lamp energy is low. 

· Drift or irregular waviness
Rinse the line since there is the possibility that dirt in the column, piping, 
detector cell or mobile phase is being detected. 

· Relatively regular (cyclic) waviness
This kind of trouble might occur when air blast from air-conditioning 
equipment directly strikes the detector or when air-conditioning 
equipment causes temperature control to fluctuate greatly, causing 
extreme differences in room temperature. Adjust the air-conditioning 
equipment so that air blast does not directly strike the detector. 

Check Point Remarks

Check Point Remarks

Rinse the column. When data acquisition has not been performed for some time, rinse the 
column, remove it from the instrument, and then put it in storage. The column 
rinsing method varies according to the type of column. For details, refer to the 
Instruction Manual for the column. 

Rinse instruments. When data acquisition has not been performed for some time, rinse and 
remove the column according to the procedure above, and rinse the 
instrument flowpath. At this time, short-circuit the inlet and outlet pipes 
connected to the column with a coupling or other metal object, and then rinse 
the pipes. 
If the pipes are left connected to the column rinsed with solution containing 
water, mold or bacteria sometimes breeds inside the instrument flowpath. To 
prevent this kind of trouble, we recommend filling the instrument flowpath with 
2-propanol, methanol or other kind of alcohol. Piping on both the inlet and exit 
ports of the suction filter and detector can be filled with solution after they are 
rinsed with solvent by immersing them in their reservoir bottles. 

Concentrated sulfuric acid, concentrated nitric acid, dichloroacetic acid, acetone, tetrohydrofuran (THF), 
dichloromethane, chloroform, and dimethyl sulfoxide (DMSO)
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• Select a mobile phase solvent for the LC or equivalent, and remove any fine particles or dirt with a filter 
(0.45 m or smaller) before use. 

• Avoid using solvents containing halogen ions (e.g. KCl, NaCl, NH4Cl) or solvents that generate halogen 

ions by reaction since halogen ions sometimes corrode the stainless steel (SUS316) pipe material. If such 
solvents must be used, rinse the entire flowpath sufficiently with distilled water immediately after data 
acquisition ends. 

• When the UV detector is used at high sensitivity, use a solvent for the LC having low UV absorbance as 
the mobile phase solvent. 

• Generation of air bubbles caused during mixing of solutions or by pressure and temperature changes, 
defective solvent delivery and generation of noise in the detection cell can be limited by degassing the 
mobile phase solvent. 
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3GC Data Acquisition

This chapter describes the basic flow of operations from entrance of the data acquisition parameters 
to the performance of a single run data acquisition on the GC. 

3.1 [Data Acquisition] Window

Two views of the [Data Acquisition] window are available, the [Chromatogram View] is used to display 
chromatograms and instrument status information and the [Instrument Parameters View] is used to display 
the parameters set for each instrument. 

3.1.1 Open the [Data Acquisition] Window

1 Click the  icon.

2 Select and double-click the instrument that will be used for data acquisition. 

The [Realtime Analysis] program opens. 
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3 Click the  (Data Acquisition) icon on the [Main] assistant bar. 

If the  (Data Acquisition) icon is not displayed, click  on the title of the assistant bar. 

4 Ensure that [Ready] is displayed on the status display in the [Data Acquisition] window. 

If [Not Connected] is displayed on the status display, refer to "3.2 The Instrument Is Not Properly 
Recognized" in the Installation & Maintenance Guide. 
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3.1.2 [Data Acquisition] Window Description
This section describes how to view and use the [Data Acquisition] window. 

No. Explanation

1 Displays the [Standard] toolbar, [Data Acquisition] toolbar, [Instrument Control] toolbar, and [GC Control] 
toolbar. 

2 Displays chromatograms and the instrument status curves. 

^ Reference
Refer to "3.3.1 Monitor the Chromatograms and Instrument Status Curves" P.45 to display the status 
information of instruments. 

3 Displays the instrument status and parameter settings. 

4 Click  to transfer the data acquisition settings set in [Instrument Parameters View] to the analytical 

instrument. 

For the GC-2010(Plus), GC-2014, GC-2025 and GC-2018, the button is on [Method Editor] sub-
window.Refer to "3.2.1 Set the Instrument Parameters" P.42.

5 In the [Control Panel], Set the data acquisition parameters, check the instrument status and control the 
instrument. Displays the instrument parameters to acquire the data. 
For [Instrument Monitor] mode, the instrument status can be checked.
For [Instrument Parameter] mode, the data acquisition parameters can be set.

For the GC-2010(Plus), GC-2014, GC-2025 and GC-2018, set the data acquisition parameters on 
[Method Editor] sub-window. Refer to "3.2.1 Set the Instrument Parameters" P.42.

6 Switches between the full screen and normal display. 

[Chromatogram View]2

6

Toolbar1

5 [Control Panel] 3 [Instrument Monitor]4
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3.2 Enter Data Acquisition Parameters

Enter the data acquisition parameters in [Control Panel]. 

The parameters are saved to the method file and used to perform data acquisition. 

This section describes the operations in the [Control Panel]. 

3.2.1 Set the Instrument Parameters
[Control Panel] has two view modes, [Instrument Monitor] and [Instrument Parameter]. 

In the [Instrument Monitor] mode, the instrument status can be checked. By clicking the icon of each unit, 
the data acquisition parameters for each unit can be set. In the [Instrument Parameter] mode, sub-window 
for each configured instrument module is displayed so that data acquisition parameters can be set in more 
detail. 

This section describes how to set the data acquisition parameters and create a method file. 

1 Set the view mode to [Instrument Monitor].

 

For the GC-2010(Plus), GC-2014, GC-2025 and GC-2018, select the menu [View] - [Display 
Settings of Instrument Parameter View] to change the display mode.

2 Click the icon of each unit and enter the data acquisition parameters. 

[Method Editor] sub-window opens. Set the detector, oven temperature, carrier gas type, program type 
and other parameters. 
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• If [(Link to Oven Program)] is displayed on [Detector] window, [Stop Time] cannot be set since the 
oven temperature program is linked to the data acquisition time. To set [Stop Time] different from 
[Total Program Time], right-click on the [Method Editor] sub-window, and click and deselect [Link 
Oven Program edit and Acquisition Time] on the displayed menu.

3 Click [Save Method File As] on the [File] menu. 

The [Save Method File As] window is displayed.

4 Enter the file name, and click [Save]. 

A method file is created with the specified file name and the new instrument parameters are saved to the 
file. 
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3.2.2 Analytical Instrument Startup
This section describes how to transfer (download) instrument parameters to an analytical instrument and 
the procedure for starting the instrument. 

1 Drag-and-drop the desired method file onto the [Data Acquisition] window from the 
[Data Explorer] sub-window. 

If the [Data Explorer] sub-window is not displayed, click the  (Toggle Data Explorer) button on 

the tool bar. 

The content of the method file is displayed in the [Data Acquisition] window. 

For GC-2010(Plus), GC-2014, GC-2025, and GC-2018, [Method Editor] sub-window is displayed 
automatically after method file is opened.

2 Check the instrument parameters, and click . 

The instrument parameters are transferred to the analytical instrument. 

3 Click the  (GC System On) button on the toolbar. 

The carrier gas supply and oven temperature control are started.
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3.3 Data Acquisition Preparation

This section describes the procedures to perform before starting data acquisition, such as baseline check. 

3.3.1 Monitor the Chromatograms and Instrument Status Curves
This section describes how to monitor chromatograms displayed in [Chromatogram View] and instrument 
status curves. 

 Chromatogram Display Settings

The chromatogram display scale can be changed. 

This section describes how to monitor chromatograms on multiple channels. 

1 Right-click on the graph in [Chromatogram View], and click [Display Settings]. 

2 Click the [GC] tab and enter the necessary parameters. 

1 Click [Overlay] to draw chromatograms overlaid. 

2 Enter the channel intensity range for the Y-axis. 
Click [Normalize] so that the intensity range falls within the minimum and maximum values of the 
currently displayed chromatogram. 

3 Select the channel and the display unit for the Y-axis. 

The intensity range of each channel cannot be set in the [Overlay] mode.

1

2

3
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3 Click the [General] tab, enter the necessary parameters, and click [OK]. 

1 Select [Sample Name], [Sample ID] and [Data Comment]. 

The sample information is displayed in the status display of the [Data Acquisition] window. 

2 Enter the [Time Range] for the X axis display range. 
Click [Normalize] to set the display range of the X-axis to either the [Stop Time] currently set in the 
method file. 

4 Click the  (Save) button on the toolbar. 

The time range and intensity range are saved to the method file. 

• Settings other than the time range and intensity range are stored to memory for each user and 
instrument. 

• The reference chromatogram is drawn overlaying [Chromatogram View]. 
Click [Open Reference Data File] in the [File] menu to select and display the reference 
chromatogram. 

1

2
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 Display Instrument Status Curves

The instrument status curves that can be displayed on the graph in [Chromatogram View] include [Column 
Oven Temperature] and [Carrier Gas Pressure]. 

1 Right-click on the graph in [Chromatogram View], and click [Display Settings]. 

2 Click the [Status] tab, enter the necessary parameters, and click [OK]. 

1 Select the desired display items in [Draw Status Curve]. 

2 Set the display range for each status item.

3 Select the type of status to display on the intensity axis on the right of the graph. 

1

2

3
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The selected status is displayed on the graph. 

• Settings are stored to memory for each user and instrument. 

• If items are not displayed at [Draw Status Curve], select [Save the Status Monitor] in the 
[Properties] sub-window for the GC in the [System Configuration] sub-window.
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3.3.2 Check the Baseline
Use the baseline check function to determine whether the baseline noise and drift values are within the 
preset time and at or below the threshold for each channel. 

1 Click [Baseline Check Parameters] from the [Method] menu in the [Data Acquisition] 

window. 

2 Set the baseline check parameters, and click [OK]. 

1 Select the noise calculation method.

2 Select [Noise] and [Drift]. 

3 Enter the time and threshold used for checking [Noise] and [Drift]. 

4 Enter a [Maximum Time] to performing repeat the evaluation if the checks “fail”. 

Select a [Failure Action] to be taken in the event of a baseline check failure. The [Failure Action] 
parameter is used when [Baseline Check] is used in the Batch Table. 

3 Click the  (Save) button on the toolbar. 

The settings are saved to the method file. 

4 Click on the  (Baseline Check) button on the toolbar. 

The baseline check is initiated, and the results of the baseline check are displayed after measurement 
ends. 

The results of the baseline check are saved in the C:\LabSolutions\Log\Baseline folder. 

1

4
2 3
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3.3.3 Calculate the Baseline Slope (Slope Test)
When the Slope Test is performed, the baseline of the chromatogram is measured to automatically 
calculate the Slope value. 

The calculation results of the Slope Test can be set as the Slope value for the peak integration parameters. 

1 Right-click on the graph in the [Chromatogram View], and click [Slope Test]. 

2 Click [Set to Parameter] to enter the on-screen value into the data processing 

parameters. 

The data processing parameter [Slope] value is set. 

The Slope value is generally rounded up to value that is larger than the calculated value. 
For example, a Slope value of “1988” is changed to “2000”. 

3 Click the  (Save) button on the toolbar. 

The Slope value is saved to the method file. 

The Slope Test cannot be executed during data acquisition or during PDA plotting. 

3.3.4 Detector Zero Correction

Use  (Zero Detector) on the toolbar to correct the signal intensity of the detector or CBM-102 to zero.

1 Click  (Zero Detector) on the toolbar. 

The signal intensity of chromatograms is corrected to zero.

The buttons displayed on the toolbar vary depending on the system configuration of the instrument.
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3.3.5 Check the Condition of Consumables (System Check)
Check the system to verify that it is in good condition before starting data acquisition (i.e. the system 
check). 

• Users are required to have the [Run System Check] rights to execute the system check. 

• For GC, the system check can be executed only if GC-2010 or GC-2014 is used.

1 Click the  (System Check) icon on the [Main] assistant bar. 

2 Select the items to check, and click [Run]. 

1 Select [Consumables Check]. 

2 Select [GC Check]. 

3 Click [Advanced], and select the items to perform the system check on. 

4 Select [Report Out] to automatically print the system check results. 

3 After the system check ends, click [View Results]. 

The [System Check Results] sub-window opens. 

1
2
4 3
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• Click [Print] in the [System Check Results] sub-window to print the system check results. 

• The system check results are saved to a file named according to the following rule:
“SysChk#_YYYYMMDDHHMMSS.lcs” (where, “#” is the system number.) 

• To check the results of previous system checks, click [Load] in the [System Check Results] sub-window, 
and select the desired results. 

• Set [System Check] in a Batch Table, to check the use frequency of instrument consumables before 
starting data acquisition. Refer to "4.2.3 Batch Table Parameters" P.80 for details.

• Realtime batch can be canceled according to the results of the system check by using the Batch Table 
action function.

• The system check is based on the consumable criteria of each instrument. Check consumable criteria in 
the [System Check] sub-window by clicking [System Check] in the [Properties] sub-window of each 
instrument. 

• Click [Reset] to open the [Consumables Reset] sub-window. 
Reset the consumables when they have been replaced. 

• Users are required to have the [Edit System Configuration] rights to set system check criteria. 

3.4 Single Run

There are two ways of acquiring data, by single run (only one data acquisition), or by realtime batch 
(sequential analysis of multiple samples). 

This section describes the procedure for a single run. 

Verify that [Ready] is displayed on the status display. 

^ Reference
Refer to "4 Realtime Batch" P.65 for information on sequential analysis of multiple samples. 

3.4.1 Execute Single Run
Execute single run from the [Data Acquisition] window. 

1 Click the  (Start Single Run) icon on the [Acquisition] assistant bar. 
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2 Set the acquisition conditions, and click [OK].

1 Enter the data file name. 

2 Select [Auto-increment], and the number type. 
The data file name is automatically appended with an incremental number. 

Example: “TEST-001.lcd”, “TEST-001.gcd”

When [Auto-increment] is selected, the file is not overwritten even if the file name was previously 
used. 

3 Enter the position of the sample for [Vial#]. 

• Selecting [Without sample] or entering "-1" at [Vial #] acquires data without injecting samples 
from the autosampler.
Data acquisition can be started without pressing the [Start] button on the GC.

• If the autosampler is TurboMatrix, data acquisition cannot be started by entering "-1" at [Vial 
#].

4 Enter the sample injection volume.

Single run is started. 
During data acquisition, the [LabSolutions Service] icon in the Systray on the Taskbar flashes green. 

Data acquisition ends when the data acquisition time in the method file has elapsed. 

• Do not turn the PC off while the [LabSolutions Service] icon is flashing. 

• In the case of a dual-line configuration, set the data acquisition parameters on the [Line 1] and 
[Line 2] tabs.

1
2

3
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3.4.2 Change the End Time During Data Acquisition
The data acquisition time can be changed during data acquisition. 

This section describes the procedure for changing the data acquisition time. 

• The end time for the detector in [Method View] is changed. 

• If the acquisition time is changed using [Change Acquisition Time], a record is created in the operation 
log. 

1 Click [Change Acquisition Time] on the [Acquisition] menu. 

2 Enter an [Acquisition Time], and click [OK]. 

• If multiple detectors are used, click [All Times Change] to changes the data acquisition time to the 
longest detector acquisition time. 

• If [Change to Minimum Value] is selected, click [All Times Change] to change the data acquisition 
time to the shortest detector acquisition time. 

• Click [Apply to Method File] to apply the new acquisition time to the method file and use it for all 
subsequent data acquisitions. 

• You can not change the value as an analysis time that already passed.

3.4.3 Stop Single Run
Single run can be stopped in the midway to end acquisition earlier than the preset end time. 

1 Click the  (Stop) icon on the [Acquisition] assistant bar. 

Data acquisition is stopped, and a data file is created for the data so far. 
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3.5 Check Analysis Results During Data Acquisition 
(Snapshot)

Execute snapshot during data acquisition to display and process the data obtained since acquisition was 
started. 

This section describes the procedure for executing a snapshot during data acquisition. 

1 Click the  (Snapshot) icon on the [Acquisition] assistant bar. 

The data obtained so far is displayed in the [Data Analysis] window. 

3.5.1 Update Snapshots
Use snapshot update to load cumulative acquired data from a continuing data acquisition after snapshot 
has been executed. 

1 Click the  (Update for Snapshot) button on the toolbar in the [Data Analysis] window. 

The snapshot is updated to display the latest chromatogram. 

仮
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3.6 Automatic Instrument Startup

Use  (Startup) to automatically start the instrument at a specified date and time. 

1 Click the  (Startup) button on the toolbar. 

2 Enter the date and time to start the instrument, and click [OK]. 

1 Set the date and time to start the instrument. 

2 Select [Method File], and enter the method file name. The method file can also be selected by 
clicking . 

When the method file is not specified, the analytical instrument is started up by the parameters 
already downloaded to the instrument (i.e. parameters used in the previous data acquisition) 
when a startup is performed. 

The instrument starts up at the specified date and time. 

• If startup is executed in a batch file(s) registered to the batch queue, the startup begins after 
processing of the previously registered batch file(s) ends. 
For details on the procedure for changing the execution order of batch files registered to the batch 
queue, refer to "4.5 Data Acquisition Using the Batch Queue Function" P.98. 

• Startup can also be set in realtime batch. 
For details, refer to "4.4.2 Start Data Acquisition at a Specified Date and Time (Startup)" P.89. 

1

2
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3.7 Automatic Instrument Shutdown

Use [Shutdown] to automatically shut down the instrument after data acquisition ends. 

1 Click the  (Shutdown) button on the toolbar. 

2 Set the date and time to shut down the instrument, and click [OK]. 

1 Select [Shutdown Method File], and enter the method file name. The method file can also be 
selected by clicking . 

When a method file is not specified, the analytical instrument is shut down by the parameters 
already downloaded to the instrument when a shutdown is performed. 

2 Enter the time that the instrument is operated by the instrument parameters of the specified method 
file. 

The analytical instruments shut down when the [Cool down Time] elapses. 

• If shutdown is executed in a batch file(s) registered to the batch queue, the shutdown begins after 
processing of the registered batch file(s) ends. 
For details on the procedure for changing the execution order of batch files registered to the batch 
queue, refer to "4.5 Data Acquisition Using the Batch Queue Function" P.98. 

• Shutdown can also be set in realtime batch. 
For details, refer to "4.4.3 Shutdown Analytical Instruments After Data Acquisition (Shutdown)" 
P.90.

• With GC-14A/B, analytical instruments are not shutdown. The shutdown method is downloaded 
but the instruments continue to run even if the cool down time has elapsed.

1

2
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3.8 Change the Sampling Rate

The sampling rate can be set matched to the peak shape of the chromatogram to acquire. 

Decreasing the sampling rate enables narrower sharp peaks to be detected. However, in this case, more 
noise might be detected, possibly preventing correct peaks from being detected. 

This section describes how to set the sampling rate. 

1 Click the detector icon in [Control Panel].

[Method Editor] sub-window opens. 

2 Set the sampling interval of the detector. 

1 Select the setting value from the list. 

3 Click the  (Save) button on the toolbar. 

The settings are saved to the method file. 

• The base period is the signal cycle sent to the PC from the detector.Set the base period in the 
[Properties] sub-window for the detector in the [System Configuration] sub-window.

• The sampling rate is the signal interval to record to the data file, and becomes the data points of 
chromatograms. 
Note that data files increase in size the smaller the sampling rate becomes. 

• The sampling rate, and data processing parameter [Width] value also affects peak detection. 

1



 Operators Guide   59

3.9  Set the Instrument Parameters for the Dual-Line Configuration GC

3

 Setting the Data Sampling Rate at [Sampling Rate]

Set the sampling rate to match the peak shape of the chromatogram. 

3.9 Set the Instrument Parameters for the Dual-Line 
Configuration GC

This section describes how to set the data acquisition parameters (instrument parameters) for the dual-line 
configuration GC.

Select [Line 1] and [Line 2] in [Control Panel], and set the parameters.

1 Click [Line 1] in [Control Panel].

2 Click the icon, and set the instrument parameters in [Method Editor].

^ Reference
Refer to "3.2.1 Set the Instrument Parameters" P.42 for more details.

Initial Value Base Period of each detector set in the [System Configuration] sub-window

Setting range Base Period 1 to 20 times of 4 msec to 80 msec range
(If Base Period is 100 msec or longer: 1 to 10 times)

Recommended 
values

Data acquisition with a packed column: 40 msec to 160 msec
Regular capillary data acquisition: 40 msec to 160 msec
High-speed data acquisition with a narrow-pore column: 20 msec to 60 msec
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3 Set the parameters for [Line 2] by the same procedure.

4 Save the instrument parameters to the method file, and click .

3.10 Acquire Data from the [Start] Button on the GC Unit

If [Acquisition Start from Instrument] is selected, data can be acquired simply by pressing the  button 

on the GC unit.

This section describes how to acquire data by pressing the  button on the GC unit using the pre-

loaded method file.

• This function cannot be used for the system with GC-14A/B.

• If the screen is locked by the popup sub-window for setting or due to data acquisition, data acquisition 
cannot be started.

1 Click [Options] on the [Tool] menu.

2 Click the [Start Acquisition] tab, enter the necessary parameters, and click [OK]. 

1 Select [Acquisition Start from Instrument].

2 Enter the default data file name at [Default Data File].

3 Press the  button on the GC unit.

Data acquisition is started.

1
2
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The acquired data is saved under the name of the file displayed at [Default Data File] in the [Setting 
Options] sub-window. Even if the data acquisition continues to be performed, the file is not 
overwritten since the data file name is automatically appended with an incremental number.

 If Data Could Not Be Acquired Successfully

Check the following if data could not be acquired.

Download is not executed.

If the [Data Acquisition] window is started up or a method file is changed, be sure to download the file 
before starting data acquisition.

In the case of GC units connected via the CBM-102, data acquisition can be performed only if the method 
is downloaded.

Programs such as oven temperature program are not set.

Correct data acquisition can be performed only if the GC program is set.

Be sure to set the oven temperature program.

Be sure to set the hold time for isocratic analysis.

3.11 If Single Baseline of instrument Is Unstable

Shortly after the GC unit is started up, if the previously acquired sample remains in the injection unit or the 
column, the baseline may become unstable or extraneous peaks may appear.

If this occurs, condition or clean up the column.

Perform the same procedure to clear the sample in the column if data acquisition fails due to a sample 
injection error.

 Change the Column Temperature for Instrument Parameters

This section describes how to change the column initial temperature from 50 °C to 120 °C and to return to 
50 °C of initial temperature after conditioning and confirming that the baseline becomes stable.

1 Click [Column] icon in [Control Panel].

[Method Editor] sub-window opens.
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2 Enter “120” at [Temperature].

3 Close the [Method Editor] sub-window, and click .

Wait a while until the baseline becomes stable.

For GC-2010(Plus), GC-2014, GC-2025 and GC-2018, close the [Method Editor] sub-window by 

clicking  to download the parameters automatically.

4 When the baseline becomes stable, open the [Method Editor] again, enter "50" for the 

initial temperature at [Temperature], and download it to the instrument by the same 

procedure.
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 Acquire Data Without Injecting Samples

Data acquisition is performed without injecting samples to check the baseline, under the same acquisition 
parameters as for the programmed temperature analysis, where column oven temperature is gradually 
raised.

1 Click the  (Start Single Run) icon on the [Acquisition] assistant bar.

2 Select [Without sample], and click [OK].

In the case of a dual-line configuration GC, make settings both on the [Line 1] and [Line 2] tabs.

 Acquire Data With Solvent Injected (Without Injecting Samples)

In cases such as if extraneous peaks appear, data acquisition is performed with solvent rather than a 
sample injected to check chromatograms. Follow the same procedure as for regular data acquisition.

^ Reference
Refer to "3.4.1 Execute Single Run" P.52 for details on single run.

If there is dirt in the injection unit, increase the temperature in the unit to clear the dirt. At that time, multiple 
injections of solvent sometimes increase the effect of clearing the dirt.

Also, replace glass insert and septum as required.

For more details, refer to the Instruction Manual for the GC unit.
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4Realtime Batch

Realtime batch is sequential data acquisition of multiple samples. Execution of realtime batch starts 
with the preparation of a Batch Table. 

This chapter describes the procedures for automating data acquisition. 

• Making Batch Tables

• Baseline check to verify the stability of the baseline

• [Startup] to begin realtime batch analysis at a specified date and time

• [Shutdown] to shutdown the instrument after realtime batch ends

4.1 Display Batch Tables

Click the  (Realtime Batch) icon on the [Main] assistant bar in the [Realtime Analysis] program to 

display the Batch Table. 

4.2 Create Batch Tables

Enter the sample information, vial #, method file name, and data file name in a Batch Table to sequentially 
acquire data from multiple samples. 

This section describes how to create a Batch Table

4.2.1 Batch Table Wizard
Batch Tables can be made easily by using the Batch Table Wizard. This section describes how to create a 
Batch Table separately for LC and GC since the Batch Table Wizard varies according to the instrument in 
use. See "For LC" and "For GC" below.

Some features of the Batch Tables cannot be set with the Batch Table Wizard. It is necessary to directly edit 
the Batch Table to set these functions. 
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 For LC

1 Click the  (Wizard) icon on the [Realtime Batch] assistant bar. 

2 Enter the parameters, and click [Next]. 

1 Click [New] at [Batch Table] to create a new Batch Table file.
Click [Add] to add a row to the currently displayed Batch Table. 

2 Enter the [Method File]. 

3 Enter the [Injection Volume]. 

4 Enter the data acquisition pattern for the standard samples and unknown samples. 

Enter a number for [Number of Sample Groups] to indicate the number of times the data acquisition 
pattern will be repeated. 

Select [Bracket Calibration] to select the type of bracket quantitation. 

^ Reference
For details, see "4.4.6 Bracket Quantitation" P.94. 

5 Select [Insert QA/QC Samples] to insert a QA/QC sample.

If [Insert QA/QC Samples] is selected, the [Batch Table Wizard - QA/QC Sample] sub-window is 
displayed. If [Insert QA/QC Samples] is deselected, proceed to Step 4.

1
2

3

4

5
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3 Enter the QA/QC sample information, then click [Next]. 

4 Enter the standard sample information, and click [Next]. 

1 Enter [Sample Name] and [Sample ID] for the standard sample. 

If [Auto-increment] is selected, the [Sample Name] and [Sample ID] are automatically appended with 
an incremental number. 

2 Enter a [Data File Name]. 

Select [Create file names automatically] to automatically generate a data file name. 

1

2

3

4
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^ Reference
For details, see "Set the Data File Name" P.106. 

3 Set the [Number of Calibration Levels] (number of calibration points), [Repetitions per Run] (number 
of injections) and select [Clear all calibrations at the beginning] to initialize the calibration curve.

The final vial No. of the standard sample you have set is displayed at [Vial#] in the Batch Table. 

4 Select [Print Report] and set [Report Format File] to create reports. 

5 Enter the unknown sample information, as with the standard sample, and click [Next]. 



 Operators Guide   69

4.2  Create Batch Tables

4

6 Set the summary report output parameters, and click [Next]. 

1 Select [Print Summary Report] for [QA/QC], and select a [Summary Report Format File]. 

[QA/QC] is not displayed if [Insert QA/QC Samples] is deselected in the [Batch Table Wizard] 
sub-window. 

2 Select [Print Summary Report] for [Analysis], and select the type of sample summary that will be 
reported. 

3 Select the [Summary Report Format File]. 

7 Select the items to be executed, and click [Next]. 

If [Startup] or [Shutdown] are selected, a setting sub-windows for each item is displayed. (Steps 8 or 9)

1

2

3
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If all of these items are deselected, proceed to Step 10. 

8 Select the startup settings, and click [Next]. 

The startup start date and time cannot be set in the Batch Table Wizard. Refer to "4.4.2 Start Data 
Acquisition at a Specified Date and Time (Startup)" P.89 to enter a specified date and time. 

1 Enter an instrument startup time at [Pumping Period].

2 Select [Startup Method File], and enter the method file.

1

2
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9 Select the shutdown settings, and click [Next]. 

1 Select [Shutdown Method File], and enter the method file. 

2 Enter an instrument shutdown time at [Cool down Time]. 

10 Enter a batch file name, and click [Finish]. 

This completes Batch Table setup using the Batch Table Wizard. The batch file is created using the 
specified file name. This Batch Table is displayed in the Batch Table sub-window. Check the contents of the 
Batch Table. 

1

2
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 For GC

1 Click the  (Wizard) icon on the [Realtime Batch] assistant bar. 

2 Enter the parameters, and click [Next]. 

1 Click [New] at [Batch Table] to create a new Batch Table file.
Click [Add] to add a row to the currently displayed Batch Table. 

2 Enter the [Method File]. 

3 Select the [Table Type].
In the case of dual-line configuration, select [Line 1 & Line 2].

4 Enter the data acquisition pattern for the standard samples and unknown samples. 

Enter a number for [Number of Sample Groups] to indicate the number of times the data acquisition 
pattern will be repeated. 

Select [Bracket Calibration] to select the type of bracket quantitation. 

^ Reference
For details, see "4.4.6 Bracket Quantitation" P.94. 

5 Select [Insert QA/QC Samples] to insert a QA/QC sample.

1
2
3

4

5



 Operators Guide   73

4.2  Create Batch Tables

4

Refer to "4.4.8 Set the Injection Volume and Multi-Injection Counts for the GC" P.97 to set the 
injection volume for each sample using the same method file.

If [Insert QA/QC Samples] is selected, the [Batch Table Wizard - QA/QC Sample] sub-window is 
displayed. If [Insert QA/QC Samples] is deselected, proceed to Step 4.

3 Enter the QA/QC sample information, then click [Next]. 

4 Enter the standard sample information, and click [Next]. 

1

2

3
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1 Enter [Sample Name] and [Sample ID] for the standard sample. 

If [Auto-increment] is selected, the [Sample Name] and [Sample ID] are automatically appended with 
an incremental number. 

2 Enter a [Data File Name]. 

Select [Create file names automatically] to automatically generate a data file name. 

^ Reference
For details, see "Set the Data File Name" P.106. 

3 Set the [Number of Calibration Levels] (number of calibration points), [Repetitions per Run] (number 
of injections) and select [Clear all calibrations at the beginning] to initialize the calibration curve. 

The final vial No. of the standard sample you have set is displayed at [Vial#] in the Batch Table. 

4 Select [Print Report] and set [Report Format File] to create reports. 

5 Enter the unknown sample information, as with the standard sample, and click [Next]. 

If [Line 1 & Line 2] is selected at Step 2, the setting sub-windows for standard sample and unknown 
sample for Line 2 are displayed consecutively. Set each item in the same way as for Line 1.
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6 Set the summary report output parameters, and click [Next]. 

1 Select [Print Summary Report] for [QA/QC], and select a [Summary Report Format File]. 

[QA/QC] is not displayed if [Insert QA/QC Samples] is deselected in the [Batch Table Wizard] 
sub-window. 

2 Select [Print Summary Report] for [Analysis], and select the type of sample summary that will be 
reported. 

3 Select the [Summary Report Format File]. 

7 Select the items to be executed, and click [Next]. 

If [Startup] or [Shutdown] are selected, a setting sub-windows for each item is displayed. (Steps 8 or 9)

1

2

3
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If all of these items are deselected, proceed to Step 10. 

8 Select the startup settings, and click [Next]. 

The startup start date and time cannot be set in the Batch Table Wizard. Refer to "4.4.2 Start Data 
Acquisition at a Specified Date and Time (Startup)" P.89 to enter a specified date and time. 

1 Enter an instrument startup time at [Pumping Period].

2 Select [Startup Method File], and enter the method file.

1

2
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9 Select the shutdown settings, and click [Next]. 

1 Select [Shutdown Method File], and enter the method file. 

2 Enter an instrument shutdown time at [Cool down Time]. 

10 Enter a batch file name, and click [Finish]. 

This completes Batch Table setup using the Batch Table Wizard. The batch file is created using the 
specified file name. This Batch Table is displayed in the Batch Table sub-window. Check the contents of the 
Batch Table. 

1

2
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4.2.2 Edit Batch Tables
This section describes 2 functions, [Fill Series] and [Fill Down], that are often used for direct Batch Table 
editing. 

 Append Table Settings with an Incremental Number

The [Vial#], [Sample Name], [Sample ID], and [Data File] entries in the Batch Table are appended with an 
incremental number. 

This section describes how to add an incremental extension to the [Vial#]. 

1 Enter the [Vial#] for the top row. 

2 Right-click the top [Vial#] cell, and click [Fill Series] from the displayed menu. 

If [Vial#] is blank, the [Vial#] sub-window opens. If a value is entered in the [Vial#] cell that value is 
used incrementally fill the [Vial#] cells in the rest of the table. 

3 If the [Vial#] sub-window is displayed, enter the [Row#], [Vial#], [Repetitions], and select 

[Auto-increment], then click [OK]. 

The [Vial#] column is incrementally filled. 

[Fill Series]

[Fill Series] functions according to how the cell is selected and the value entered in the cell. 

• If the end of the character string is not a number (ex: “standard sample”)
A 3-digit number is appended starting with the row following the selected cell.
“standard sample”, “standard sample 001", “standard sample 002", and so forth. 

• If the end of the character string is a number (ex: “STD01”)
The cells are filled with STD01, STD02, STD03 and so forth. 

• If only 1 cell is selected (ex: “ABC”)
The cells following the selected cell become ABC001, ABC002, ABC003 and so forth. 



 Operators Guide   79

4.2  Create Batch Tables

4

• If multiple cells are selected (ex: “STD1”, “AAA” and “STD5” are selected in this order)
The selected cells are changed to STD1, STD2, and STD3. 

• If a blank cell is selected (ex: a cell in the [Sample Name] column)
The [Sample Name] sub-window opens. Enter the sample name parameters, and click [OK]. 

 Copy Settings

The individual columns of the Batch Table can be copied. 

This section describes how to copy and fill the [Sample Name] column. 

1 Enter a [Sample Name] in the top row. 

2 Right-click the top cell of the [Sample Name] column that is to be copied, and click [Fill 

Down]. 

The contents of the top cell is copied to the subsequent cells of the [Sample Name] column. 

[Fill Down]

[Fill Down] functions according to how the cell is selected. 

• If only 1 cell is selected (ex: “STD”)
All selected cells following the selected cell become STD. 

• If multiple cells are selected (ex: “STD1”, “AAA” and “STD5” are selected in this order)
All cells become the same STD1 as the initial cell. 

• If a blank cell is selected (ex: a cell in the [Sample Name] column)
The [Sample Name] sub-window opens. Enter the [Sample Name] parameters, and click [OK]. 
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4.2.3 Batch Table Parameters
In addition to sample information and sample type, method file, data file, and report output settings, the 
following Batch Table parameters can also be set. 

Parameter Contents

Run mode Determines whether there is a standby period before data acquisition, and whether to 
execute data acquisition and data processing on each row of the Batch Table. 

Background compensation Performs compensation using the blank (solvent only) chromatogram to subtract 
baseline drift or solvent peaks. 

^ Reference
For details, refer to "4.4.5 Background Data File" P.93. 

System check Performs a system check before data acquisition, enter the system check parameter in 
the top row of the Batch Table. Click the [System Check] cell, and enter the system 
check parameters in the [System Check] sub-window. 

System suitability Checks the suitability of the system based on the analysis results of known multiple 
samples.
The results can be displayed or output in text format. 

Custom parameters Calculation formulas can be set for totaling the peak area of related substances in 
analysis data and for compensating quantitative values. The results are output to a 
Quantitative Results Table or reports. 

^ Reference
For details, refer to "4.4.7 Custom Calculation Function" P.95. 

Action The batch processing can be controlled according to pass/fail of the check conditions in 
each row of the Batch Table. 

Options 1 to 10 Up to ten additional information columns can be added to the Batch Table. 
Once you enter [Option Title] in <Settings> - [Option Items] Tab, this additional sample 
information is saved in the same data as [Sample Name] and [Sample ID]. 
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 Hide or Display Batch Table Items

Use the [Table Style] sub-window to hide or display columns in the Batch Table. 

This section describes how to add or delete displayed items to the Batch Table. 

1 Right-click on the Batch Table, and select [Table Style]. 

2 Select the desired items, and click [OK]. 

Display Hidden Batch Table Items

1 Select the items to display from the [Hide Items] list. 

2 Click [Add]. 

The selected items are added to the end of the [Display Items] list. 

3 Select an item to change the display order. 

4 Click [Up] or [Down]. 

The top item in the [Display Items] list is displayed in the first (left) Batch Table column. 

1 2 3 4
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Hide Items in the Batch Table

1 Select the items to hide from the [Display Items] list. 

2 Click [Remove]. 

The selected items move to the [Hide Items] list. 

Realtime batch is executed based on settings in the Batch Table even if the items are hidden. 
For example, if a summary report output and summary report format file are entered, the summary 
report is output after realtime batch ends even if these items are hidden in the Batch Table. 

4.2.4 Before Editing Batch Tables in Dual-Line Configuration
In the case of dual-line configuration GC, realtime batch analysis can be performed in dual-line 
configuration. To perform realtime batch analysis in dual-line configuration, a Batch Table must be switched 
to the Batch Table for dual lines before editing the Batch Table.

This section describes how to switch to the Batch Table for dual lines. Referring to "4.2.1 Batch Table 
Wizard" or "4.2.2 Edit Batch Tables", create a Batch Table using the Batch Table for the dual lines.

1 Click the  (Settings) icon on the [Realtime Batch] assistant bar.

1 32
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2 Click the [Type] tab, select [Line1 & Line2], and click [OK].

Selecting [Line 2] configures batch processing to be executed only for [Line 2].

If [Line 1 & Line 2] is selected, the lines are displayed in the Batch Table by a row number and a line 
number such as "1-1" or "1-2", and the Batch Table edition or realtime batch analysis is executed by two 
rows at a time.

Editing the Batch Table items in the second row for Line 2 is restricted as follows.

• The [Sample Type], [Method File], [Level#], [Baseline Check], [System Check], [User Prog.], and [Action] 
items are in common with the Line 1 and cannot be edited for Line 2.

• In [Run Mode], there are common items set for both Line 1 and Line 2 and items set for each Line. 
Therefore, in the [Run Mode] sub-window for setting the cell content, common items are set on Line 1 and 
only [Data Acquisition] and [Data Analysis] at [Process] can be set on Line 2.
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4.3 Data Acquisition Using Batch Tables

Perform data acquisition using the Batch Table created in "4.2 Create Batch Tables". 

This section describes partial execution of a Batch Table, how to stop realtime batch, and how to pause 
realtime batch to edit the Batch Table. 

4.3.1 Partial Execution of a Batch Table 
This section describes how to perform data analysis on only part of the Batch Table (1 to 3 rows). 

1 Select the row numbers to be analyzed. 

2 Click the  (Start Realtime Batch) icon on the [Realtime Batch] assistant bar. 

3 Check [Selected Row(s)], and click [Start]. 

A screen for confirming partial execution opens. 

4 In this screen, click [OK]. 

Batch processing of the selected rows is executed. 
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4.3.2 Stop Realtime Batch

1 Click the  (Stop) icon on the [Realtime Batch] assistant bar. 

2 Select the processes to stop, and click [OK]. 

Batch processing is stopped. 

• If only [Data acquisition under execution] is selected, the current data acquisition is stopped and 
processing moves to the next row of the Batch Table, and data acquisition is started on that row. 

• If only [Batch Processing] is selected, processing for the entire Batch Table stops after the current 
data acquisition ends. 

• If both [Data acquisition under execution] and [Batch Processing] are selected, Batch Table 
processing stops in the middle of the current acquisition. 

• When data acquisition is resumed in the row after the stop of batch processing, some information 
such as, pass/fail information for the QA/QC function, may be cleared. 
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4.3.3 Pause Realtime Batch to Edit the Batch Table
Realtime batch can be paused and the non-acquired rows of the Batch Table can be edited (add, insert, 
delete). 

This section describes how to delete a non-acquired row of the Batch Table. 

• This operation cannot be performed on rows that have already been acquired. 

• If the TurboMatrixHS is used for GC, realtime batch analysis cannot be paused.

1 During realtime batch, click the  (Edit Table/Restart) icon on the [Realtime Batch] 

assistant bar. 

2 Set the row where realtime batch is to be paused, and click [OK]. 

Data acquisition goes into the standby state at the selected row, and batch processing is paused. 

Data acquisition continues until the row selected in the [Pause] sub-windows reached. The [Release 
Paused Status] sub-window opens when the pause is executed.
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3 Select the row to be deleted on the Batch Table, right-click on the selected row, and click 

[Delete Row]. 

The selected row is deleted.

4 Click the  (Save) button on the toolbar. 

The method file is overwritten and saved.

5 Click the  (Edit Table/Restart) icon on the [Realtime Batch] assistant bar. 

Batch processing is resumed from the paused row. 
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4.4 Automation of Data Acquisition Operations

Using the Batch Table to automate data acquisition allows for the automation of baseline check, system 
check, startup and shutdown as well as mobile phase substitution (autopurge). 

This section describes how to automate data acquisition, output of summary reports, background 
compensation, bracket quantitation, and the custom calculation function. 

Use the Batch Table [Action] function to control batch processing actions. 

4.4.1 Check Baseline Stability Before Data Acquisition (Baseline Check)
This section describes how to check the baseline before starting data acquisition. Set the baseline check 
thresholds and other items in the baseline check parameter of the method file. 

^ Reference
See "2.3.3 Check the Baseline" P.21 for LC, or "2.3.3 Check the Baseline" P.21 for GC, for details on setting 
the baseline check parameter of the method file. 

1 Select [Baseline Check] in the row where baseline check is to be performed. 

^ Reference
If [Baseline Check] is not displayed in the Batch Table, refer to "Hide or Display Batch Table Items" 
P.81. 

2 Click the  (Save) button on the toolbar. 

The baseline check settings are saved to the batch file. 
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4.4.2 Start Data Acquisition at a Specified Date and Time (Startup)
Use realtime batch Startup to automatically start realtime batch at a preset date and time. This section 
describes how to use Startup. 

1 Click the  (Settings) icon on the [Realtime Batch] assistant bar. 

2 Click the [Startup] tab, enter the conditions for automatically starting the analytical 

instruments, and click [OK]. 

1 Select [Startup]. 

2 When [Set start date and time when starting batch] is selected, the sub-window for entering the start 
date and time is displayed. 

The analytical instruments are started at the specified [Start Date & Time].

3 Select [Method File], and enter the name of the method file that contains the parameters for 
analytical instruments startup. 

• Click  to change the referenced file. 

• Enter a time in [Pumping Period] for the analytical instruments to operate at the initial conditions 
before batch processing begins. 

• If a method file is not specified, the analytical instruments are started up by the parameters 
downloaded to the instruments when the startup is performed. 

3 Click the  (Save) button on the toolbar. 

The startup settings are saved to the batch file. 

2

3

1
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4.4.3 Shutdown Analytical Instruments After Data Acquisition 
(Shutdown)
Use realtime batch Shutdown to automatically shut down the analytical instruments after realtime batch 
ends. This section describes how to use Shutdown. 

1 Click the  (Settings) icon on the [Realtime Batch] assistant bar. 

2 Click the [Shutdown] tab, enter the conditions for automatic shutdown of the analytical 

instruments, and click [OK]. 

1 Select [Shutdown]. 

2 Select [Shutdown Method File], and enter the name of the method file that contains the parameters 
for shutdown of the analytical instruments.

• Click  to change the referenced file.

• Enter a time in [Cool Down Time] for the instruments to run after analysis and before shutdown. 

• If a method file is not specified, the analytical instruments are shut down by the parameters 
downloaded to the instruments when a shutdown is performed. 

3 Click the  (Save) button on the toolbar. 

The shutdown settings are saved to the batch file. 

2

1
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 Turn the Detector Lamp Off

When creating a shutdown method file, select [Off] in the [Lamp] parameter. 

4.4.4 Print a Summary Report
A summary report summarizes the chromatograms and the statistical calculation results from multiple data. 
This section describes how to set a summary report. 

1 Drag and select the rows in the Batch Table to be included in the summary report. 

If the [Summary Type] and [Summary Report Format File] items are not displayed in the Batch Table, 
refer "Hide or Display Batch Table Items" P.81. 

2 Right-click on the selected rows, and click [Summary Report Settings]. 
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3 Select a [Report Format File], and click [OK]. 

• Click  to change the referenced file. 

• The selected start row and end row numbers are displayed at [Row Number]. Change the numbers to 
change the rows to be printed in the summary report. 

^ Reference
See "8.4 Create a Report Format File" P.236 for details on the report format. 

4 Click the  (Save) button on the toolbar. 

The summary report settings are saved to the batch file. 
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4.4.5 Background Data File
Background data refers to a chromatogram obtained by performing the gradient analysis (LC) or 
programmed temperature analysis (GC) without injecting a sample. Use the background data file to 
compensate for baseline drift in the acquired sample date.

This section describes how to acquire background data and perform background compensation in the 
same realtime batch. 

1 Select the row where background data will be acquired. 

• Ensure that the background data row is above the sample rows. 

• If [Auto Filename] is selected for the [Data File] column, click the  (Settings) icon on the 

[Realtime Batch] assistant bar, and select [Create filenames automatically with] on the [Data 
File Name] tab. 

2 Select [Background] for the rows where background compensation will be applied. 

3 Enter a [Background Data File] for each of the rows where [Background] is selected. 

^ Reference
If [Background] and [Background File] are not displayed in the Batch Table, refer to "Hide or 
Display Batch Table Items" P.81. 

5 Click the  (Save) button on the toolbar. 

The background compensation settings are saved to the batch file. 

1 32
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4.4.6 Bracket Quantitation
When sequential data acquisition is performed on multiple samples, the detector sensitivity may change 
over time and sometimes affect the initial and final data acquisition results. To correct this situation, the 
quantitative value for unknown samples can be obtained by bracketing the unknown sample with standard 
samples, and creating a calibration curve from the standard sample data acquired before and after the 
unknown sample. 

Three different types of bracket calibration curves are available, [Overlap], [Sequence] and [Average]. 
Select the appropriate type according to how the standard sample calibration points are set. 

This section describes how to select bracket quantitation. 

1 Click the  (Settings) icon on the [Realtime Batch] assistant bar. 

2 Click the [Bracket] tab, select the bracket quantitation type, and click [OK]. 

3 Click the  (Save) button on the toolbar. 

The bracket quantitation settings are saved to the batch file. 

No. Parameter Explanation

1 Overlap Quantitates the unknown sample using the calibration curve made from the results of the 
standard samples acquired before and after the unknown sample. 

2 Sequence Quantitates the unknown sample using the calibration curve made from the results of all 
standard samples regardless of the position of the bracketed unknown sample. 

3 Average Quantitates the unknown sample using the calibration curve made by averaging the results 
of all standard samples before the unknown sample and the results of the standard sample 
directly after the unknown sample. 

1

2

3
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4.4.7 Custom Calculation Function
The custom calculation function allows for automation of operations, such as totaling of the peak area and 
quantitative value compensation. 

This section describes how to set custom parameters. 

1 Click the [Custom Parameters] cell in the Batch Table where custom calculations are 

necessary. 

^ Reference
If the [Custom Parameters] column is not displayed in the Batch Table, refer to "Hide or Display 
Batch Table Items" P.81. 

2 Enter [Title], [Formula] and constants to display in the Compound Result Table, and 

click [OK]. 

No. Parameter Explanation

1 Title Enter a title to displayed in the Compound Result Table. 

2 Formula Enter a formula using numeric values, macro variables and operators (+, -, *, /, e). 
• Macro variables

Retention time (RetTime), area (Area), height (Height), concentration (Conc)
• For a specific peak

RetTime [1] (retention time of peak with compound ID “1”)
• To specifying peaks between data

RetTime [1] (3) (retention time of peak with compound ID “1” of data at 3 rows above the 
preset row)

3 Const A to C Up to any three constants can be specified in each calculation formula. 

1 2 3
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3 Click the  (Save) button on the toolbar. 

The custom parameter settings are saved to the batch file. 

Execute batch processing to check the calculation results, and then check the results on the [Compound] tab 
in [Results View]. If custom parameters are not displayed, display them using the [Table Style] sub-window. 

 Custom Parameter Example

The 1st row is an example of a compensated area calculation. In this example, each peak area of the 
unknown sample is multiplied by the compensation factor to obtain the compensated area. 

The 2nd row is an example of a calculation between samples. In this example, calculation uses the peak 
area of an unknown sample and the peak area of a standard sample that was acquired three samples 
before the unknown sample. 

The 3rd row is an example of calculation between peaks. In this example, the total value of 4 peak values 
is calculated. 
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4.4.8 Set the Injection Volume and Multi-Injection Counts for the GC
With the GC unit, the injection volume and Multi-injection counts are set for each sample in the Batch Table 
to perform data acquisition using the same method file.

This section describes how to set the sample injection volume or multi-injection counts in the Batch Table.

1 Click the  (Settings) icon on the [Realtime Batch] assistant bar.

2 Click the [Type] tab, deselect [Use Method Inj. Volume & Multi-Inj. Counts], and click 

[OK].

In the case of a dual-line configuration GC, select the line to use in the Batch Table.

3 Set [Inj. Volume] and [Multi Injection] in the Batch Table.

^ Reference
If [Inj. Volume] and [Multi Injection] are not displayed in the Batch Table, refer to "Hide or Display 
Batch Table Items" P.81 at "4.2.3 Batch Table Parameters".

4 Click  (Save) on the toolbar.

[Inj. Volume] and [Multi Injection] settings are saved to the batch file.

Items in the [Setting] sub-window are stored to memory for each batch file.
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4.5 Data Acquisition Using the Batch Queue Function

This software allows you to perform continuous data acquisition using different batch files. Batch files used 
for continuous data acquisition are registered to a memory area called the “batch queue”. 

In the batch queue, registered batch files are displayed as a list, and are executed in order by realtime 
batch from the top of the queue. 

The order of registered batch files can be changed and registered batch files can be deleted from the list. 

4.5.1 Register Batch Files to the Batch Queue

1 Click the  (Batch Editor) icon on the [Main] assistant bar. 

2 Open the batch file in the [Batch Editor] window. 

3 Click the  (Queue Batch Run) icon on the [Batch Editor] assistant bar. 

The batch file is added to the batch queue. 

• The information for batch files that are registered to the batch queue is retained even if the 
[Realtime Analysis] program is exited. 

• The status of a batch file registered to the batch queue can be set to “Waiting” (pause) before 
realtime batch analysis begins on that batch file. Select [The batch queue is registered as a state 
of “Waiting”] on the [Batch] menu, select the rows of the batch queue to set to the “Waiting” status, 
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and click [Start] to save the batch queue settings. 

4.5.2 Change the Batch Queue Order or Delete Batch Files 

1 Click the  (Batch Editor) icon on the [Main] assistant bar. 

2 Click the  (Batch Queue) icon on the [Batch Editor] assistant bar. 

3 To change the order of batch files in the batch queue, select the desired row, and click 

[Up] or [Down]. 
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The order of batch files in the batch queue is changed. 

4 To delete a registered batch file from the batch queue, right-click on the desired row, 

and click [Delete]. 

The selected row is deleted from the batch queue. 

5 Click [Start]. 

Realtime batch is started in the new batch file order. 
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4.5.3 Priority Batch
The currently acquiring batch file can be paused to give priority to another batch file that must be measured 
immediately in realtime batch. This is called “priority batch”. 

1 Click the  (Batch Editor) icon on the [Main] assistant bar. 

2 Display the batch file to give priority to in realtime batch. 

3 Click [Start Priority Batch] on the [Batch] menu. 

The priority batch is started. 

• Priority batch is started after the current data acquisition ends. 

• Priority batch cannot be set to batch files set with bracket quantitation, summary report, QA/QC, 
and batch action. 

The following shows an example of how the [Batch Queue] sub-window changes when priority batch is 
set for batch file Sample3.lcb. 
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4.6 Create a Calibration Curve to Quantitate an 
Unknown Sample

If data processing parameters have already been determined for a target compound, they may be 
extracted from a method so that a calibration curve can automatically be established during acquisition of 
standard samples and used for quantitation of unknown samples.

This section describes how to set data processing parameters and Batch Table items to perform 
quantitative calculations. 

4.6.1 Edit the Data Processing Parameters

1 Click the  (Data Analysis) icon on the [Acquisition] assistant bar. 

2 Drag-and-drop the data file onto the [Data Analysis] window from the [Data Explorer] 

sub-window. 

Select a data file with data acquisition conditions (instrument parameters) that match those for the target 
component to be analyzed.

3 Click the  (Wizard) icon on the [Data Analysis] assistant bar. 

4 Refer to "6.5.1 Compound Table Wizard" to set the data processing parameters using 

the Compound Table Wizard. 

5 Click  (View Mode) in [Method View]. 

The data loaded in the [Data Analysis] window is reanalyzed according to the new parameter settings. 
Check the analysis results in [Chromatogram View] and [Results View]. 

6 Click the  (Apply to Method) icon on the [Data Analysis] assistant bar. 

The parameters are exported to the method file. 

^ Reference
For details, see "6.7 Save (Export) to Method Files" P.174. 
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4.6.2 Edit Batch Tables
This section describes how to the set the [Method File], [Sample Type], [Level#], [Data File], [Sample 
Amt.], [Dil. Factor.], and [ISTD Amt.] items required for quantitative calculation. 

See "4.2 Create Batch Tables" P.65 for details on other items. 

 Add Rows to Batch Tables

1 Right-click on the Batch Table, and select [Add Row] from the displayed menu. 

2 Enter the number of samples, and click [OK]. 

Rows are added to the Batch Table. 
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 Set the Method File

1 Click the [Method File] cell on the Batch Table. 

2 Select the method file, and click [Open]. 

The method file is set. 

3 Set other [Method File] cells in the same way. 

^ Reference
Refer to "Copy Settings" P.79 to copy and paste the same method file name to multiple rows. 
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 Set the Sample Type

Set the type of sample to measure. 

In the case of a standard sample, set the first standard sample to [Initialize Calibration Curve] and the next 
standard sample to [Add Calibration Level]. The default setting [0: Unknown] is used for unknown samples. 

1 Click the [Sample Type] cell of the first standard sample. 

2 Click [Standard], select [Initialize Calibration Curve] and click [OK]. 

The initial cell for the sample type is displayed as [1: Standard (I)]. 

3 Click the [Sample Type] cell of the next standard sample. 

4 Click [Standard], select [Add Calibration Level] and click [OK]. 

The [Sample Type] cell is displayed as [1: Standard]. 
Repeat steps 3 and 4 for multiple standard samples. 
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 Set the Level#

Set the standard sample [Level#] according to the concentration value in the Compound Table of the 
method file. The calibration points are created from the level number of the Compound Table and the area 
and height values of the preset standard sample.

[Level#] values are not used for unknown samples, even if they are set.

1 Click the [Level#] cell for the standard sample. 

2 Enter the level number.

The level number is changed. 

3 Set the [Level#] cell for other standard samples. 

 Set the Data File Name

Either directly enter a file name in the [Data File] cell, or automatically create the data file.

This section describes how to automatically create a data file name. 

1 Click the  (Settings) icon on the [Realtime Batch] assistant bar. 
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2 Click the [Data File Name] tab, set each item, and click [OK]. 

1 Select [Create filenames automatically with]. 

2 Select the items for the file name to automatically create from the [Items] list. 

Enter a character string in the [Prefix] box to create a data file name with a fixed character string. 

3 Click [Add]. 

Items are added onto the end of [Selected Items], and the file name is created using the currently 
displayed items. 

4 Select an item in the [Selected Items] list to change the display order. 

5 Change the display order by clicking [Up] or [Down]. 

Automatically created file names use an _ (underscore) to join together items in order starting 
with the top item in the [Selected Items] box. 
For example, when a file name is automatically created using Batch File Name (AAA), Batch 
Start Date (2008/04/01):
the file name is “AAA_20080401”. 

6 Select a numeric format to automatically append the file name with an incremental number at [Auto-
increment Format]. 

The data file name in the Batch Table is displayed as [Auto Filename]. 

Postrun batch reprocessing cannot be executed when a field is set to [Auto-increment Format] because a 
specific filename and path are required. Therefore, it is recommended to copy the batch after realtime 
acquisition ends. When a batch is copied, the data file name generated at the time of data acquisition is 
transferred to the appropriate cell of the copied batch allowing postrun batch processing to be executed.

2

6

3 4 51
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To copy a batch, select the following menu item. 

 Set the Sample Amount, Dilution Factor, and ISTD Amount. 

Enter values in each cell of the Batch Table to set the [Sample Amt.] (weight) and dilution factor for an 
unknown sample, and ISTD amount (for internal standard method) to spike the unknown sample. 

This section describes how to set the ISTD amount. 

• Enter the ISTD amount for sample types other than the standard sample when the quantitative calculation 
method is internal standard method. 

• Enter the concentration of the ISTD for the number of internal standard substances set in the Compound 
Table. 

• Set [Dilution Factor] to either [Apply] or [Not Used] in the [Data Processing Setting] sub-window in the 
[System Settings] sub-window. 

^ Reference
If [Sample Amt.], [Dil. Factor] and [ISTD Amt.] are not displayed in the Batch Table, refer to "Hide or Display 
Batch Table Items" P.81. 

1 Click the [ISTD Amt.] cell for the unknown sample. 
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2 Enter the concentration for each internal standard substance, and click [OK]. 

1 Deselect [Use level 1 conc. in the compound table of a method file]. 

If [Use level 1 conc. in the compound table of a method file] is selected, the level 1 concentrations of 
the compounds specified as the internal standard substances in the method file are used. Select this 
checkbox when a standard sample and unknown sample are spiked with the same amount of 
internal standard substances. 

2 Enter the concentrations of the internal standard substances in each group. 

3 Enter the [ISTD Amt.] cell for other unknown samples. 

4.6.3 Data Acquisition Using Batch Tables
Perform data acquisition using a preset batch file. 

1 Click the  (Start Realtime Batch) icon on the [Realtime Batch] assistant bar. 

2

1
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When data acquisition is started, the [Realtime Batch] and [Data Acquisition] windows change as follows. 

During data acquisition, the [LabSolutions Service] icon in the Systray on the Taskbar flashes green. 

Do not turn the PC off while the [LabSolutions Service] icon is flashing. 

^ Reference
See "4.3.2 Stop Realtime Batch" P.85 for details on how to stop or pause realtime batch. 

 When an Autosampler Is Not Used

For LC

When a manual injector on the LC is connected to the Manual Inject (start) terminals of the system 
controller, initiate acquisition by rotating the manual injector to the inject position.

For GC

If the connection is configured to initiate data acquisition by the START input signal of the GC, inject the 

sample, and then press the  button on the GC. For more details, refer to the Instruction Manual for 

the GC unit.

In all other cases, click [Start] in the [Start Data Acquisition] sub-window and press the [start / stop] button 
on the CBM-102.
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4.6.4 Check the Quantitation Results
Check the quantitation results for the unknown sample in the [Data Analysis] window. 

1 Click the  (Data Analysis) icon on the [Realtime Batch] assistant bar. 

The [Postrun Analysis] program is displayed, and the data file for the selected row on the Batch Table is 
loaded. 

2 Click the [Compound] and [Calibration Curve] tabs in [Results View], and check the 

quantitation results. 
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4.7 Acquisition Cycle Time Optimization

The total time for the batch analysis can be reduced by using the acquisition cycle time optimization 
function that overlaps autosampler pretreatment for next sample during current data acquisition.

This function can be performed when using CBM-20A/20Alite(Ver.2.0 or later) as a LC System Controller. (It 
is available for any autosampler controlled by CBM-20A/20Alite.)

For GC, This function can be performed when using GC-2030 and AOC-20i, AOC-20i+s or AOC-20d.

Both method file and batch file should be set to use the acquisition cycle time optimization function. This 
section describes how to set these parameters.

4.7.1 Set the Instrument Parameters (LC)

1 Click the (Data Acquisition) icon on the [Main] assistant bar in the [Realtime 

Analysis] program.

2 Click [Advanced] on the [Instrument Parameters View] to open the [Advanced] sub-

window.

3 Click the [Controller] tab, and select [Automatic] for the [Autosampler pretreatment 

beginning].

^ Reference
Refer to Help for details.

4 Click [Save Method File As] on the [File] menu to save the method file.
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4.7.2 Set the Instrument Parameters (GC)

1 Click the (Data Acquisition) icon on the [Main] assistant bar in the [Realtime 

Analysis] program.

2 Change the [View Mode] to [Instrument Parameter] on the [Control Panel] and click the 

[AOC-20i] (or [AOC-20i+s], [AOC-20d]).

3 Check the [Activate Overlap], and set [Type] and [Time].

^ Reference
Refer to Help for details.

4 Click [Save Method File As] on the [File] menu to save the method file.
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4.7.3 Create Bath Tables

1 Click the (Realtime Batch) icon on the [Main] assistant bar.

2 Open the batch file in the [Realtime Batch] window.

3 Enter the method file saved above to all rows of [Method File] column.

• By entering the method file to the top row and then selecting [Fill Down] from right-click menu on 
the cell, it can be set to all rows.

• The overlap injection can not be performed when the method file name is different between lines.

4 Click the (Settings) icon on the [Realtime Batch] assistant bar.

5 Select a [Start pretreatment for next sample during current data acquisition] checkbox 

in the [General] tab.

^ Reference
Refer to Help for details.

6 Save the batch file and execute the batch analysis.
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5Calibration Curves

This chapter describes how to make calibration curves and check calibration curve information. 

There are two ways to make a calibration curve:

• Automatic creation by batch processing

• Manual creation in the [Calibration Curve] window

This section describes how to make calibration curves automatically by postrun batch processing at 
"5.1 Calibration Curves by Postrun Batch" and manually in the [Calibration Curve] window at "5.2 
[Calibration Curve] Window". 

^ Reference
See "4.6 Create a Calibration Curve to Quantitate an Unknown Sample" P.102 for details on automatically 
making calibration curves using realtime batch. 

5.1 Calibration Curves by Postrun Batch

Use postrun batch to automatically make a calibration curve using the data file of a standard sample that 
has already been acquired. 

This section describes how to set data processing parameters and Batch Table items to make calibration 
curves. 

5.1.1 Edit the Data Processing Parameters
This section describes how to edit the data processing parameters of method files using standard samples 
data. 

1 Click the  (Data Analysis) icon on the [Main] assistant bar in the [Postrun Analysis] 

program. 

2 Drag-and-drop the data file of the standard sample from which data has already been 

acquired onto the [Data Analysis] window from the [Data Explorer] sub-window. 

3 Click the  (Wizard) icon on the [Data Analysis] assistant bar. 
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4 Refer to "6.5.1 Compound Table Wizard" to set the data processing parameters using 

the Compound Table Wizard. 

5 Click  (View Mode) in [Method View]. 

The data loaded in the [Data Analysis] window is reanalyzed according to the new parameter settings. 
Check the analysis results in [Chromatogram View] and [Results View]. 

6 Click the  (Apply to Method) icon on the [Data Analysis] assistant bar. 

The parameters are exported to the method file. 

^ Reference
For details, see "6.7 Save (Export) to Method Files" P.174. 

5.1.2 Edit Batch Tables

 Create Batch Tables

This section describes how to create batch tables. There are two ways to create a Batch Table according to 
how data is acquired. 

• New Batch Table

• Load the Batch Table used for data acquisition

New Batch Table

1 Click the  (Postrun Batch) icon on the [Main] assistant bar in the [Postrun Analysis] 

program. 
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If the  (Postrun Batch) icon is not displayed on the assistant bar, click  on the 

assistant bar title. 

2 Click [Add Rows with Selected Data File] on the [Edit] menu. 

3 Select the data file name and then click . 

The data file name is displayed in the [Selected Data Files] box. Repeat this procedure to select all of the 
files required for postrun batch. 

The Batch Table is created from the information in the selected data file. 
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Load a Batch Table Used for Data Acquisition

1 Click the  (Postrun Batch) icon on the [Main] assistant bar in the [Postrun Analysis] 

program. 

If the  (Postrun Batch) icon is not displayed on the assistant bar, click  on the assistant 

bar title. 

2 Drag-and-drop the batch file used for data acquisition onto the [Postrun Batch] window 

from the [Data Explorer] sub-window. 
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 Set the Sample Type

Set the type of sample to measure. 

In the case of a standard sample, set the first standard sample to [Initialize Calibration Curve] and the next 
standard sample to [Add Calibration Level]. The default setting [0: Unknown] is used for unknown samples.

1 Click the [Sample Type] cell of the initial standard sample. 

2 Click [Standard], select [Initialize Calibration Curve] and click [OK]. 

The initial cell for the sample type is displayed as [1: Standard (i)]. 

3 Click the [Sample Type] cell of the next standard sample. 

4 Click [Standard], select [Add Calibration Level] and click [OK]. 

The cell for the sample type is displayed as [1: Standard]. 
Repeat steps 3 and 4 for multiple standard samples. 
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 Set the Level#

Set the standard sample [Level#] according to the concentration value in the Compound Table of the 
method file. The calibration points are created from the level number of the Compound Table and the area 
and height values of the preset standard sample. 

[Level#] values are not used for unknown samples, even if they are set. 

1 Click the [Level#] cell for the standard sample. 

2 Enter the level number. 

The level number. is changed. 

3 Set the [Level#] cell for other standard samples. 

5.1.3 Postrun Analysis Using Batch Tables

1 Click the  (Start Postrun Batch) icon on the [Postrun Batch] assistant bar. 

Postrun batch is started. 
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5.1.4 Check Calibration Curves
Check whether the calibration curve has been successfully drawn in the [Calibration Curve] window in 
"5.1.3 Postrun Analysis Using Batch Tables". 

1 Select the [Method File] cell in the batch table, and click the  (Method Development) 

icon on the [Postrun Batch] assistant bar. 

2 Check the calibration curve in the [Calibration Curve] window. 
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5.2 [Calibration Curve] Window

Check calibration curves made in realtime or postrun batch in the [Calibration Curve View] window and 
make calibration curves by manually adding calibration points. 

The [Calibration Curve] window has four views, [Calibration Curve View] displays calibration curves, 
[Method View] displays the data processing parameters, the [Data Files] tree view displays the data files 
used for calibration curves, and [Chromatogram View]. 

5.2.1 [Calibration Curve] window Description
This section describes how to view the [Calibration Curve] window. 

The layout of each view can be changed in the [Calibration Curve] window. 
Two modes are provided for the display layout, [Normal Mode] and [Many Ingredients Mode], which is used 
when there are many identified peaks. 

No. Explanation

1 Displays the [Standard] and [Calibration Curve] toolbars. 

2 Displays a calibration curve graph, calibration curve information and Calibration Table. 

3 Displays the data files for the individual levels used to make the calibration curve. 
Calibration points for each level can be added or deleted. 
Add data files by dragging-and-dropping them from the [Data Explorer] sub-window. 

4 Displays the chromatograms and sample information of the data files used to make the calibration curve. 

5 Parameters are displayed in the [View] mode, and can be changed in the [Edit] mode. 

6 Displays the data processing parameters in the method file.

Toolbar1 [Calibration Curve View]2 [Data File] tree view3

5

6 [Method View]

4 [Chromatogram 
View]
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5.2.2 Make Calibration Curves in the [Calibration Curve] Window
This section describes how to manually make calibration curves. 

Data processing parameters must be set before calibration curves can be manually created in the 
[Calibration Curve] window. 

1 Click the  (Calibration Curve) icon on the [Main] assistant bar in the [Postrun 

Analysis] program. 

2 Select the method file. 

• Existing method file

1 Drag-and-drop the method file onto the [Calibration Curve] window from the [Data Explorer] sub-
window. 

• New method file

1 Click the  (New) button on the toolbar. 

The following message is displayed. 

2 Click [OK].
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3 Select the method file used for data acquisition or a method file with the same system configuration, 
and click [Open]. 

The detector is set based on the system configuration information in this file.

The [Calibration Curve] window changes to [Untitled]. 

3 Click the [Data] tab at the bottom of the [Data Explorer] sub-window. 
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4 Drag-and-drop the data file of the standard sample onto the target level in the [Data 

Files] tree view from the [Data Explorer] sub-window. 

Drag-and-drop the data file onto the same level position as the concentration set in the Compound 
Table of the method file. 

The data file is added to the level. 

Repeat the above step and drag-and-drop the additional standard sample data file onto the target level 
when multiple standard samples are used. 
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Set the [# of Calib. Levels] on the [Quantitative] tab in the [Method View] to increase the number of 

levels in the calibration curve. 

5 Click the  (Wizard) icon on the [Calibration] assistant bar. 
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6 Refer to "6.5.1 Compound Table Wizard" to set the data processing parameters using 

the Compound Table Wizard. 

7 Click  (View Mode) in [Method View]. 

Data processing is performed on the data loaded in the [Data Files] tree view according to the parameters 
set in the Compound Table Wizard. 

8 Click the  (Save) button on the toolbar. 

The method file and the data file(s) in the [Data Files] tree view are saved. 

In the case of a dual-line configuration GC, select the line to export the method from, and click [OK].
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6Data Analysis

This chapter describes how to display the results of acquired data and set data processing 
parameters during postrun analysis. The [Data Analysis] window displays the contents of a single 
data file. 

^ Reference
• Use the [Quant Browser] window to display the contents of multiple data files, refer to "9 Quant Browser" 

P.263. 

• Refer to "5 Calibration Curves" P.115 for details on creating calibration curves used for quantitative 
calculations. 

6.1 [Data Analysis] Window

The [Data Analysis] window is comprised of the following views:

• [Chromatogram View] - displays chromatograms and instrument status

• [Results View] - displays Peak Tables and quantitative results

• [Method View] - displays the data processing parameters

6.1.1 Open the [Data Analysis] Window

1 Click the  icon in the [LabSolutions Main] window.
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2 Double-click [Postrun]. 

The [Data Analysis] window can also be opened by clicking the  (Data Analysis) icon on the 

[Acquisition] assistant bar. 

3 Drag-and-drop a data file onto the [Data Analysis] window from the [Data Explorer] sub-

window. 

The content of the data file is displayed in the [Data Analysis] window. 
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6.1.2 [Data Analysis] Window Description
This section describes how to view and use the [Data Analysis] window. 

The size of each view can be changed. Click [Save Layout] on the [Layout] menu, and save the changed 
layout under a new name. 

No. Explanation

1 Displays the [Standard] toolbar, [Data Analysis] toolbar, and [Background Compensation Bar]. 

2 Displays the chromatogram for the currently open data file. 
[Chromatogram View] displays graphs with the [Full Chromatogram] on top and the [Zoomed Chromatogram] 
on the bottom. If the data has been acquired from multiple detectors, [Other Detector] graphs can also be 
displayed. 
[Pressure] and [Flow] can be set to overlaying [Chromatogram View] in the display settings. 

^ Reference
 Refer to "Status Display in the [Chromatogram View]" P.132 for details. 

3 Displays the parameters in the [View] mode. 
Switch to the [Edit] mode to change the parameters. 
Change back to the [View] mode to perform postrun analysis using edited parameters. 

4 The data processing parameters are displayed on the [Integration], [Identification], [Quantitative], [Compound], 
[Group], [Performance], [Custom], and [QC Check] tabs. 

^ Reference
Refer to "6.2 Peak Integration Parameters" P.134 for details. 

5 The analysis results are displayed on the [Peak Table], [Compound], [Group], and [Calibration Curve] tabs. 

[Chromatogram View]2Toolbar1

3

5 [Results View] 4 [Method View]
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 Status Display in the [Chromatogram View]

The pressure, temperature and other conditions at the time of data acquisition are displayed and can be 
overlaid in the [Chromatogram View]. 

1 Right-click on the graph, and click [Display Settings]. 

2 Click the [Status] tab, make the necessary selections, and click [OK]. 

1 Select the status items to be overlaid on the chromatogram. 

2 Set the display range of each status item or click [Normalize]. 

3 Select the parameter to display on the right axis of the graph (Intensity Axis). 

 Top of Peak Comment

1 Right-click on the chromatogram, and click [Graph Properties]. 

1

2

3
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2 Select the peak top comment that is displayed on zoomed chromatograms, and click 

[OK]. 

The selected comment is displayed at the top of the peak in the enlarged chromatogram. 
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6.2 Peak Integration Parameters

Change the peak integration parameters and repeat peak integration. 

While in the [Data Analysis] window, the changes to peak integration parameters are applied only to data 
processing parameters in the current data file. 

The parameters must be exported to a method file before they can be applied to other data, then data 
processing using this newly saved method must be applied to all of the additional data. Refer to "6.7 Save 
(Export) to Method Files" P.174. 

6.2.1 Peak Integration of Detected Peaks
This section describes how to set peak integration parameters. 

1 Click  (Edit Mode) in [Method View]. 

Click the [Integration] tab, and change the parameters as required. 

Click  to change the integration time program and peak selection range. 

If analysis was performed on multiple detectors, the parameter changes can be applied to the other 
channels by clicking [Copy to All Channels]. 
Click [Noise/Drift Calculation], and make changes to the [Noise/Drift Calculation Settings] in the sub-
window that is displayed. 

^ Reference
Refer to Help for details about each of the parameters. 

2 Click  (View Mode) in [Method View]. 

The data loaded in the [Data Analysis] window is reanalyzed according to the new parameter settings. 
Check the processing results in the [Chromatogram View] and [Results View]. 
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6.2.2 Remove Unwanted Peak Integration

 Remove Integration of Unwanted Peaks with Minimum Area/Height

Use a larger [Min. Area/Height] value to exclude integration of small peaks. 

The following example describes how to change the [Min. Area/Height] value from “1000” to “10000”. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Integration] tab, and change the [Min. Area/Height] value to “10000". 

Select [Height] at [Calculated by] to remove the integration of unwanted peaks based on peak 
height. 

3 Click  (View Mode) in [Method View]. 

The data loaded in the [Data Analysis] window is reanalyzed according to the new parameter settings. 
Check the processing results in the [Chromatogram View] and [Results View]. 
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 Remove Integration of Unwanted Peaks with the Integration Time Program

The integration time program allows for detailed peak integration, that is not normally possible with typical 
integration parameters. 

The following example describes how to remove integration of unwanted peaks using the integration time 
program. 

You can delete unwanted peaks by setting period in which peak detection is not performed in the Time 
Program Table in the [Integration Time Program] sub-window. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Integration] tab, and click . 

3 Create an integration time program, and click [OK]. 

1 Click  (Period of “Integration Off”). 

2 Use the cursor to select the start and end positions of the range where integration is not performed. 

3 Evaluate the [Start Time] and [End Time] in the [Period of “Integration Off”] sub-window, and click 
[Simulate]. 

2

1

3
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The time and processing commands are added to the time program. 

Examine the resulting integration. 

Use the mouse to click  to zoom in or out a chromatogram and change the display of the 
specified view area. 

4 Click  (View Mode) in [Method View]. 

The data loaded in the [Data Analysis] window is reanalyzed according to the new parameter settings. 
Check the processing results in the [Chromatogram View] and [Results View]. 
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6.2.3 Analyze Tailing Peaks
This section describes how to process a target peak that overlays the tail of the main peak. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Integration] tab, and click . 

3 Set the peak to perform tailing processing on, and click [OK]. 

1 Click  (Period of “Tailing On”). 

2 Use the cursor to select the start and end positions of the range where tailing processing is 
performed. 

3 Evaluate the [Start Time] and [End Time] in the [Period of “Tailing On”] sub-window, and click 
[Simulate]. 

The time and processing commands are added to the time program. 

1

2

3
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Examine the resulting integration. 

If the peak on the tail of the main peak is small, adjust the Slope value until it is detected. 

4 Click  (View Mode) in [Method View]. 

The data loaded in the [Data Analysis] window is reanalyzed according to the new parameter settings. 
Check the processing results in the [Chromatogram View] and [Results View]. 

Referring to the procedure above, click  (Period of “Leading On”) if the target peak overlaps the front of 
the main peak. 

6.2.4 Manual Peak Integration
It is possible to manually integrate peaks that are not properly integrated using the automatic integration 
parameters in the method file. 

• Manual peak integration commands are saved only to current data.

• Manual peak integration commands cannot be exported to the method file. 

• To execute the same processing command on multiple data files, make settings in the Integration Time 
Program in [Method View], and save that method file for use. Alternatively, copy the content in the Manual 
Peak Integration Table, paste it into other data tables to apply it on them, and then perform analysis.

• The content in the Manual Peak Integration Table is retained even if postrun analysis is performed using 
the other method files.
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 Display [Manual Integration Bar]

1 Click the  (Manual Peak Integration) icon on the [Data Analysis] assistant bar.

[Manual Integration Bar] is displayed.

[Manual Integration Bar] can also be displayed by clicking the  (Manual Integration Bar) on the 
toolbar or right-clicking on [Chromatogram View] and selecting [Manual Integration Bar].

Two types of [Manual Integration Bar] formats are available, Standard toolbar and Advanced toolbar. The 
format type can be switched by changing the setting.

This section describes the Normal toolbar.

Manual Integration Bar (Standard Toolbar with Labels)

Icon Name Explanation

Auto Mode This mode selects the optimal processing based on the relationship 
between the position of the mouse cursor and the chromatogram 
automatically.
The command shortcut key can also be used.

Move BL Moves the peak detection points (start or end) along the X-axis (time). 

Move BL (Vertical) Moves the peak detection points (start or end) along the Y-axis (intensity).

Insert Peak Inserts a peak start and peak end point for a peak that was not previously 
integrated.

Insert Peak (Free) Specifies the times and intensity values of the start point and the end 
point of the peak, and inserts the peak.
A vertically divided peak can be inserted.
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Furthermore, there are three operation types, auto mode, selecting processing commands on the toolbar, 
and operation by shortcut keys. This section describes operations in auto mode.

 Move the Peak Detection Point in Auto Mode

1 Click the  (Auto Mode) icon to start the auto mode.

2 Move the mouse to near the detection point to move to.

The detection point is highlighted.

Split Peak Splits a peak vertically at a specified time.
If there is a valley near the specified time on the chromatogram, the peak 
is split at the time on the valley.

Unify Peaks Unifies two peaks adjacent to a vertical division line that is specified by 
clicking the mouse. Or, unifies multiple peaks between two points, which 
are specified by dragging the mouse, into a single peak.

Reject Peak Removes the peak that is specified by clicking the mouse.
Or, removes multiple peaks between two points that are specified by 
dragging the mouse.

Force B/V Changes to detection of baseline separation if the separation state of two 
adjacent peaks is vertical division.
Changes to vertical division if the separation state is baseline separation.

Force T / Not Performs tailing processing if the specified peak is vertically divided. This 
processes a peak as a peak included in the tailing.
If the specified peak is on tailing, vertical division processing is 
performed.

Force L / Not Performs leading processing if the specified peak is vertically divided. 
This processes a peak as a peak included in the leading.
If the specified peak is on leading, vertical division processing is 
performed.

Clear All Table Deletes all the content in the Manual Peak Integration Table and sets the 
peak detection method to automatic peak integration.

Toggle Manual Peak 
Integration Table

Toggles the Manual Peak Integration Table between display/hide.

Icon Name Explanation
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3 Click the detection point to move to and confirm it.

This can be controlled by dragging the mouse.

A vertical blue line is displayed.

At this time, if the detection point is specified with the [Y] key held down, the point can be moved in 
the intensity axis direction.

If the point is specified with the [F] key held down, it can be moved in both the X and Y directions.

4 Align the mouse (vertical line) to the time of the move destination and click the mouse.

The peak detection point is changed and baseline is adjusted.
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 Remove a Peak in Auto Mode

1 Click the  (Auto Mode) icon to start the auto mode.

2 Move the mouse to inside the peak to remove.

The peak inside is filled.

3 Right-click on the graph, and click [Reject Peak(No Correction)] on the displayed menu.

The peak is removed.



6  Data Analysis

144   Operators Guide

 Unify Peaks in Auto Mode

This section describes how to execute the peak integration processing command on multiple peaks as a 
single peak.

1 Click the  (Auto Mode) icon to start the auto mode.

2 Move the mouse to near the vertical division line to unify.

The vertical division line is highlighted.
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3 Right-click on the graph, and click [Unify Peaks] on the displayed menu.

The peak is unified.

The peak integration processing command can also be executed on multiple peaks as a single peak 
by changing the [Width] value on the [Integration] tab page in [Method View].

^ Reference
For details on the [Width] value, refer to Help.

6.2.5 Enable/Disable Each Processing Command
This section describes how to enable/disable each processing command using the Manual Peak 
Integration Table.

1 Click the  (Toggle Manual Peak Integration Table) icon on [Manual Integration Bar].

The Manual Peak Integration Table is displayed.
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2 Clear the checkbox for the processing command to disable and click [Analyze].

Only the processing commands with their checkboxes selected are executed again.

Pressing the [Delete] key deletes the row selected in the Manual Peak Integration Table.

6.2.6 Overlay Data in the Analysis Sub-window
A reference data file can be opened on the current open data file and displayed as an overlay in the 
[Chromatogram View].

1 Select [Open Reference Data File] on the [File] menu. 

2 Click the data file to display, and click [Open]. 
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The chromatogram in the selected data file is displayed on the sub-window. 

• Up to 16 data files can be drawn overlaying each other as reference chromatograms. 

• If the data file was obtained by data acquisition on multiple channels, the [Select Channels] sub-
window opens to allow for proper chromatogram selection. 

• To display the baseline of a reference chromatogram, right-click on the zoomed chromatogram, 
and select at [Graph Properties]. 

^ Reference
Refer to "6.1.2 [Data Analysis] Window Description" P.131 for details. 

• The peak integration parameters for the reference chromatograms cannot be displayed or 
modified. 

6.3 Peak Identification Parameters

This section describes how to set the allowable time width (window/band width) used for identifying peaks 
based on the Compound Table and which of the identification methods, absolute retention time method or 
relative retention time method is used. 
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1 Click  (Edit Mode) in [Method View]. 

2 Click the [Identification] tab, and set each parameter. 

1 Select either [Window] or [Band] at [Window/Band]. 
If [Window] is selected, enter [Window] in % units, and if [Band] is selected, enter [Default Band 
Time] in minutes. 

2 Select either [Absolute Rt] or [Relative Rt] as the peak identification method. 

3 Select the peak to identify from [All Peaks], [Closest Peak], and [Largest Peak]. 

Parameter Contents

Window The allowable time width for the peak top is set as a percentage (%) of the retention time. All 
peaks are calculated with the same window percentage. 
Allowable time width (min) =  (Compound Table retention time (min)  window (%) + 0.02)

Band The allowable time width of the peak top is set as an absolute time. The allowable time width 
can be set to each peak in the Compound Table. 
Allowable time width (min) =  Default Band Time (min)

Parameter Contents

Absolute Rt Identifies target peaks from the retention time of each peak and their allowable times 
preset to the Compound Table. 

Relative Rt Compares the retention time of the sample peak to the retention time of the reference 
peak to compensate for retention time deviation caused by fluctuation of the data 
acquisition conditions. A reference peak must be set in the Compound Table. 

^ Reference
For details, see "6.5.4 Directly Edit the Compound Table" P.170. 

Parameter Contents

All Peaks If multiple peaks fall within a single allowable time range, all peaks are identified as the 
target compound despite whether the Window method or Band method is set as the 
allowable time width setting method. 

Closest Peak If multiple peaks fall within a single allowable time range, only the peak closest to the 
retention time in the Compound Table is identified as the target compound, despite 
whether the Window method or Band method is set as the allowable time width setting 
method. 

Largest Peak If multiple peaks fall within a single allowable time range, only the peak with the largest 
peak area or height value is identified as the target compound, despite whether the 
Window method or Band method is set as the allowable time width setting method. 

Similarity [Similarity] can be selected when the photodiode array detector is used. The similarity 
between the spectrum at the retention time of the peaks in the allowable identification 
width and the standard spectrum registered in the Compound Table is calculated, and only 
the peak with the largest similarity value is identified as the target compound. 

1

2
3

4

5
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If peak identification is based on internal standard substances or if peak identification is 
performed on reference substances, the peak having the maximum area or maximum height is 
automatically identified regardless of the [Peak Selection] setting. 

4 Set [Display not identified peaks as peaks with zero area (height)]. 

If this checkbox is selected, the information of that compound is displayed at [Results View]. 

5 Set how the Compound Table retention time is automatically updated based on the retention time of 
an actually identified peak each time that data processing is performed on the standard sample.

3 Click  (View Mode) in [Method View]. 

The data loaded in the [Data Analysis] window is reanalyzed according to the new parameter settings. 
Check the processing results in the [Chromatogram View] and [Results View]. 

Parameter Contents

Replace Replaces the retention time of each compound in the Compound Table with the retention 
time of the actually identified peak. 

Average Replaces the retention time with the value obtained by averaging the retention time of each 
compound in the Compound Table and the retention time of the actually identified peak. 
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6.4 Quantitative Parameters

This section describes how to set the quantitative parameters used to calculate the concentration values of 
the target peak. 

6.4.1 External Standard Method
This method involves calculating concentrations from the peak area or height of unknown samples using a 
calibration curve based on a standard sample. This is the most frequently used quantitative calculation 
method. 

Data acquisition is performed on a fixed volume of multiple concentrations of a standard solution that were 
prepared to bracket the anticipated concentration of the substance in the unknown sample. 

A calibration curve is made using the absolute concentration of the standard solution (absolute amount) as 
the vertical axis and the respective peak area or height as the horizontal axis. 
(The X- and Y-axes display can be changed using [X Axis Calib. Curve].)

Fig.6-1 External Standard Method (Absolute Calibration Curve Method)

Quantitative Processing Reference

Quantitate by external standard method. "6.4.1 External Standard Method" P.150

Quantitate by internal standard method. "6.4.2 Internal Standard Method" P.152

Quantitate by standard addition method. "6.4.3 Standard Addition Method" P.154

Calculate the percentage (%) of each component by 
corrected area normalization method. 

"6.4.4 Corrected Area Normalization Method" P.156

Quantitate multiple compound peaks as a group "6.4.5 Grouping" P.158

Make the calibration curve of the natural logarithmic axis "6.4.6 Calibration Curve for Exponential Calculation" 
P.159

Correct the concentration value of a standard sample 
using the standard concentration factor. 

"6.4.7 Standard Concentration Factor" P.160

Quantitate using the calibration curve of other 
components. 

"6.4.8 Reference Standard ID and Correction Factor" 
P.161
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After the calibration curve is created, the same volume of the unknown sample solution is analyzed under 
the same conditions used to analyze the standard solutions. 

The peak area or height (A5) of the unknown sample is determined and the concentration (C5) of the 
substance in the unknown sample can be calculated from the calibration curve. 

This section describes how to quantitate using the “external standard method”. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Quantitative] tab, and set each parameter. 

1 Select [External Standard] for the [Quantitative Method]. 

2 Enter the number of concentration levels (calibration points) at [# of Calib. Levels]. 

3 Click the [Compound] tab, and enter the concentration for each of the standard samples 

in the [Conc. (1)], [Conc. (2)] and [Conc. (3)] columns.

This example uses a 3-point calibration curve. 

[Not Used] is displayed if the concentration cell is selected and the keyboard [Delete] key is pressed 
or if “-1” is entered in the cell.

Use this method when separate standard samples are prepared for individual target components. 

4 Click  (View Mode) in [Method View]. 

5 Save the method file before creating the calibration curve. 

^ Reference
For details on how to make calibration curves, refer to "4 Realtime Batch" P.65 or "5 Calibration 
Curves" P.115. 

1

2
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6.4.2 Internal Standard Method
This highly precise method involves performing quantitative calculation with an area ratio or height ratio to 
correct for injection volume errors. 

The internal standard (ISTD) substance should be a stable compound that separates completely from 
other peaks in the sample, has a similar chemical nature and elutes near the substance to be quantitated.

The standard solutions are prepared with 1 or more known concentrations of the target substance (“X” from 
here on) and a specified concentration of the internal standard substance (“ISTD” from here on). Then data 
acquisition is performed on fixed amounts of these standard solutions. 

A calibration curve is created using the ratio of “X concentration/ISTD concentration” in the standard 
solution as the vertical axis and the ratio of “peak area of X/peak area of ISTD” as the horizontal axis. 
(The X- and Y-axes display can be changed using [X Axis Calib. Curve].)

Fig.6-2 Internal Standard Method

A sample solution is prepared by spiking the unknown sample with the same concentration of ISTD as was 
used in the standard solution preparation. Data acquisition is performed on the same volume of unknown 
sample solution under the same conditions used to analyze the standard solutions.

The peak area ratio between X and ISTD (A5/Aistd.) for the unknown sample is calculated and the 
concentration ratio (C5/Cistd) is calculated from the calibration curve. 

This section describes how to quantitate using the “internal standard method”. 

1 Click  (Edit Mode) in [Method View]. 
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2 Click the [Quantitative] tab, and set each parameter. 

1 Select [Internal Standard] for the [Quantitative Method]. 

2 Enter the number of concentration levels (calibration points) at [# of Calib. Levels]. 

3 Click the [Compound] tab, and set the [Type], [Conc.], and [ISTD Group] for each 

compound. 

This example uses the following calibration curve parameters. 

Make a calibration curve using 3 concentrations of standard solution:
• Peak A: ISTD

• Peak B: Target substance. Quantitated using Peak A. 

• Peak C: ISTD

• Peak D: Target substance. Quantitated using Peak C. 

• The ISTD concentration values are used to calculate the calibration curve as the ISTD amount. 

• If multiple ISTDs are used, number the substances in the [ISTD Group] column so that the ISTDs 
corresponding to the target substance are in the same ISTD group. 

4 Click  (View Mode) in [Method View]. 

• The amount of ISTD in the standard sample is entered in the Compound Table. The amount of 
ISTD in unknown samples is entered in the Batch Table and in single run. Refer to "4.6.2 Edit 
Batch Tables" P.103 for details on entering the ISTD amount. 

• To make a calibration curve with multiple calibration points (levels) add equivalent amounts of 
ISTD to standard solutions of different concentrations. If the standard solution is spiked with the 
ISTD before it is diluted, only a 1-point calibration curve is created. 

• Prepare standard sample solutions by diluting a stock solution in stages to achieve multiple 
concentrations of the target substance. Prepare the unknown sample solution at the appropriate 
concentration. Spike all of the diluted standard samples and the unknown sample with equal 
amounts of the ISTD. 
When the unknown sample is spiked with the same amount of ISTD as the standard solution, 
quantitative calculation can be performed by comparing the sample amount and ISTD amount 
with all levels of the ISTD concentration fields set to “1”. 

1

2
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5 Save the method file before creating the calibration curve. 

^ Reference
For details on how to make calibration curves, see "4 Realtime Batch" P.65 or "5 Calibration Curves" 
P.115. 

6.4.3 Standard Addition Method
This method involves analyzing an unknown sample that has been spiked with a known amount of the 
target substance and an unspiked unknown sample. Quantitation is performed using the difference 
between the measured peak areas or heights. 

Equivalent aliquots of the same unknown sample solution are prepared. One aliquot remains unspiked and 
the other aliquots are spiked with differing known concentrations of the target substance. All of the 
unknown sample solutions are analyzed and the results are used to quantitatively calculate the amount of 
target substance in the unspiked unknown sample. The calibration curve created with the spiked amount of 
substance (concentration) as the horizontal axis and peak area or height as the vertical axis. 

This method is often used in situations where the components of unknown sample matrix compromise the 
sensitivity of the target substance. 

The sample solution (source solution) is divided into several equal parts, and each part is spiked with 
standard solution and used for data acquisition. 
(Example C1: unspiked, C2: 1.0 mg/L, C3: 2.0 mg/L)

The calibration points of the peak area (A1, A2, A3) and spiked amount (0, 1.0 mg/L, 2.0 mg/L) from the 
data acquisition results, are used to make a 3-point calibration curve (linear). 

The absolute value where the calibration curve intersects the X-axis (point of intersection - C4) indicates 
the concentration (X) of the target component. 

Fig.6-3 Standard Addition Method

This section describes how to quantitate using “standard addition method”. 

Peak area

A3

A2

A1

C1
Unspiked

C2
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Source 
solution
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Spiked concentration (mg/L)

C2 (1.0) C3 (2.0)C1 (0)C4
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1 Click  (Edit Mode) in [Method View]. 

2 Click the [Quantitative] tab, and set each parameter. 

1 Select [Standard Addition] for the [Quantitative Method]. 

2 Enter the number of concentration levels (calibration points) at [# of Calib. Levels]. 

The unspiked sample is one calibration point and 2 spiked samples are used, making the 
number of calibration points, 3. (1 unspiked sample + 2 spiked samples = 3). Therefore, set the 
number of levels to “3”. 

3 Click the [Compound] tab, and enter the [Conc.] of the standard sample. 

This example uses the following calibration curve parameters.

• Level 1: Unspiked sample “concentration = 0"

• Level 2: 10 mg/L spiked sample

• Level 3: 20 mg/L spiked sample

• Enter “0” for [Conc. (1)] since it is used for the unspiked sample calibration point. 

• Set [Type] to standard for the unspiked and all of the spiked samples, and perform data 
acquisition using the method file saved above. (Perform postrun batch analysis if the data has 
already been acquired.) 
Then, change [Type] to [Unknown] for only the unspiked sample, and reprocess the data using 
the using the method file that contains this calibration curve to obtain the quantitative results. 

4 Click  (View Mode) in [Method View]. 

1

2
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6.4.4 Corrected Area Normalization Method
This method involves, first, correcting the peak area or height of each component peak in an unknown 
sample and totaling these values. The percentage of the corrected area or height for each component with 
is calculated with respect to that total value is assumed to be the quantitative value.

This section describes how to obtain the sensitivity correction factor using a standard sample of known 
concentration and how to perform quantitation by the “corrected area normalization” method by manually 
entering that sensitivity correction factor. 

With corrected area normalization, the percentage of the area or height value of all detected peaks is 
assumed to be the quantitative value. 

 Sensitivity Correction Factor Using a Standard Sample

This section describes use of a mixed sample as the standard sample. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Quantitative] tab, and set each parameter. 

1 Select [Corrected Area Normalization] for the [Quantitative Method]. 

2 Select [Linear] for the [Curve Fit Type]. 

3 Enter the concentration in the [Conc.(1)] cell for each compound in the [Compound] tab. 

4 Click  (View Mode) in [Method View]. 

Refer to "5.1 Calibration Curves by Postrun Batch" and use the standard sample data to make a 
calibration curve. The 1st coefficient obtained is the sensitivity correction factor. 

1

2
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 Enter the Sensitivity Correction Factor

This section describes how to manually enter the sensitivity correction factor if it is known. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Quantitative] tab, and set each parameter. 

1 Select [Corrected Area Normalization] for the [Quantitative Method]. 

2 Select [Manual RF (Linear)] for the [Curve Fit Type]. 

3 Enter the sensitivity correction factor in the [1st Coefficient] cell for each compound in 

the [Compound] tab. 

4 Click  (View Mode) in [Method View]. 

1

2
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6.4.5 Grouping
Bundling homologs or isomers when there are multiple compounds is called “grouping”. 

Grouping is effective in dividing the peaks into groups to perform quantitative analysis only on individual 
groups or when measuring the amount of impurities in a certain main component as a single group. 

This section describes how to perform grouping quantitation. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Quantitative] tab, and select [Group Calibration] or [Conc. Summation] for the 

[Grouping Type]. 

• The sum of the peak areas or heights of the grouped compounds is used with [Group Calibration], 
a calibration curve is created for each group, and quantitation is performed for each group. 

• A calibration curve is created for each compound and quantitation is performed for each 
compound, with [Conc. Summation]. Then the sum of the concentrations of the grouped 
compounds is used as the concentration of the group.

3 Click the [Compound] tab, and enter the same group number in the [Group#] column of 

all of the compounds in a group. 

4 Click the [Group] tab, and enter [Name], [Conc.], and [Unit]. 

5 Click  (View Mode) in [Method View]. 
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6.4.6 Calibration Curve for Exponential Calculation
Since the sample concentration and sensitivity are not directly proportional when using an LC-ELSD 
detector or the GC-FPD detector S mode, make a calibration curve using the exponential function. 

This section describes how to perform quantitative calculation using a calibration curve calculated from the 
exponential function. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Quantitative] tab, and select [Exponential] for the [Curve Fit Type]. 

• At least 2 standard samples (i.e. 2 calibration points) are required to create a calibration curve 
with the exponential calculation. Select 2 or higher at [# of Calb. Levels].

• [Zero] cannot be set for the exponential calibration curve since the curve does not pass through 
the origin.

• Both of the axes of the graph for the exponential calibration curve are logarithmic. 

3 Click the [Compound] tab, and enter the [Conc.](s). 

4 Click  (View Mode) in [Method View]. 
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6.4.7 Standard Concentration Factor
Make a calibration curve using values obtained by multiplying concentration values of each level with 
compensation factors. 

This section describes how to set the standard concentration factor. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Compound] tab. 

3 Right-click on the Compound Table, and click [Table Style]. 

4 Add the [Standard concentration factor] column to the Compound Table in the [Table Style] 

sub-window, and click [OK]. 

1 Select [Standard concentration factor] in the [Hide Items] list. 

2 Click [Add]. 

The [Standard concentration factor] item is added to [Display Items] list. 

Change the display order of items in the Compound Table, by selecting the item in the [Display 
Items] list and then clicking [Up] or [Down]. 

2

1
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5 Enter the [Standard concentration factor] column. 

6 Click  (View Mode) in [Method View]. 

6.4.8 Reference Standard ID and Correction Factor
If standards cannot be prepared for impurities or related substances, create a calibration curve using a 
standard substance with the same (or proportional) response factor, and quantitate the concentration of the 
impurities or related substances using that calibration curve.

Use the value obtained by multiplying the peak area or height or the peak area or height ratio of the internal 
standard by the correction factor, to create the reference standard calibration curve specified by ID. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Compound] tab. 

3 Right-click on the Compound Table, and click [Table Style]. 
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4 Add the [Ref STD ID] and the [Correction factor] column to the Compound Table in the 

[Table Style] sub-window, and click [OK]. 

1 Select [Ref STD ID] and [Correction factor] in the [Hide Items] list. 

2 Click [Add]. 

The [Ref STD ID] and [Correction factor] item are added to the [Display Items] list. 

Change the display order of items in the Compound Table, by selecting the item in the [Display 
Items] list and then clicking [Up] or [Down]. 

5 Enter the [Ref STD ID] and [Correction factor] column. 

6 Click  (View Mode) in [Method View]. 

2

1
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6.5 Compound Table

The Compound Table must be completed to identify detected peaks or to perform quantitative calculation 
on the detected peaks. There are various ways of entering data into the Compound Table. Use the method 
that is the most convenient. 

• "Compound Table Wizard"

• "Compound Table from the Peak Table"

• "Compound Table Retention Times Using the Mouse"

• "Directly Edit the Compound Table"

6.5.1 Compound Table Wizard
This section describes how to complete a Compound Table using the wizard. Using the wizard also allows 
the peak integration, peak identification, and quantitative parameters to be entered in the consecutive sub-
windows.

1 Click the  (Wizard) icon on the [Data Analysis] assistant bar. 

2 Enter the peak integration parameters, and click [Next]. 

^ Reference
Refer to "6.2 Peak Integration Parameters" P.134 for details on setting the peak integration 
parameters.
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3 Select the [Select] column to register a peak in the Compound Table, and click [Next]. 

4 Enter the quantitative parameters, and click [Next]. 

^ Reference
Refer to "6.4 Quantitative Parameters" P.150 for details on setting the quantitative parameters. 

5 Enter the peak identification parameters, and click [Next]. 

^ Reference
Refer to "6.3 Peak Identification Parameters" P.147 for details on setting the peak identification 
parameters. 
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6 Enter the [Name], [Type] and [Conc.] column in the Compound Table, and click [Finish]. 

• The default [Name] is “RT (Retention Time) + peak retention time”. 

• Edit the Compound Table to match the parameters set in quantitative processing. 

The settings made in the wizard are saved to the data processing parameters in the open data file. 

^ Reference
• Refer to "6.7 Save (Export) to Method Files" P.174 to save settings made in the wizard to method file. 

• Refer to "5 Calibration Curves" P.115 for details on creating calibration curves. 
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6.5.2 Compound Table from the Peak Table
Peaks displayed in [Chromatogram View] can be registered to the [Compound] tab in [Method View]. 

This section describes how to register peaks in [Chromatogram View] to the Compound Table. 

1 Click the [Peak Table] tab in [Results View]. 

2 Right-click [Peak#] for the desired peak, and click [Register Selected Peak to Compound 

Table]. 

The selected peaks in the Peak Table are registered to the Compound Table. 

3 Click the [Compound] tab in [Method View]. 



 Operators Guide   167

6.5  Compound Table

6

4 Enter [Name] and [Conc.] of the registered peak in the Compound Table. 

Click the  (Wide Size) button to maximize the view width. Click the  (Normal Size) button to restore 

the view size. 

5 Click  (View Mode) in [Method View]. 

^ Reference
• Refer to "6.7 Save (Export) to Method Files" P.174 for details on saving to the method file. 

• Refer to "5 Calibration Curves" P.115 For details on creating calibration curves. 
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6.5.3 Compound Table Retention Times Using the Mouse
Retention times in the Compound Table can be easily set with the mouse in [Chromatogram View]. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Compound] tab, and select the desired [Ret. Time] cell. 

The peak position lines are displayed in red in the [Chromatogram View]. 

Right-click on the chromatogram, and if [Peak Position Line] on the displayed menu is not selected, 
select [Peak Position Line] to display the peak position line. 
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3 Select the peak whose retention time is to be changed. 

The retention time change is automatically registered to the Compound Table. 

Fine-adjust the peak position line by dragging the line with the [Shift] key held down. 

4 Click  (View Mode) in [Method View]. 

^ Reference
• Refer to "6.7 Save (Export) to Method Files" P.174 for details on saving to the method file. 

• Refer to "5 Calibration Curves" P.115 for details on creating calibration curves. 

Display position check line
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6.5.4 Directly Edit the Compound Table
Click the target compound cell to edit a cell in the Compound Table. 

This section describes how to select the Window/Band method and compound type. 

 Select the Window/Band Method for Each Compound

The identification method set on the [Identification] tab in [Method View] is used for all of the compounds. It 
can also be set to each compound in the Compound Table. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Compound] tab. 

3 Right-click on the Compound Table, and click [Table Style]. 

4 Add the [Window/Band] and the [Band] column to the Compound Table in the [Table 

Style] sub-window, and click [OK]. 

1 Select [Window/Band] and [Band] in the [Hide Items] list. 

2 Click [Add]. 

The [Window/Band] and the [Band] item are added to the [Display Items] list. 

Change the display order of items in the Compound Table, by selecting the item in the [Display 
Items] list and then clicking [Up] or [Down]. 

2

1
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5 Set [Window/Band] and [Band] parameters. 

1 Click the [Window/Band] cell for the desired compound, and select [Default], [Window] or [Band]. 

2 Enter the allowable time width in the [Band] cell, if [Band] is selected. 

If [Window/Band] is set to [Default], the value set on the [Identification] tab is used. 

6 Click  (View Mode) in [Method View]. 

^ Reference
• Refer to "6.7 Save (Export) to Method Files" P.174 for details on saving to the method file. 

• Refer to "5 Calibration Curves" P.115 for details on creating calibration curves. 

 Compound Type

This section describes how to set the reference compound for peak identification using the relative 
retention time method. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Compound] tab, and select the [Type]. 

Click the [Type] cell of the desired compound, and select [Reference]. 

Use this method to set the ISTD as the reference for the internal standard method. Click the [Type] 
cell of the ISTD, and select [ISTD & Ref.]. 

3 Click  (View Mode) in [Method View]. 

If changes are made to the parameters such as [Type] on the [Compound] tab, the calibration curve will 
change. In this case, the current calibration curve information saved in the data file is automatically deleted. 

^ Reference
• Refer to "6.7 Save (Export) to Method Files" P.174 for details on saving to the method file. 

• Refer to "6.7 Save (Export) to Method Files" P.174 for details on creating calibration curves. 
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6.6 Column Performance Parameters

This section describes how to set the various calculation methods for supporting the system suitability test 
and how to check calculation results. 

• USP

• USP2

• JP

• JP2

• EP

• BP

• DAB

• EMG

• EMG (50%)

• area/height

• user-defined

^ Reference
For details about the column performance equations, refer to Help or the Data Acquisition & Processing 
Theory Guide.

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Performance] tab, and select the appropriate checkbox(es) at [Calc. Method]. 

• Select [User Defined] to display the [User] parameters box. 

• Either select [1st Peak Time] or enter a [Set Time] at [Unretained Peak Time].

• Select [Column Length] to calculate the number of theoretical plates.

3 Click  (View Mode) in [Method View]. 
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4 Click the [Peak Table] tab in [Results View], and check the number of theoretical plates 

and resolution. 

5 To check the tailing factor, right-click on the Peak Table, and click [Table Style]. 

6 Add the [Tailing F.] in the [Hide Items] column to the Compound Table in the [Table Style] 

sub-window, and click [OK].   

1 Select [Tailing F.] in the [Hide Items] list. 

2 Click [Add]. 

The [Tailing F.] item is added to the [Display Items] list. 

Change the display order of items in the Compound Table, by selecting the item in the [Display 
Items] list and then clicking [Up] or [Down]. 

[Tailing F.] is displayed in the Peak Table. 

Add [Tailing Factor] or [Resolution] display settings to the [Quantitative Results] report items to print 
the results in the output report.

2
1
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6.7 Save (Export) to Method Files

After setting the quantitative parameters and the Compound Table, save (export) the new settings to the 
method file. 

1 Click the  (Apply to Method) icon on the [Data Analysis] assistant bar. 

2 The name of the method file used for data acquisition is displayed. Click [Save]. 

Enter a new name at [File name] to create a new method file. 

3 Select the method items to save, and click [OK]. 

1 Select [Current Settings].

[Current Settings] saves the latest currently displayed method parameters. 
[Acquisition Settings] saves the method parameters used for data acquisition. 

2 Select the method items to save. 

The selected method items are saved to the method file. 

1

2
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In the case of a dual-line configuration GC, select the line to export the method from, and click [OK].
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7PDA Data Analysis

This chapter describes how to analyze chromatograms or spectra obtained by data acquisition with 
the PDA (photodiode array) detector, execute purity calculations on detected peaks, and perform 
library searches.

7.1 [PDA Data Analysis] Window

The [PDA Data Analysis] window is comprised of the following views:

• [Contour View] - displays a contour view with absorbance color-coded

• [Chromatogram View] - displays chromatograms and status curves

• [Spectrum View] - displays the UV spectra

• [Purity View] - displays the purity calculation results of detected peaks

• [Results View] - displays quantitative calculation results

• [Method View] - displays and editing data processing parameters

7.1.1 Open the [PDA Data Analysis] Window

1 Click the  (PDA Data Analysis) icon on the [Main] assistant bar in the [Postrun 

Analysis] program. 

2 Drag-and-drop the data file onto the [PDA Data Analysis] window from the [Data 

Explorer] sub-window. 

The contents of the data file is displayed in the [PDA Data Analysis] window. 
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7.1.2 [PDA Data Analysis] Window Description
This section describes how to view and use the [PDA Data Analysis] window. 

No. Explanation

1 Displays the [Standard] and [PDA Data Analysis] toolbars. 

2 Displays the contour graph with PDA data color-coded into absorbance ranges. 

Drag the  and  to display the chromatograms and spectra extracted at that position in [Chromatogram 
View] and [Spectrum View]. 

3 Displays the UV spectrum at selected retention time or a selected peak. 
Right-click the [Spectrum View] to select operations such as switching of the view mode (Extracted or 
Registered) and UV library search for selected spectra. 

4 The [Peak Purity] tab displays the purity result for the selected peak. 
The [Peak Profile] tab displays the overlaid chromatogram for the selected peak at multiple wavelengths.

5 Select the [Edit] mode to change various parameters in [Method View]. 

6 Displays the data processing parameters of the currently open data file. 
The [Multi Chrom], [UV Spectrum], [Library Search], and [Purity] tabs are displayed in addition to the tabs 
displayed in the [Data Analysis] window. 

7 Displays the peak integration and quantitative results. 
The display content is the same as [Results View] in the [Data Analysis] window. 

8 Displays the chromatogram at the wavelength on the [Multi Chrom] tab in the data processing parameters and 
the chromatogram extracted from the contour. 
Right-click on the graph in [Chromatogram View] to select operations such as switching the view mode 
(Overlay Chromatograms, Stack Chromatograms and Single Chromatogram), registration of multi 
chromatograms, and manual peak integration. 

Use  to change the channel and peak position. 

1 Toolbar 2 [Contour View]

6 [Method View]

8 [Chromatogram View] 7 [Results View]

5

[Spectrum View]3

4 [Purity View]
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• Only data file can be displayed in the [PDA Data Analysis] window. 
Drag-and-drop the other data files onto the [PDA Data Analysis] window to change to the content of their 
data files. 

• If the data file was acquired by simultaneous use of another detector, the chromatogram acquired by that 
detector is also displayed in the [Data Analysis] window. 

 View the Data in Its Entirety (3D Image)

PDA data can be shown in its entirely as a 3D image. 

1 Click [3D Image] on the [View] menu. 

The [3D Image] sub-window opens. 

• Click  in the top right corner of the sub-window to close the [3D Image] sub-window. 

• The [3D Image] sub-window can be enlarged by dragging on the sub-window, and the display 
angle can be changed by dragging on the periphery of the 3D display area. 

• The [3D Image] sub-window does not support the [256 Colors] Windows graphic mode. Use it in 
environments with the [High Color] setting or above. Do not change the number of colors for 
graphics while the [3D Image] sub-window is displayed. 



7  PDA Data Analysis

180   Operators Guide

7.1.3 Display Chromatograms Extracted from [Contour View]
In [Contour View], the chromatograms or spectra can be extracted from [Contour View] by using the 
extraction lines. 

This section describes how to change the extraction position of the wavelength (Y-axis) and display the 
chromatogram at that position in the [Chromatogram View]. 

1 Drag  to move to the target position. 

(Click  to fine-adjust the wavelength extraction position.)

The extracted chromatogram is displayed in the [Ex] (extracted chromatogram) region in the 
[Chromatogram View]. 

• The wavelength extraction position can be checked by the wavelength displayed by  on [Contour View] 
or by the wavelength displayed in the [Ex] region in [Chromatogram View]. 

• Right-click on [Contour View] and select [Graph Properties] to adjust the Contour Properties. Select 
[Display Settings] to adjust the Contour View Display Settings. 

• The extracted chromatogram is only displayed if [Display Extracted chromatogram] is selected on the 
[Multi Chrom] tab in [Method View]. 
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7.1.4 Display Spectra Extracted from [Contour View]
The chromatograms or spectra can be extracted from [Contour View] by using the extraction line. 

This section describes how to change the extraction position of the time (X-axis) and display the spectrum 
at that position in the [Spectrum View]. 

1 Drag  to move to the target position. 

(Click  to fine-adjust the time extraction position. )

The extracted spectrum is displayed in [Spectrum View]. 

• The wavelength extraction position can be checked by the wavelength displayed by  on [Contour View] 
or by the retention time displayed in [Spectrum View]. 

• Right-click on [Contour View] and select [Graph Properties] to adjust the Contour Properties. Select 
[Display Settings] to adjust the Contour View Display Settings. 

• Right-click on the spectrum and select or deselect [Registered Spectrum] and switch between [Spectrum 
View (Registered)] and [Spectrum View (Extracted)].
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7.1.5 Manipulate Extracted Chromatograms and Spectra
Double-click anywhere on a chromatogram (or spectrum) display to check the chromatogram waveform or 
spectrum shape.

 Display the Spectrum of a Desired Retention Time Extracted from the 

Chromatogram

Double-click a selected chromatogram at a desired retention time to display the spectrum of that retention 
time in [Spectrum View]. 

To check the spectrum of a time at the top of a detected peak, click [Peak ]. The spectrum moves to the 
top of the detected peak. 

 Display the Chromatogram of a Desired Wavelength Extracted from the 

Spectrum

Double-click a desired wavelength of a spectrum to display the chromatogram at that wavelength in the 
[Ex] (extracted chromatogram] section of the [Chromatogram View]. 

• Chromatograms extracted from [Spectrum View] cannot be displayed if a channel other than [Ex] 
(extracted chromatogram) is selected in [Chromatogram View]. 

• The extracted chromatogram cannot be displayed if [Display Extracted chromatogram] is deselected on 
the [Multi Chrom] tab in [Method View]. 



 Operators Guide   183

7.2  Register Chromatograms

7

7.2 Register Chromatograms

Chromatograms extracted from 3D data can be registered in the Multi-Chromatogram Table. 

7.2.1 Register Chromatograms to the Multi-Chromatogram Table
Register a chromatogram to the Multi-Chromatogram Table to perform operations such as comparison of 
multiple chromatograms, output of reports and peak integration. 

This section describes how to register chromatograms to the Multi-Chromatogram Table. 

1 Right-click on the chromatogram in [Ex] (extracted chromatogram), and select [Register 

Extracted Chromatogram to Table]. 

The extracted chromatogram is registered to a channel in the Multi Chromatogram Table. 

• The extracted chromatogram cannot be displayed if [Display Extracted chromatogram] is 
deselected on the [Multi Chrom] tab in [Method View].

• Right-click on the chromatogram, and select [Register Lambda max Chromatogram to Table] to 
register the lambda max chromatogram for the target peak to the Multi Chromatogram Table. 
Then, double-click near the peak top of the target peak in [Chromatogram View]. The 
chromatogram is registered to the Multi Chromatogram Table. 

• If the chromatogram display mode is [Overlay Chromatograms] or [Stack Chromatograms], new 
chromatogram are displayed in [Chromatogram View] as they are registered to a channel in the 
Multi Chromatogram Table. 
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2 Click  (Edit Mode) in [Method View]. 

3 Click the [Multi Chrom] tab in [Method View], and select the registered chromatograms. 

1 Select [Display Extracted chromatogram] to display the chromatogram in [Chromatogram View]. 

2 Click the [Wavelength] cell. 

Select [Max Plot] from the [Types of Chromatograms] and enter a [Start Wavelength] and an [End 
Wavelength] to display that chromatogram as a Max Plot. 

Max Plot refers to the chromatogram obtained by plotting the intensity of the maximum absorbance in the 
specified wavelength range. 

4 Click  (View Mode) in [Method View]. 

The chromatogram is displayed in [Chromatogram View]. 

21



 Operators Guide   185

7.2  Register Chromatograms

7

7.2.2 Peak Integration Parameters
The peak integration parameters for PDA data can be individually edited for each channel in the Multi 
Chromatogram Table. 

This section describes how to select a channel and perform data processing on that channel. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Integration] tab, and select the target channel from the [Channel] list. 

3 Edit the peak integration parameters. 

^ Reference
Refer to "6.2 Peak Integration Parameters" P.134 for details on peak integration operations. 

4 Click  (View Mode) in [Method View]. 

The chromatogram in the selected channel is reintegrated with the new peak integration parameters. 

Right-click on the chromatogram in [Chromatogram View], and select [Manual Integration Bar] to manually 
integrate the chromatograms for each channel. Refer to"6.2.4 Manual Peak Integration" P.139 for details on 
manual peak integration. 
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7.3 Register Spectra

Register spectra extracted from 3D data to the Spectrum Table to perform a library search and calculate 
the similarity between each spectrum and the reference spectrum. 

7.3.1 Register Spectra to the Spectrum Table
If the displayed spectra are registered to the Spectrum Table, they can be compared with other spectra and 
their similarity can be calculated. 

This section describes how to register extracted spectrum to the Spectrum Table. 

Right-click on the spectrum and select or deselect [Registered Spectrum] and switch between [Spectrum 
View (Registered)] and [Spectrum View (Extracted)].  

1 Right-click on [Spectrum View], and click [Register Extracted Spectrum to Table]. 

The extracted spectrum is registered to the Spectrum Table. 

2 Right-click on [Spectrum View], and click [Show Spectrum Table]. 
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3 Edit the Spectrum Table. 

1 Check the content of the [Data Source], [Param.], and [Scale] cells of the registered spectrum. 

If an extracted spectrum has been registered, [Time] is displayed at [Data Source], and the retention 
time when it was extracted from the chromatogram is displayed at [Param.]. 

2 Click the [Data Source] cell and select [Library] and select the UV library file to register a spectrum in 
a library file to the Spectrum Table. 

3 Select the spectrum in the library file from the [UV Library-Select Spectrum] sub-window, and click 
[OK]. 
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4 Click [Apply], check the display in [Spectrum View], and then click [OK]. 

• If [Spectrum View (Registered)] is displayed, double-click anywhere in [Chromatogram View] to register 
the extracted spectrum to the Spectrum Table. 

• Select [Register Spectrum to Table] on the [Integration] tab in [Method View] to automatically register the 
spectrum at all peak top times to the Spectrum Table. 

7.3.2 Calculate Spectrum Similarity
The similarity between the reference spectrum and another spectrum in the Spectrum Table can be 
calculated if a reference spectrum ([Ref]) is registered to the Spectrum Table. 

This section describes how to register a reference spectrum to calculate similarity. 

1 Right-click the ID No. to be used as the reference spectrum, and click [Set to Reference 

Spectrum for Similarity]. 

[Ref] is displayed in the [Similarity] for the selected ID#. 
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2 Click [Apply], and check [Similarity] of the spectrum currently registered to the 

Spectrum Table. 

[Similarity] is displayed as a value with respect to [Ref] = 1. 

3 Click [OK]. 

Right-click on the [Spectrum View] and select [Registered Spectrum] to display the spectrum 
currently registered in the Spectrum Table. 
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7.3.3 Create a Spectrum File
Spectra can be exported to common format (.jcm) files. Exported files are used to register to library files 
and to perform peak identification based on similarity. 

This section describes how to export a spectrum in [Spectrum View] to a file, and how to export spectra 
registered to the Spectrum Table to files. 

 Export a Spectrum in [Spectrum View]

1 Right-click on [Spectrum View], and click [Export Spectrum As]. 

If the view mode is [Spectrum View (Registered)], select the spectrum label before right-clicking on 
[Spectrum View]. 

2 Enter the file name, and click [Save]. 

The spectrum file is created. 
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 Export Spectra Registered to the Spectrum Table

1 Right-click on the ID No. of the spectrum to export, and click [Export Spectrum As]. 

2 Enter the file name, and click [Save]. 

The spectrum file is created. 
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7.4 UV Spectrum Library

A file that contains multiple UV spectra is called a library file. Library file allow for the comparison of 
unknown spectra to a library of known spectra to identify the unknown compound.

This section describes how to make a library file according to the following procedures.

1. "Create a Library File"

2. "Register a UV Spectrum to the Library File"

3. "Edit a Library File"

^ Reference
Refer to "7.5.1 Identify Peaks by Spectrum Similarity" P.198 or "7.5.2 Use [Library Search] to Search for 
Spectra" P.201 for more details. 

7.4.1 Create a Library File
A UV spectra library file must be created before extracted spectra can be added to it.

1 Click the  (UV Library Editor) icon on the [Main] assistant bar in the [Postrun 

Analysis] program. 

2 Click  (New) on the toolbar. 



 Operators Guide   193

7.4  UV Spectrum Library

7

3 Enter a [File name], and click [Save]. 

The UV library file is created. 
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7.4.2 Register a UV Spectrum to the Library File
This section describes how to register the UV spectra displayed in the [Spectrum View] and spectra files to 
the library file made in "7.4.1 Create a Library File". 

 Register a UV Spectrum File

^ Reference
Refer to "7.3.3 Create a Spectrum File" P.190 for details. 

1 Right-click on [Spectrum Information] in the [UV Library Editor] window, and click 

[Register from UV spectrum file]. 

2 Select the desired UV spectrum file and then click . 

The UV spectrum file name is displayed in the [Selected Files] box. Repeat this procedure to select all 
files required for the UV library. 

The selected UV spectra files are registered to the UV library file. 



 Operators Guide   195

7.4  UV Spectrum Library

7

 Register a UV Spectrum

1 Right-click on [Spectrum View] in the [PDA Data Analysis] window, and click [Register 

Spectrum to Library]. 

The spectrum is added to the UV library file. 

2 Select the desired UV library file, and click [Open]. 

The spectrum is added to the UV library file. 

• Right-click on the ID No. of the desired spectra, and select [Register Spectrum to Library] to add spectra 
in the Spectrum Table to the library file. 
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• If the view mode is [Spectrum View (Registered)], select the spectrum label before right-clicking on 
[Spectrum View], and then select [Register Spectrum to Library]. 

7.4.3 Edit a Library File
This section describes how to edit the spectrum files registered at "7.4.2 Register a UV Spectrum to the 
Library File". 

1 Click the  (UV Library Editor) icon on the [Main] assistant bar in the [Postrun 

Analysis] program. 

2 Click the  (Open) button on the toolbar. 
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3 Select the desired UV library file, and click [Open]. 

4 Edit the [Spectrum Information] in the UV library file. 

1 Enter the [Compound Name] if one was not already entered. 

2 Enter the wavelength range in the [Lambda Range] column for use the library search. 

3 Check the [Lambda max] and [Lambda min] values. 

The items displayed at [Spectrum Information] can be edited with [Table Style]. 
Right-click on [Spectrum Information], and select [Table Style]. 

5 Click the  (Save) button on the toolbar. 

The UV library file is saved. 

1 2 3
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7.5 Specify a Compound From a Spectrum

Compare the spectra of known compounds with the spectrum of an unknown compound to identify and 
specify the compounds from a spectrum. 

This section describes the following operations. 

• "Identify Peaks by Spectrum Similarity"

• "Use [Library Search] to Search for Spectra"

• "Spectrum Conditions of the Search Target"

Set the spectrum conditions of the search target to perform higher precision similarity and library searches. 

7.5.1 Identify Peaks by Spectrum Similarity

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Identification] tab, and select [Similarity] in the [Peak Selection] list. 
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3 Click the [Compound] tab, right-click on the Compound Table, and click [Table Style]. 

4 Make the settings in the [Table Style] sub-window, and click [OK]. 

1 Select [Std. Spectrum], [Min Similarity], and [Wavelength] in the [Hide Items] box. 

2 Click [Add]. 

[Std. Spectrum], [Min Similarity], and [Wavelength] are added to the [Display Items] box. 

Change the display order of items in the Compound Table, by selecting the item in the [Display 
Items] box and then clicking [Up] or [Down]. 

2
1
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5 Right-click the [ID#] of the compound whose similarity is to be identified, click 

[Extracted Spectrum], [UV Spectrum File] or [UV Library File] at [Register Standard 

Spectrum], and register the standard spectrum for the compound. 

6 Enter the [Min Similarity] and [Wavelength] that is associated with the [Std. Spectrum]. 

7 Click  (View Mode) in [Method View]. 

• Right-click and select [Show Standard Spectrum] to check a registered spectrum. 

• The peak is not identified if the similarity between the standard spectrum and the spectrum of the time at 
the top of the detected peak falls below the threshold. 
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7.5.2 Use [Library Search] to Search for Spectra
This section describes how to perform a library search.

1. Set library search criteria

2. Execute the library search

 Library Search Criteria

The following example describes how to set the criteria to search the similarity between an unknown 
spectrum and the spectra registered to the library file. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Library] tab, and enter the search criteria. 

1 Set the [Wavelength Range] and [Max # of Hits]. 

[Max # of Hits] is the number of spectra to display in the [UV Library Search Results] sub-
window. 

2 Set the [Library Files] parameters. 

• Select [Use All Library Files in UVLibrary Folder] to search all of the library files in the 
UVLibrary folder. 

• Select [Use All Library Files in a Specified Folder] and specify a folder to search all of the 
library files in a specific folder in the UVLibrary. 

3 Select [Prefilter] and [Enable], then click the [Index] cell and select a keyword to further filter the 
search results by compound name, retention time or another keyword. 

3 Click  (View Mode) in [Method View]. 

2

3

1
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 Execute the Library Search

When the library search is executed, matching spectra are displayed in order from the highest similarity to 
the lowest in the [UV Library Search Results] sub-window. 

The following example describes how to select a spectrum in [Spectrum View (Registered)] and perform a 
library search. 

To perform a library search on the extracted spectrum, first, display the spectrum extracted from [Contour 
View] or [Chromatogram View] in [Spectrum View (Registered)], and execute the library search. 

1 Select the spectrum in the [Spectrum View], right-click on the view, and click [Library 

Search]. 

The spectra found (hit) by the search criteria are displayed in the library search results. 
The following sub-window displays search results when the [Max # of Hits] is set to “3”. 

No. Explanation

1 Changes the spectrum displayed in the graph.
The number of graphs to display can be set at [Display Settings] on the [View] menu. 

2 Determines the number of hits displayed in the search results window.

3 Displays the [Ret. Time] and [Lambda max] values for the UV spectrum of the target peak. 

1

4

2 3

5
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Click [Repeat Search] on the [Library Search] menu, and change the search criteria in the [Library 
Search] sub-window to perform the search again with new criteria. 

7.5.3 Spectrum Conditions of the Search Target
Set the spectrum conditions during extraction of the UV spectrum to perform higher precision peak 
identification and library searches. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [UV Spectrum] tab, and set the spectrum conditions. 

1 Select [Smoothing] in the [Filtering Type] list to perform spectral smoothing. 

2 Select [Background Compensation] to perform background compensation on spectra. 

3 Click  (View Mode) in [Method View]. 

4 Displays a table of spectrum information that was hit (found) in the search. 
The spectrum information is displayed in order from the highest similarity to lowest. 

5 Displays the searched spectra (Library) overlaying the unknown spectra (Target). 

No. Explanation

2 1
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7.6 Peak Purity Analysis
The peak purity can be calculated and the peak shape of chromatograms at each wavelength can be 
compared to check whether detected peaks contain impurities. 

^ Reference
 Refer to Help for details on peak purity analysis. 

7.6.1 Peak Purity Calculation Parameters
This section describes how to set the calculation range and the compensation conditions based on the 
noise spectrum. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Purity] tab, and set the conditions for the peak purity calculation. 

1 At [From] and [To], enter the wavelength range where purity will be calculated. 

2 At [Step], enter the wavelength interval to use for the calculation. 

3 Select [Background Compensation]. 

• Select [Background Compensation] to calculate the peak purity of components with a slow 
retention time or whose baseline easily drifts as in gradient acquisition. 

• Insufficient peak separation causes the start and end points of the peak to overlap. Better 
results are obtained by not performing background compensation. 

4 Select [Identified Peaks] from the [Compute Purity] drop-down list. 

Depending on the number of peaks and whether [All Peaks] is selected, it may take time to 
perform data analysis. 

5 At [From] and [To], enter the retention time range to set as the noise spectrum. 

Select a time range that incorporates the retention time of the target component. 

• Display the chromatogram as a Max Plot, and verify that there are no peaks between [From] 
and [To], then select the noise spectrum range. 

• Select [Compute noise spectrum from current data for peak purity] to compute the noise 
spectrum from the every data file. 

1
2

3

4

5
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3 Click  (View Mode) in [Method View]. 

The purity calculation is executed according to the preset conditions. 

7.6.2 Displaying Calculation Results
[Purity View] has 2 sub-windows for viewing the results of the peak purity calculation, [Peak Purity] and 
[Peak Profile]. 

[Peak Purity] is used to check the peak purity based on the spectrum information of the detected peak. 
[Peak Profile] is used to check for impurities by comparing chromatograms at multiple wavelengths. 

First, select the desired peak in [Chromatogram View] or [Contour View]. This section describes how to 
select peaks whose purity is to be checked in [Chromatogram View]. 

Next, check the calculation results at [Purity View]. The section describes the following 2 methods:

• "Display Calculation Results using the 3-Point Peak Purity Method"

• "Display the Calculation Result using the Total Peak Purity Method"

1 Move the extraction line in [Chromatogram View], to the peak for which purity is to be 

calculated. 

^ Reference
Refer to "Display the Spectrum of a Desired Retention Time Extracted from the Chromatogram" 
P.182 for more details. 

If the peak is detected, the purity of the selected peak is calculated. 
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 Display Calculation Results using the 3-Point Peak Purity Method

Peak purity is calculated based on 3 points, the upslope, peak top point and downslope.

1 Select the [Peak Purity] tab in [Purity View] then right-click the graph and select [Display 

Settings]. 

2 Select [3-Point] from the [Purity Index Mode] drop-down list, and click [OK]. 

3 Confirm that the 3-point spectra method waveform and calculation results are 

displayed. 

If the spectral similarity between the peak top, the upslope and the downslope is higher than the 
threshold, it is an indication that the calculated peak does not contain impurities. 

 Display the Calculation Result using the Total Peak Purity Method

Peak purity is calculated based on all of the points from peak start to peak end, then the similarity and 
purity curves are displayed. 
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1 Select the [Peak Purity] tab in [Purity View] then right-click the graph and select [Display 

Settings].

2 Select [Total Peak] from the [Purity Index Mode] drop-down list, and set the [Graph Type] 

and [Y Axis Scaling], and click [OK]. 

• If [Purity] is selected, the purity curve (curve obtained by subtracting the threshold curve from the 
similarity curve) and zero compensation line are displayed in the graph. 

• If [Similarity] is selected, the similarity curve and threshold curve are displayed in the graph. 

• To change the display scale of the similarity curve, deselect [Auto Y Scale] at [Y Axis Scaling], 
and enter a display range. 
In the following example, the display range is set to 0.99 to 1.01. 

• Notice in the following [Purity] graph example that impurities are detected where the purity curve 
is below the zero compensation line. 
The negative [Peak purity index] value confirms that the sample contains impurities. 

The [Purity] graph or [Similarity] graph is displayed. 

Purity graph Similarity graph
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 Examine Chromatograms using the Peak Profile

Display chromatograms at multiple wavelengths to compare peak shape. 

1 Select the [Peak Purity] tab in [Purity View] then right-click the graph and select [Display 

Settings].

2 Enter the parameters in the [Display Settings] sub-window, and click [OK]. 

1 Select the [Display Mode]. 

The [Chromatogram] or [Ratio Chromatogram] is displayed. 

The center wavelength refers to the wavelength of the chromatogram extracted from the contour 
view or set in the Multi Chromatogram Table. 

No. Explanation

1 Select [Chromatogram] to display the chromatogram based on the [Wavelength Interval] and [Number of 
Additional Chromatograms] parameters. 
Select [Ratio Chromatogram] to display the central wavelength chromatogram with the ratios between 
the chromatograms based on the [Wavelength Interval] and [Number of Additional Chromatograms]. 

2 Select how many wavelengths (nm) will separate the chromatograms displayed on the short and long 
sides of the center wavelength. 

3 Select the number of chromatograms to display on the short and long sides of the center wavelength. Up 
to 5 wavelengths can be specified on each side. 

4 If [Chromatogram] is selected as [Display Mode] and [Normalize Chromatograms] is selected, the 
intensity axis of the chromatogram is normalized. 

1
2
3
4

Chromatogram Ratio chromatogram
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7.7 Print PDA Data Analysis Results

A report format file must be made in the [Report] window to print PDA data analysis results. This software 
provides several report format files to make printing easier. First-time users of this software can easily print 
analysis results using the pre-installed report format files. As users becomes more familiar with the 
software operations, they can edit or add report items to the pre-installed report format files, or create a 
new report format file and use it to print reports. 

This chapter describes the following procedures.

• "Open the [Report] Window"

• "Open Report Format Files"

• "Edit PDA Report Format"

• "Preview Before Printing"

• "Save Report Format Files"

7.7.1 Open the [Report] Window
Open the [Report] window in either the [Realtime Analysis] program or the [Postrun Analysis] program. 

This section describes how to open the [Report] window in the [Postrun Analysis] program. 

1 Click the  (Report Format) icon on the [Main] assistant bar in the [Postrun Analysis] 

program. 

The [Report] window opens. 
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7.7.2 Open Report Format Files
Several report format files are pre-installed in the \LabSolutions\Sample\LC folder. This section describes 
how to open the report format file “PDA data analysis results.lcr”. 

1 Click  (Select Folder) in the [Data Explorer] sub-window. 

2 Select “\LabSolutions\Sample\LC”, and click [Close]. 

The “\LabSolutions\Sample\LC” folder is displayed in the [Data Explorer] sub-window. 
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3 Drag-and-drop “PDADataAnalysisResults.lsr” onto the [Report] window. 

4 Click the  (Data) tab in the [Data Explorer] sub-window, and select the appropriate 

data file folder.
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5 Drag-and-drop the data file into the report format. 

The data file is loaded into the report format and displayed. 

6 If the report includes multiple pages, use the icons on the toolbar to review the content 

of the other pages.

If the desired data file is not displayed in the [Data Explorer] sub-window, click  (Select Folder), 
and specify the folder that contains the desired data file. 
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7.7.3 Edit PDA Report Format
The following 8 report items are provided for inclusions in the PDA data analysis format. 

This section describes how to edit items in the report format file opened at "7.7.2 Open Report Format 
Files". 

Item Contents

 Contour Graph
Prints the contour graph and 3D graph of the data acquired by the PDA detector. 

^ Reference
For details, see "Change the Display Color and Scale of the Contour View" 
P.214. 

 3D Graph

 UV Spectrum
Prints the information in the spectrum files and the spectra extracted from the data 
acquired by the PDA detector. 

^ Reference
For details, see "Change the Content and Print Scale for UV Spectra" P.216. 

 Peak Purity
Prints the peak purity calculation results for the data acquired by the PDA detector. 

^ Reference
For details, see "Specify the Peaks and Calculation Method to Print the Peak 
Purity Calculation Results" P.220. 

 Peak Profile

 UV Spectrum Index
Prints the identified peak information and its spectrum. 

 UV Library Search
Prints the library search results for the data acquired by the PDA detector. 

^ Reference
For details, see "Change the Content and Print Scale for Library Search 
Results" P.218. 

 UV Library
Prints a list of the spectrum information registered to the UV spectrum library. 
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 Change the Display Color and Scale of the Contour View

Use the pre-installed report format file “Contour3DReport.lsr” to print contour views. Refer to "7.7.2 Open 
Report Format Files" and open “Contour3DReport.lsr”. 

1 Double-click the [Contour Graph] item.

The [Contour Properties] sub-window is displayed.

2 Click the [Contour] tab, and set the [Inten. Scale Position], [Color Mode], and [Number of 

Colors] parameters. 

3 Click the [Scale/Title/Range] tab, then under the [Display Area] deselect [Auto] for the 

the X-axis (time), Y-axis (wavelength) and X-axis (intensity). Enter the desired scale for 

each. 

4 Click [OK]. 

^ Reference
For details, see "7.7.4 Preview Before Printing" P.222. 
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 Change the Display Scale of 3D Graphs

Use the pre-installed report format file “Contour3DReport.lsr” to print 3D graphs. Refer to "7.7.2 Open 
Report Format Files" to open “Contour3DReport.lsr”. 

1 Double-click the [3D Graph] item. 

The [3D Graph] item is located on the second page of “Contour3DReport.lsr”. 

2 Click the [3D] tab, and set the [Inten. Scale Position], [Color Mode], [Number of Colors], 

and [Rotate] parameters. 

3 Click the [Scale/Title/Range] tab and under the [Display Area], deselect [Auto] for the X-

axis (time), Y-axis (wavelength) and Z-axis (intensity). Enter the desired scale for each. 

4 Click [OK]. 

^ Reference
For details, see "7.7.4 Preview Before Printing" P.222. 
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 Change the Content and Print Scale for UV Spectra

Use the pre-installed report format file “PDADataAnalysisResults.lsr” to print UV spectra. Refer to "7.7.2 
Open Report Format Files" to open “PDADataAnalysisResults.lsr”. 

1 Double-click the [UV Spectrum] item. 

2 Click the [Spectrum] tab, and select the spectrum from the [Selection] list. 

Parameter Explanation

ID Peak Selects the spectra to print by entering the ID#s of the compounds in the Compound 
Table. 
The spectra of all identified peaks are printed if [0]-[0] is entered. 

All Channel Select the retention time range at [RT]. 
The spectra of all detected peaks are printed if [0]-[0] is entered.
If multiple peaks are detected, the printed spectra can be easily checked by selecting 
[Reduce duplicate output for same RT]. 

Multi Chromatogram Sets the number of the peak at [Peak #].
The spectra of all detected peaks are printed if [0]-[0] is entered. 

Spectrum Table Sets the row No. of the table at [Row]. 
All of the spectra registered in the Spectrum Table are printed if [0]-[0] is entered.
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3 Click the [Header] tab, and edit the items to display in the report. 

4 Click the [Scale/Title/Range] tab. 

1 Deselect [Auto] for the X-axis (wavelength) and Y-axis (intensity) in the [Display Area], and enter the 
desired scale. 

2 To output reports of lambda max or lambda min spectrum, select [Lambda max Label] or [Lambda 
min Label], and click [Format]. 

5 Click [OK]. 

^ Reference
Refer to "7.7.4 Preview Before Printing" P.222 for details. 

1
2
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 Change the Content and Print Scale for Library Search Results

Use the pre-installed report format file “PDADataAnalysisResults.lsr” to print library search results. Refer to 
"7.7.2 Open Report Format Files" to open “PDADataAnalysisResults.lsr”. 

Data processing parameter changes on the [Library Search] tab for the data file are not printed even if the 
library search results are printed. Add the [Method] item to print the settings made on the [Library Search] 
tab. 

1 Double-click the [UV Library Search] item. 

The [UV Library Search] item is located on the second page of "PDADataAnalysisResults.lsr". 

2 Click the [UV Library Search] tab. 

1 Select the searched peaks to display in the [Selection] list. 

2 Enter the number of hits to display at [# of Hits]. 

3 Select the target spectrum print method at [Display target spectrum]. 

3

2

1
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3 Click each of the [Search Header], [Result Spectrum Header], and [Target Spectrum 

Header] tabs, and edit the header information to display in the report. 

The [Target Spectrum Header] tab is shown in the following example. 

^ Reference
Refer to "8.5.11 Edit Calibration Curve Information" P.251 for more details.

4 Click each of the [Result Spectrum - Scale/Title/Range], and [Target Spectrum - Scale/

Title/Range] tabs and under [Display Area], deselect [Auto] for X-axis (wavelength) and 

Y-axis (intensity). Then, enter the desired scale. 

The [Target Spectrum - Scale/Title/Range] tab is shown in the following example. 
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5 Click the [Search Result] tab, and select the table information to be displayed for each of 

the spectra hit (found) in the search. 

6 Click [OK]. 

^ Reference
Refer to "7.7.4 Preview Before Printing" P.222 for details. 

 Specify the Peaks and Calculation Method to Print the Peak Purity Calculation 

Results

Use the pre-installed report format file “PDADataAnalysisResults.lsr” to print peak purity calculation results. 
Refer to "7.7.2 Open Report Format Files" to open “PDADataAnalysisResults.lsr”. 

Data processing parameter changes made on the [Purity] tab for the data file are not printed even if the peak 
purity calculation results are printed. Add the [Method] item to print the settings made on the [Purity] tab. 

1 Double-click the [Peak Purity] item.

The [Peak Purity] item is located on the third page of "PDADataAnalysisResults.lsr". 
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2 Click the [Peak Purity] tab. 

1 Select the peaks to display in the [Selection] list. 

If [ID Peak] is selected, select the calculation results to print by entering the ID#s of the compounds 
in the Compound Table. The calculation results of all identified peaks are printed if [0]-[0] is entered. 

If [Multi Chrom] is selected, select the number of the peak at [Peak #]. The calculation results of all 
detected peaks are printed if [0]-[0] is entered.

2 Select the purity calculation mode in the [Mode] list. 

3 Select the display graph in the [Graph Type] list. 

3 Click the [Header] tab, and edit the items to display in the report. 

^ Reference
Refer to "8.5.11 Edit Calibration Curve Information" P.251 for details.

4 Click [OK]. 

2

3

1

2

3

2
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7.7.4 Preview Before Printing
Preview the print details set in "7.7.3 Edit PDA Report Format" before printing the report.

1 Click the  (Preview) icon on the [Report] assistant bar. 

2 Check the report in the preview sub-window, and click [Close]. 
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3 Click the  (Print) icon on the [Report] assistant bar. 

The report is printed. 

7.7.5 Save Report Format Files
Once a report format is complete, save the report format file under a new name. 

1 Click [Save Report Format File As] on the [File] menu. 

2 Set [Save in], enter the file name, and click [Save]. 
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8Report Function

This chapter describes how to use the report function to print chromatograms and quantitative results. 

Use the report format function, to combine report items, such as sample information, chromatograms 
and quantitative results, to create reports in various formats. 

8.1 Print Reports in Batch Processing

This section describes how to use the Batch Table to print reports in realtime batch. 

^ Reference
Refer to "4.2 Create Batch Tables" P.65 for details on creating a new Batch Table. 

1 Click the  (Realtime Batch) icon on the [Main] assistant bar in the [Realtime 

Analysis] program. 

2 Click  (Toggle Data Explorer) on the toolbar. 

3 In the [Data Explorer] sub-window, drag-and-drop the target batch file onto the Batch 

Table. 
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4 Select the [Report Output] cell in the desired rows, and select the [Report Format File]. 

• If a new report format file has not been created, select an installed report format file in the [Report 
Format File] cell. 

• If a report format file has been created, select that report format file in the [Report Format File] cell. 

• If the [Report Format File] cell is left blank, the default report format file “Default.lsr” is used to print the 
report. 

^ Reference
• Refer to "8.3.1 Installed Report Format Files" P.234 for details on pre-installed report format files. 

• Refer to "8.1.1 Change the Default Report Format File" P.226 for details on the default report 
format file.

5 Click the  (Start Realtime Batch) icon on the [Realtime Batch] assistant bar. 

The report is automatically printed when data acquisition for the selected row is complete. 

Set the Batch Table in the same way in the [Postrun Batch] window, to automatically print reports in 
postrun batch. 

^ Reference
Refer to "4.4.4 Print a Summary Report" P.91 for details on outputting summary reports. 

8.1.1 Change the Default Report Format File
When [Report Output] is selected for single run or realtime batch, reports are printed in a pre-determined 
default report format even if a report format file is not set. 

This section describes how to change the default report format file in the [Realtime Batch] window. 

1 Click [Options] on the [Tools] menu in the [Realtime Batch] window. 
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2 Click [Change] on the [Report] tab, set the report file to change, and click [OK]. 

• Do not delete or move the default report format file. 

• If the [Report Format File] cell is left blank and [Report Output] is selected, reports are printed in 
the report format saved in each data file. 

^ Reference
Refer to "8.2 Print Data Processing Results" P.227 for details on the report format saved in each data 
file. 

8.2 Print Data Processing Results

This section describes how to print reports from data files in the [Data Analysis] window or [PDA Data 
Analysis] window. 

1 Open the data file in the [Data Analysis] window or [PDA Data Analysis] window, select 

[Data Report] on the [File] menu, and click [Print]. 

The report is printed. 
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• If a report format file was not specified at the time of data acquisition, the default report format file 
[Default.lsr] is used to print the report. 

• Select [Data Report] on the [File] menu, and click [Preview] to check the printed details. The 
preview sub-window opens. 

• Select [Data Report] on the [File] menu, and click [Edit Format] to change the report format. The 
report format in the data file is edited. 

^ Reference
Refer to "8.4 Create a Report Format File" P.236 for details on pasting new items to reports. 
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8.3 Edit Report Format Files

Sample report format files are installed in the \LabSolutions\Sample\LC (or \LabSolutions\Sample\GC) 
folder. First-time users should use these report format files as a base to make new report format files. 

This section describes how to open the pre-installed report format file "peak report_1.lsr" in the [Report] 
window, and display the compound name in the peak top comment of the chromatogram. 

^ Reference
Refer to "8.3.1 Installed Report Format Files" P.234 for details on pre-installed report format files.

1 Click the  (Report Format) icon on the [Main] assistant bar. 

The [Report] window opens. 

2 Click  (Select Folder) in the [Data Explorer] sub-window. 

3 Select “\LabSolutions\Sample\LC” (or “\LabSolutions\Sample\GC”), and click [Close]. 

The contents of the “\LabSolutions\Sample\LC” (or “\LabSolutions\Sample\GC”) [Folder] is displayed 
in the [Data Explorer] sub-window. 
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4 Drag-and-drop “peak report_1.lcr” from the [Data Explorer] sub-window onto the 

[Report] window. 

5 Click the  (Data) tab at the bottom of the [Data Explorer] sub-window, and drag-and-

drop the data file. 
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The contents of the data file is displayed in the [Report] window. 

If the data file is not displayed in the [Data Explorer] sub-window, click  (Select Folder), and 

specify the folder that contains the desired data file. 

6 Double-click the chromatogram item. 

The [LC/PDA Chromatogram Properties] sub-window opens. 
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7 Click the [Peak Top Comment] tab, enter the [Peak Top Comment] tab parameters, and 

click [OK]. 

1 Select [Name] in the [Hide Items] box, and click [Add]. 

[Name] is displayed in the [Display Items] box. 

Click [Format] to open the [Format Settings] sub-window to edit the number of display digits and 
rounding method. Refer to "8.5.9 Edit the Numeric Value Format in the Quantitative Results 
Table" P.249 for details.

2 Select [ID Peak] and [Others] to display the peak top comment on all detected peaks. 

3 Enter the [Angle] or [Position] to change the angle or position of the peak top comment. 

The default angle is “90”. Increase the value to rotate the comment counterclockwise from the 
start of the text string.

^ Reference
Refer to "8.4 Create a Report Format File" P.236 for details on adding items to the report format.
Refer to "8.5 Edit Report Items" P.241 or "7.7.3 Edit PDA Report Format" P.213 to edit other report 
format items. 

8 Click the  (Preview) icon on the [Report] assistant bar. 

1

2

3
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9 Preview the report, and click [Close]. 

10 Click [Save Report Format File As] on the [File] menu. 

11 Enter a file name at [Save in], and click [Save]. 
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8.3.1 Installed Report Format Files
The following report format files are installed. 

Pre-installed report format files are saved to the \LabSolutions\Sample\LC (\LabSolutions\Sample\GC) 
folder. 

Report Format File Contents

Method.lsr This file is used to print all instrument parameters and data processing 
parameters set in the method file. 

CalibrationCurveReport_1.lsr This file is used to print a calibration curve graph and calibration curve 
information. 

CalibrationCurveReport_2.lsr This file is used to print chromatograms, sample information, quantitative results, 
and calibration curve information. 

CalibrationCurveReport_3.lsr This file is used to print two blocks of calibration curve graph and rhe list.

QuantitativeResults_1.lsr This file is used to print sample information, chromatograms, and quantitative 
results. 
(This is a basic report format file.) 

QuantitativeResults_2.lsr This file is used to print vertical stack display, sample information and 
quantitative results of chromatograms acquired by detector1 and detector2. 

QuantitativeResults_3.lsr This file is used to print horizontal stack display, sample information and 
quantitative results of chromatograms acquired by detector1 and detectorB. 

QuantitativeResults_4.lsr This file is used to print the chromatogram and quantitative results ofdetector1 on 
the first page, and the chromatogram and quantitative results of detector2 on the 
second page. 

QuantitativeResults_5.lsr This file is used to print the all chromatogram (overlay) and the quantitative 
results in landscape page.

PeakReport_1.lsr This file is used to print sample information, chromatograms, and peak reports. 
(This is a basic report format file.) 

PeakReport_2.lsr This file is used to print chromatograms in landscape orientation. 

PeakReport_3.lsr This file is used to print basic method information in addition to the content of the 
basic format. 

PeakReport_4.lsr This file is used to print the chromatogram and the peak report in landscape 
page.

PeakReport_5.lsr This file is used to print the divided chromatogram and the peak report.

PeakReport_CalibrationCurve.lsr This file is used to print calibration curve information in addition to the content of 
the basic format.

SummaryReport_1.lsr This file is used to print a summary of chromatograms and peak reports of 
multiple data. 

SummaryReport_2.lsr This file is used to print the concentration, area and height of multiple data by 
individual compound. 

SummaryReport_3.lsr This file is used to print the chromatograms and the statistical calculation results 
of the concentration, area and height of multiple data. 

SummaryReport_4.lsr This file is used to print the chromatogram(Landscape), and the quantitative 
summary report for each compound.

SummaryReport_5.lsr This file is used to print the concentration summary report, the area summary 
report and the height summary report in landscape page.

SummaryReport_6.lsr This file is used to print the chromatogram(overlay), and the quantitative 
summary report for each compound.

GroupResults_1.lsr This file is used to print chromatograms and grouping results. 
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*1:\LabSolutions\Sample\LC folder only
*2:\LabSolutions\Sample\GC folder only

GroupResults_2.lsr This file is used to print chromatograms, grouping results and group calibration 
curve.

BatchTable.lcr This file is used to print the batch table in landscape page.

FractionCollectionReport.lsr(*1) This file is used to print chromatograms and fraction collection results. 

Contour3DReport.lsr(*1) This file is used to print contour views and 3D graphs of PDA data. 

PDADataAnalysisResults.lsr(*1) This file is used to print chromatograms and PDA data analysis results 
(UV spectra, library search and peak purity). 

GCMethodShort.lcr(*2) This file is used to print the chromatogram and the peak report with general 
method parameters.

GCConfiguraton.lcr(*2) This file is used to print the GC system configuration.

Report Format File Contents
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8.4 Create a Report Format File

This section describes an example of how to make a new report format file in the [Report] window. 

^ Reference
Refer to "8.5 Edit Report Items" P.241 for details. 

1 Click the  (Report Format) icon on the [Main] assistant bar. 

2 Click  (New) on the toolbar. 

3 Click  (Chromatogram) on the toolbar. 

^ Reference
Refer to "8.4.1 Types of Report Items" P.240 for details on each toolbar item. 

4 Drag the cursor on the format to specify a range for the chromatogram. 
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5 In the [LC/PDA Chromatogram Properties] sub-window, correct the display position and 

edit the display items, and click [OK]. 

Double-click inside the item frame to open the [LC/PDA Chromatogram Properties] sub-window. 

^ Reference
Refer to "8.5.1 Change the Chromatogram Properties" P.241 or "8.5.2 Chromatogram Display Scale" 
P.242 for details on editing the chromatogram display.

6 Click the  (Data) tab at the bottom of the [Data Explorer] sub-window and drag-and-

drop the target data file onto the report format to examine the print details of a report 

format file. 
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The chromatogram information of the data file is displayed in the [Report] window. 

• Right-click on an item and click [Delete] to remove the item. 

• Drag-and-drop the data file to a specific item with the [Shift] key held down to load data only to 
that item. 

• If the data file is not displayed in the [Data Explorer] sub-window, click  (Select Folder), and 

specify the folder containing the desired data file. 

7 Click the  (Preview) icon on the [Report] assistant bar. 

8 Examine the report in the preview sub-window, and click [Close]. 

9 Click [Save Report Format File As] on the [File] menu. 
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10 Specify a folder at [Save in], enter a [File Name], and click [Save]. 
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8.4.1 Types of Report Items
Items, such as chromatograms and quantitative result information, can be added to the report format using 
the icons on the toolbar. The following report items are available. 

Item Content

    Figure Use these icons to add a Line, Arrow, Rectangle or Ellipse to the report format. 

 Text Use this icon to add a text box to the report format. 

 Picture Use this icon to add bitmaps or other image files to the report format. 

 System Configuration Use this icon to add the instrument configuration at the time of data acquisition to 
the report format. 

 Sample Information Use this icon to add sample information to the report format. 

 Method Use this icon to add method file information, such as the instrument and data 
processing parameters to the report format. 

 Batch Table Use this icon to add the Batch Table and batch file settings to the report format. 

 System Check Use this icon to add the system check results saved in data files to the report 
format. 

 Chromatogram Use this icon to add chromatograms and instrument status information to the 
report format. 

 Calibration Curve Use this icon to add the calibration curve graph and information to the report 
format. 

 Peak Table Use this icon to add a table of the retention times and area values of detected 
peaks to the report format. 

 Quantitative Results Use this icon to add a table of the quantitative results of identified peaks to the 
report format. 

 Group Results Use this icon to add a table of the quantitative results for grouped compounds to 
the report format. 

 Fraction Collection Report Use this icon to add a table of the fraction collection status to the report format.

 Summary (Concentration) Use this icon to add a summary of the chromatograms, statistical concentration 
results, areas and heights for multiple data acquisitions to the report format. 

 Summary (Compound) Use this icon to add a summary of the concentrations, areas and heights of 
multiple data by individual compound to the report format. 

 Summary (Data) Use this icon to add a summary of the chromatograms and Peak Tables for 
multiple data to the report format. 

 Status Information Use this icon to add contour graphs of PDA data to the report format. 

 Contour Graph Use this icon to add 3D graphs of PDA data to the report format. 

 3D Graph Use this item to add PDA spectra and spectra information to the report format. 

 UV Spectrum Use this icon to add the PDA peak purity results to the report format. 

 Peak Purity Use this icon to add the PDA peak profile information to the report format. 

 Peak Profile Use this icon to add PDA chromatograms and spectra for detected peaks to the 
report format. 

 UV Spectrum Index Use this icon to add UV Library Search results to the report format. 

 UV Library Search Use this icon to add a list of the spectra in the library file to the report format. 

 UV Library Use these icons to add a Line, Arrow, Rectangle or Ellipse to the report format. 
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8.5 Edit Report Items

This section describes how to edit properties for each report item. 

8.5.1 Change the Chromatogram Properties
The following section describes how to set the chromatogram display properties on the [Chromatogram] 
tab of the [Chromatogram Properties] sub-window. 

1 Click the [Chromatogram] tab. 

2 Enter the properties on the [Chromatogram] tab, and click [OK]. 

1 Select each of the checkboxes to print the [Baseline] and [Peak Detection Mark].  

2 Click [Portrait] and [Overlay] in the [Type] list to draw chromatograms overlaid in a portrait 
orientation.
Click [Landscape] and [Separate] in the [Type] list to draw chromatograms overlaid in a landscape 
orientation.

3 Click [All] in the [Displayed Chromatogram] list.

 

• When [Select Chromatogram] in the [Displayed Chromatogram] list is selected and select the 
detector in [Detector], all of the channels set by that detector are displayed. 

• When [No Chromatogram] is selected in the [Displayed Chromatogram] list, chromatograms 
are not displayed. Use this parameter to display only the instrument status.  

2 31
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8.5.2 Chromatogram Display Scale
Set the chromatogram display scale and scale interval on the [Setting Scale] tab in the [Chromatogram 
Properties] sub-window. 

1 Click the [Setting Scale] tab. 

2 Enter the properties on the [Setting Scale] tab, and click [OK]. 

1 Select [Scale Interval], and set the interval at [Scale Interval] and [Sub Scale] to display the scale on 
the intensity axis (Y-axis) and time axis (X-axis). 

2 Deselect [Use range in data], and select the display unit and reference peak at [Inten. Unit] and 
[Scale to] to set the chromatogram intensity axis (Y-axis). 

• The default setting is [Use range in data], and the intensity unit and intensity axis range saved 
in data files are used. 

• If [Zero Base Point] is selected and a setting other than [User Defined] is selected at [Scale 
to], chromatograms are auto-scaled and displayed on the intensity axis of 0 V or more. 

• Set the upper/lower width (margin) of the intensity axis at [Margin] when chromatogram 
displays are auto-scaled. 

• If the intensity axis is unique for each chromatogram, for example, because the peak height 
of obtained by data acquisition differs for each detection channel, select [Set per 
Chromatogram] and enter the upper limit and lower limit values for each chromatogram. 

2

1
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8.5.3 Display the LC Instrument Status and Gradient Curve
Use the [LC Status] tab of the [Chromatogram Properties] sub-window to overlay the instrument status 
information and gradient curve on chromatograms.

This section describes how to overlay the gradient curve for pump B (B.Conc%) on a chromatogram. 

1 Click the [LC Status] tab. 

2 Enter the [LC Status] tab parameters, and click [OK]. 

1 Select [B.Conc] in the [Hide Items] box, and click [Add]. 

[B.Conc] is added to the [Display Items] box. 

2 Select [Y Scale (Conc.)] at [Scale] and [Title]. 

3 Click [Intensity Range] to set the intensity axis range. 

1 Click [Manual] in the [Scale to] list. 

2 Enter the upper limit and lower limits at [Conc]. 

3 Click [OK].

4 Check the edited details, and click [OK]. 

1

2

1

2
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8.5.4 Display the GC Instrument Status and Column Oven Temperature
To draw the instrument status information and column oven monitor temperature overlaid on 
chromatograms, set this on the [GC Status] tab in the [Chromatogram Properties] sub-window.

This section describes how to draw the column oven monitor temperature overlaid on chromatograms.

• If [Save the Status Monitor] is selected in the [Properties] sub-window for the GC in the [System 
Configuration] sub-window, the monitor temperature can be displayed overlaid by performing data 
acquisition. The monitor temperature can be displayed only for the data file that retains monitor values.

• With the GC other than GC-2010 and GC-2014, status monitor values cannot be retained. 

1 Click the [GC Status] tab.

2 Set the [GC Status] tab.

1 Select [Monitor Column Oven Temperature] in the [Hide Items] list, and click [Add].

[Monitor Column Oven Temperature] is added to the [Display Item] list.

2 Select [Y Scale (Temp.)] at [Scale] and [Title].

3 Click [Intensity Range] to set the intensity axis range. 

1 Select [Manual] in the [Scale to] list. 

2 Enter the upper limit and lower limits at [Temp.]. 

3 Click [OK].

4 Check the edited details, and click [OK]. 

1

2

1
2
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8.5.5 Edit Sample Information Display
Click [Remarks] on the [Chromatogram] tab of the [Chromatogram Properties] sub-window, and select the 
desired remark to display sample information in the chromatogram remarks section. 

1 Click the [Chromatogram] tab, select [Remarks], and click [Detail]. 

2 Select the display item in the [Remarks] sub-window, and click [OK]. 

1 Select the items to print in the [Hide Items] box. 

2 Click [Add]. 
The added items are displayed in the [Display Items] box. 

1
2
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8.5.6 Display the Background File
Use the [Chromatogram] tab in the [Chromatogram Properties] sub-window to overlay the background data 
or the chromatograms before background compensation. 

1 Click the [Chromatogram] tab. 

2 Enter the [Chromatogram] tab parameters, and click [OK]. 

1 Click [Overlay] in the [Type] list. 

2 Select the chromatograms to be overlaid at [Displayed Chromatogram]. 

3 Select [Original Chrom. (before Background Compensation)] and [Background Chromatogram]. 

1

2

3
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8.5.7 Attach a Specific Chromatogram to the Report Format
Enter a file on the [File] tab of the [Chromatogram Properties] sub-window to attach a specific (reference) 
chromatogram to the report format and cause the same chromatogram to be printed each time the report 
format is used to print data. 

1 Click the [File] tab. 

2 Select the [File] tab parameters, and click [OK]. 

1 Click [Browse] and select the desired data file, and click [Open]. 

2 Select [Fix file in the item]. 

Select [Fix file in the item] to print the chromatogram selected in [File] each time the report 
format is used. This selected chromatogram is printed even if a different data file is loaded in the 
[Report] window. 

3
1
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8.5.8 Edit the Quantitative Results Table

1 Click the [Quantitative Results] tab. 

2 Set the [Quantitative Results] tab parameters, and click [OK]. 

1 Select items to print in the [Hide Items] box, and click [Add]. 

The added items are displayed in the [Display Items] box. 

2 Select the desired items to display statistical calculation results and the grid. 

When displayed items include column performance parameters (e.g. number of theoretical plates 
and tailing factor), all values calculated by the various pharmacopoeia methods (JP, USP, etc.) 
specified in the data processing parameters are displayed.
To filter the reported calculation results in the Quantitative Results Table, click the [Column 
Performance Settings] button, select [Display only selected calc. method] in the [Display Settings for 
Column Performance Results] sub-window that is displayed, and specify the calculation results to 
display.

1

2
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8.5.9 Edit the Numeric Value Format in the Quantitative Results Table
It is possible to set the rounding method and the display parameters for the numeric data. 

This section describes the procedure for changing the numeric format of [Area Ratio]. 

1 Click the [Quantitative Results] tab. 

2 Select [Area Ratio] in the [Hide Items] box, and click [Add]. 

[Area Ratio] is displayed in the [Display Items] box. 

3 Select [Area Ratio] in the [Display Items] box, and click the [99.9999] format.

4 Make the appropriate settings in the [Format Settings] sub-window, and click [OK]. 

1 Select [Option Settings]. 

2 Click [Significant Digits] at [Display Type]. 

3 Select [Significant Digits], and enter “6”. 

4 Click [Half Adjust] at [Rounding]. 

By default, [Option Settings] is deselected and the display format and rounding method set in the 
[Data Processing Setting] sub-window for [System Settings] in [Administration Tools] are used. 

5 Check the edited details, and click [OK]. 

1
2
3
4
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8.5.10Edit Sample Information
Use the [Sample Information] tab of the [Sample Information Properties] sub-window to select the sample 
information to include in the report format. 

The following section describes how to display the repeat injection count of the same vial number set in the 
batch file.

1 Click the [Sample Information] tab. 

2 Set the [Sample Information] tab parameters, and click [OK]. 

1 Select [Sampling Count from the Vial] in the [Hide Items] box, and click [Add]. 

[Sampling Count from the Vial] is displayed in the [Display Items] box. 

2 To display 2 sample information items in a row, enter “2” at [# of Items in a Row]. 

Click [Setting Macro] on the [Sample Information] tab and create a method using macros to 
display sample information. Select the information to be displayed and the position in the 
macros sub-window. Once macros have been used to set the [Sample Information] tab 
parameters, the original table format sub-window cannot be displayed. 

1

2
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8.5.11Edit Calibration Curve Information
Use the [Header] tab in the [Calibration Curve Properties] sub-window to edit calibration curve information 
such as, calibration curve expressions and quantitative calculation methods. 

Macros are provided for each of the [Header] tab items. These macros can be edited to determine display 
items and positions in reports. 

This section describes how to edit the [Channel] macro to print the channel. 

1 Click the [Header] tab. 

2 Place the cursor in the position where the new information is to be added in the display 

area to the left, select [Channel] in the [Variable] list, and click [Insert]. 

[$Channel$] is added to the text display area. 
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3 Prefix the additional macro [$Channel$] with “Channel:”. 

• Tabs can be inserted by pressing the [Ctrl] and [I] keys at the same time. The tab interval is the 
number of characters set at [Tab Stop]. 

• Click [Initialize] to restore the default settings. 

• Use the [Position] tab to change the display position of the calibration curve graph and table. 

• [Channel] is displayed as follows:

4 Check the edited details, and click [OK]. 
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8.5.12Change the Color and Line Width of Overlaid Chromatograms
Select the number of lines, line color and line width for overlaid chromatograms on the [General] tab in the 
[Summary (Concentration) Properties] sub-window. 

This section describes how to change the color, line type and line width of overlaid chromatograms. 

1 Click the [General] tab. 

2 Set the [General] tab parameters, and click [OK]. 

1 Enter “2” at [Definable Max Lines]. 

When “2” is set to [Definable Max Lines], [Graph - Chromato Line 2] is added to the [Color] list. 
Values higher than 2 for [Definable Max Lines] add additional chromatograms to the color list.

2 Select [Graph - Chromato Line 2] in the [Color] list. 

3 Click [Set], select red in the [Color] sub-window, and click [OK]. 

4 Click [Dot] in the [Style] list. 

5 Set [Width] to “2”. 

In addition to chromatograms, statistical results can also be output with the [Summary 
(Concentration)] item. Select the summary data (area, height and concentration) and the statistical 
items to display on the [Summary] tab to display the statistical calculation results of multiple data. 

1 2 3 4 5
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8.5.13Edit the Statistical Results Table
Items such as statistical results can be displayed by adding them to the [Display Items] box on the 
[Summary] tab in [Summary (Compound) Properties]. 

1 Click the [Summary] tab. 

2 Set the [Summary] tab parameters, and click [OK]. 

1 Select the items to be displayed in the report in the [Hide Items] box, and click [Add]. 

The added items are displayed in the [Display Items] box. 

2 Select the respective items to display the statistical results and the grid in the table. 

• If [Calculate by specified digits] is selected, statistical calculation is performed using the number 
of digits set in the [Format Settings] sub-window. 

• If the number of theoretical plates and tailing factor display items are selected, all values 
calculated by the formulas (JP method and USP method) specified in the data processing 
parameters are displayed. 
Click the [Column Performance Settings] button, and select [Display only selected calc. method] 
in the [Display Settings for Column Performance Results] sub-window to select calculation results 
to display in the Quantitative Results Table. 

1

2
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8.5.14Edit the Measurement Results Table
Use the [Summary (Data)] item to display one of three tables, the Peak Table, Quantitative Results Table 
and Grouping Results Table. 

This section describes how to use the [Summary (Data)] item to edit the Peak Table display items.

1 Click the [Display] tab. 

2 Select [Display peak table]. 

3 Click the [Peak Table] tab. 

4 Set the [Peak Table] tab parameters, and click [OK]. 

1 Select the desired items in the [Hide Items] box, and click [Add]. 

The added items are displayed in the [Display Items] box. 

2 Select the respective items to display the total values and grids. 

1

2
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• If the number of theoretical plates and tailing factor display items are selected, all values 
calculated by the formulas (JP method and USP method) specified in the data processing 
parameters are displayed. 
Click the [Column Performance Settings] button, and select [Display only selected calc. method] 
in the [Display Settings for Column Performance Results] sub-window to select the calculation 
results to display in the Quantitative Results Table. 

8.5.15Change the Display of Chromatograms and Results Tables
Use the [Display] tab in the [Summary (Data) Properties] sub-window to change the horizontal and vertical 
chromatogram display and table information to display. 

1 Click the [Display] tab. 

2 Set the [Display] tab parameters, and click [OK]. 

1 Click [Right Chromatogram] to display the table on the right side of the chromatogram. 

2 Change [Arrangement] to change the display aspect ratio of chromatograms and tables. 

2
1
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8.6 Report Layout

Functions for editing the positions of report items include position and size adjustment, header/footer 
setting and the ability to add, move or delete pages. 

8.6.1 Change the Item Position and Number of Pages
If a report format includes multiple items, the layout icons are enabled in the toolbar so that the items can 
be repositioned.

Pages can be added to and deleted from the report format.

 Re-Position Items

1 Click  (Pointer) on the toolbar. 

2 Drag the point so that it encloses the items to be re-positioned. 
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3 Click each of the items on the [Report] toolbar, and adjust the position of items. 

• Some of the layout icons are disabled if only one item is selected.

• Drag the frame of the report item to resize that item. 

 Add or Delete Report Pages

I

All icons except the [Insert (Page)] icon (1) are disabled if there is only one page.

No. Explanation

1 Aligns items to the left edge of the left most item. 

2 Aligns items to the right edge of the right most item. 

3 Aligns items to the top edge of the topmost item. 

4 Aligns items to the bottom edge of the bottommost item. 

5 Aligns the width of each item to the longest horizontal item. 

6 Aligns the height of each item to the longest vertical item. 

7 Aligns the width and height of each item to the longest horizontal and vertical item. 

1234 567

No. Explanation

1 Inserts a page after the currently displayed page. 

2 Deletes the currently displayed page. 

3 Displays the first page. 

4 Displays the previous page. 

5 Displays the next page. 

6 Displays the last page. 

345612
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8.6.2 Use the Grid
Use the grid to adjust the positions of report items.

This section describes how to display the grid in the [Report] window. 

1 Display the report format file on the [Report] window, and click  (Toggle Grid) on the 

toolbar. 

2 To adjust the interval of the displayed grid, click [Option] on the [View] menu. 

3 Enter [Grid Width], and click [OK]. 

The grid is displayed at that interval. 



8  Report Function

260   Operators Guide

8.6.3 Headers and Footers
This section describes how to display information such as, print date, page number in the header or footer 
of the report format.

1 Display the report format file on the [Report] window, and click [Header/Footer] on the 

[View] menu. 

2 Select the [Header] or [Footer] tab and select the information to be displayed in the 

[Left], [Center], and [Right] sections. 

3 Click [OK]. 

The settings are displayed in the report header or footer. 

8.6.4 Paper Size and Margin
Click [Page Setup] on the [File] menu in the [Report] window. The [Page Setup] sub-window is displayed. 
Select the paper size, paper source, orientation (portrait or landscape), and margins of the report. 
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8.7 Other Reports

Exclusive reports can also be output from the following sub-windows. 

Window/Sub-Window Explanation (Operation Method)

Data Acquisition The contents of the displayed method file are loaded to a system exclusive report 
format and output. ([Print Method File] on the [File] menu)

System Configuration The current system configuration information is loaded to a system exclusive report 
format and output. ([Print] button)

Realtime Batch
Postrun Batch

The contents of the Batch Table are loaded to a system exclusive report format and 
output. Edit the report format to match specific display items. 
([Print Batch Table] on the [File] menu)

Data Analysis
PDA Data Analysis
Calibration Curve
Data Comparison
UV Library Editor
Quant Browser

The contents of files loaded to each window can be loaded to a system exclusive report 
format and output. 

Spectrum Index The PDA chromatograms and spectra for detected peaks are loaded to a system 
exclusive report format and output. 
([Print Spectrum Index] on the [File] menu in the [PDA Data Analysis] window)

Spectrum Table Spectrum information registered to the Spectrum Table is output. 

UV Library Search Results The UV library search results are loaded to an exclusive report format and output. 
Edit the report format to match the settings made in the data processing parameters. 
([Print] on the [Library Search] menu)

Audit Trail Log If the audit trail log is activated, the log contents are output in a fixed format. ([Print] 
button)

Log Browser Each log displayed in the log browser is output in a fixed format. 

Show Check Result Results of the program or raw data check are output in a fixed format. 

System Check Results The system check results are output in a fixed format. 
([Print] button)
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9Quant Browser

Use the [Quant Browser] window to edit a method file and then perform quantitative calculation on 
multiple data. 

This chapter describes how to edit the quantitative results for multiple data files, and perform 
collective postrun analysis on multiple data files.

9.1 [Quant Browser] Window

The [Quant Browser] window is comprised of the following views:

• [Quantitative Results View] - displays the quantitative calculation results

• [Method View] - displays the method file parameters

• [Chromatogram View] - displays the chromatograms and sample information

• [Calibration Curve/Spectrum View] - displays the calibration curves and spectra 

9.1.1 Open the [Quant Browser] Window

1 Select the  icon on the [LabSolutions Main] icon bar, and double-click the  

icon. 

The [Browser] program opens. 
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2 Click the  (Quant Browser) icon on the [Main] assistant bar in the [Browser] 

program. 

3 Drag-and-drop the method file from the [Data Explorer] sub-window onto the [Quant 

Browser] window. 

The contents of the method file are displayed in the [Quant Browser] window. 
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9.1.2 [Quant Browser] Window Description
This section describes how to view and use the [Quant Browser] window. 

• The [Quant Browser] views that are separated by dividers. Drag the dividers with the mouse to resize the 
views.

• Use the [Quant Browser] to check the quantitative calculation results of up to 1024 data files.

• Click [Save Browsing File As] on the [Layout] menu to save the name of the method and data file, file sort 
order, layout information, and other details as a browsing file (file extension *.lcq).

• Files are [Read Only] if they are currently being edited in other windows and cannot be edited. Close the 
file in the other window, and open the file again to edit these files.

No. Explanation

1 Displays the [Standard] and [Quant Browser] toolbars. 

2 Displays the quantitative calculation results of compounds selected on the [Compound] tab in [Method View]. 

Click  to change the ID # and the displayed compound. 

3 Displays the data processing parameters in the method file. Click  (Edit Mode) to change the 

parameters. Click  (View Mode) after editing to reflect the changes in [Method View]. 

4 Displays the calibration curve for the compound selected on the [Compound] tab in [Method View] or the 
spectra specified in [Chromatogram View]. 

5 Displays the [Chromatogram] and [Sample Info] for the selected data file. Clicking  or  to double or 
halve the intensity axis (Y-axis), respectively.

6 Click this icon to expand the view to the full screen size.

6

Toolber1

4 [Calibration Curve/
Spectrum View] 

 [Quantitative Results View]2 [Method View]3

[Chromatogram View]5
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9.2 Check Quantitative Results in the Quant Browser

Multiple data can be displayed in a simple form in the [Quant Browser] window.

This section describes how to display data in each of the [Quant Browser] views. 

9.2.1 Open Batch Files
This section describes how to open batch files to display the contents of the method file and data files. 

1 Click the  (Batch) tab at the bottom of the [Data Explorer] sub-window. 
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2 Drag-and-drop the batch file onto the [Quant Browser] window from the [Data Explorer] 

sub-window. 

The contents of the method file and data files are displayed in the [Quant Browser] window. 

3 Click the [Compound] tab in [Method View], and select the desired compound. 

The quantitative results of the selected compound are displayed in [Quantitative Results View], and the 
calibration curve is displayed in the [Calibration Curve/Spectrum View]. 
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4 Select the data file from [Quantitative Results View], and click the data file. 

The chromatogram of the selected data file is displayed in the [Chromatogram View]. 

• The method file in the top row of the Batch Table is displayed in [Method View] when a batch file is 
selected in the [Data Explorer] sub-window. If the method file contains calibration curve information, the 
standard sample data file used for making the calibration curve is loaded. 

• The data file and method file must be saved to the same folder as the batch file to display the content of 
the method file and data file using a batch file. 

• Edit the method file and data file in the [Quant Browser] window. The batch file is not changed when data 
is displayed. 
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9.2.2 Open Data Files
Open data files to display the contents of data files in each view. 

This section describes how to open the data file of an unknown sample. 

1 Drag-and-drop the data file onto the [Quant Browser] window from the [Data Explorer] 

sub-window. 

The contents of the data file and method file are displayed in the [Quant Browser] window. 

Multiple files are selected when the data file is dragged-and-dropped onto the [Quant Browser] window from 
the [Data Explorer] sub-window. The method file in the top data file is displayed in [Method View]. If the 
loaded method file contains calibration curve information, the content of the standard sample data file used 
to make the calibration curve is also displayed.
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9.2.3 Change the Detector
The method for the targeted detector can be changed if the method files contains methods for multiple 
detectors. 

This section describes how to change [Select Detector] from [Detector A] to [PDA]. 

1 Select and click [PDA] from the [Select Detector] list. 

The [Quant Browser] window changes to display the PDA detector.
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9.2.4 Check Spectra from [Chromatogram View]
Double-click the PDA chromatogram displayed in [Chromatogram View] to display the spectrum at that 
retention time. 

This section describes how to display a PDA spectrum. 

1 Select the [Chromatogram] tab in [Chromatogram View], and double-click the PDA 

chromatogram. 

[Calibration Curve/Spectrum View] changes to the [Spectrum] tab, and the PDA spectrum is displayed. 

To display chromatograms in all time ranges in [Chromatogram View], right-click on [Chromatogram View], 
and click [All Peaks] on the displayed menu. 
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9.3 Postrun Analysis of Multiple Data

This section describes how to edit [Quantitative Results View] and [Method View] and perform collective 
postrun analysis on multiple data. 

9.3.1 Edit the Compound Table
Compound Tables that were used for data acquisition can be edited in [Method View]. 

This section describes how to change [Conc. (1)] in the Compound Table. 

1 Click  (Edit Mode) in [Method View]. 

2 Click  (Full Size) in [Method View]. 

3 Click the [Compound] tab, select the desired compound, and change [Conc. (1)]. 

In this example, change the [Conc. (1)] setting from “10.000” to “5.000”. 
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4 Click  (Normal Size) and  (View Mode) in [Method View]. 

The calibration curve is recreated, the quantitative results are re-calculated, and [Quantitative Results 
View] is updated. 

• Right-click on [Method View] and click [Cancel Edit] to cancel method editing. 

• Select the columns that are displayed in the Compound Table in the [Table Style] sub-window. Right-
click on the Compound Table and click [Table Style] to open the [Table Style] sub-window. 

9.3.2 Edit [Quantitative Results View]
This section describes how to change the items displayed in the [Quantitative Results View]. 

Quantitative results are automatically re-calculated when each item is changed. 

• Right-click on [Quantitative Results View] and click [Remove] to delete a data file in [Quantitative Results 
View]. If deletion of a data file affects the calibration curve, all data files are re-calculated. 

• Click the  icon on the toolbar to filter the data files displayed in [Quantitative Results View] by 

individual sample type. 

• Right-click on [Quantitative Results View] and click [Full Path] to display the folder and file name at [Data 
Filename]. 

• Click the title of a column in the [Quantitative Results View] table to sort the data by [Data Filename], 
[Sample Name], [Sample ID], [Sample Type], [Level #], [Vial #], [Tray], and [Date Acquired].

• Select the columns that are displayed in the [Quantitative Results View] table in the [Table Style] sub-
window. Right-click on the [Quantitative Results View] table and click [Table Style] to open the [Table 
Style] sub-window. 

• Click [Save Method File] on the [File] menu to save changes made to the data and method files in 
[Quantitative Results View]. 
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 Change the Sample Type

Sample types that were set at data acquisition can be changed. 

1 Click the [Sample Type] cell of the sample to be changed, and select the sample type 

from the displayed list. 

If [Standard (Calc. Point)] is changed to another sample type, or another sample type is changed to 
[Standard (Calc. Point)], the calibration curve is re-created, and all data files are re-calculated. 

 Change the [Level#]

The level numbers that were set at data acquisition can be changed. 

1 Change the [Level#] of the desired sample. 
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 Disable Calibration Points

Calibration curve points can be disabled if the standard samples were not analyzed appropriately. 

1 Deselect [Cal. Point]. 

If a [Cal. Point] is disabled, the calibration curve is re-created. 

Calibration points for individual compounds can be enabled or disabled on the [Compound] tab in [Method 
View]. 

 Display Statistical Results

Statistical calculations can be applied to quantitative results and the results can be displayed in the 
[Quantitative Results View]. 

1 Right-click on [Quantitative Results View], and click [Statistical Result]. 

The statistical calculation results are added to the bottom of the table. 

Select the [Statistic] column in the [Quantitative Results View] table to target a data file for statistical 
calculation. [Statistic] is not displayed in [Quantitative Results View] by default. Right-click on the 
[Quantitative Results View] table and select [Table Style] to display the [Statistic] column. 
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9.3.3 Change Peak Integration Parameters
This section describes how to change the peak integration parameters and re-integrate the peak. 

1 Click  (Edit Mode) in [Method View]. 

2 Click the [Integration] tab, and set each parameter as required. 

In this example, change the [Slope] to “2000”. 

^ Reference
Refer to the Data Acquisition & Processing Theory Guide for details on peak integration. 

3 Click  (View Mode) in [Method View]. 

The results of peak integration and quantitation are displayed in the [Quantitative Results View]. 
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9.3.4 Calibration Curve Correction
During calibration curve creation, low-concentration samples may not be integrated properly. If the low-
concentration calibration point is disabled, a 3-point calibration curve becomes a 2-point calibration curve. 

This section describes how to manually integrate the data of a standard sample that could not be 
automatically integrated, and correct the calibration curve.

This section describes an example where peak integration failed, resulting in 2-point calibration curve. 

1 Click the  (Manual Peak Integration) icon on the [Main] assistant bar in the 

[Browser] program. 

The [Manual Integration Bar] is displayed. 

2 Click  (Insert Peak) on [Manual Integration Bar], and click the peak start point and 

then the peak end point. 
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The peak is detected, and the results are re-calculated. 
The 3-point calibration curve is re-created, and all data files are recalculated. 

To confirm the calibration curve information, right-click on the calibration curve on the [Calib Curve] tab in 
[Calibration Curve/Spectrum View], and click [Calibration Information] on the displayed menu. 
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9.3.5 Export the Quantitative Results
The contents of the [Quantitative Results View] table can be converted to the ASCII text format and saved 
to a file or copied to the Clipboard. 

1 Click [Export Quantitative Results] on the [File] menu. 

2 Select the desired parameters, and click [OK]. 

1 Select [Export to]. 

Enter the folder and file name to output files. 

2 Set [Items to Output]. 

Select [Items Displayed on the Screen] to output the items displayed in the [Quantitative Results 
View]. 

3 Set [IDs to Output]. 

Select [All IDs] to display the results of all compound IDs. 

Select [Designate IDs] and enter the ID numbers of the compounds to output. 

• Enter multiple ID numbers to output with a comma or space. (example: 1,3,8)

• Enter a range of continuous ID numbers with a hyphen. (example: 2-8)

4 Select a [Delimiter]. 

1

2

3

4



9  Quant Browser

280   Operators Guide

9.4 Print Quantitative Results

The [Quant Browser] window has a summary report function for collectively reporting multiple data. 

1 Click the  (Summary Report) icon on the [Quant Browser] assistant bar. 

2 Click the  (Print) icon on the [Report] assistant bar. 

An image of the table is printed for each compound. 

Example of Quant Browser printout
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10Data Browser

Use the [Data Browser] window to compare multiple data, compare the data of different detectors, set 
the layout of display data, perform peak integration of chromatograms, and print browser reports. 

This chapter describes how to collectively check multiple chromatograms and spectra. 

10.1 Open the [Data Browser] Window

Up to 64 chromatogram data, sample information, etc. can be displayed as a list in the [Data Browser] 
Window. 

1 Select the  icon on the [LabSolutions Main] icon bar, and double-click the  

icon. 

The [Browser] program opens. 

2 Click the  (Data Browser) icon on the [Main] assistant bar in the [Browser] program.



10  Data Browser

282   Operators Guide

3 Drag-and-drop the data files onto the [Data Browser] window from the [Data Explorer] 

sub-window. 

4 Select the Data Type parameters, and click [OK]. 

If the cell fixed function is not enabled, the [Select Data Type] sub-window is displayed. Refer to 
"10.3 Cell Fixed Function" P.292 for details on the cell fixed function. 

3

1

2
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1 Select the [Target Cell]. 

Select [Load Data to Current Cell] to display the selected data files in the cell where the files were 
dragged-and-dropped into from the [Data Explorer] sub-window. 

2 Set [Cell Location]. 

If [Open as New Cell] was selected at [Target Cell], set the direction that new cells will be added. 
Select [Rightward] to create columns and select [Downward] to create rows. 

3 Set [Data Type]. 

Select the multiple types of data to be displayed. 

The contents of the data files are displayed in the [Data Browser] window. 

 [Target Cell]

Cells are created according to the [Target Cell] setting in the [Select Data Type] sub-window. The following 
example assumes that a data file is already loaded in a layout whose [Row] and [Col] settings are set to “3” 
and “1”, respectively. 
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• [Load Data to Current Cell] is selected at [Target Cell] 
The [Chromatogram] cell contents are replaced by the data file that is dragged-and-dropped into that cell. In 
this example, the cell contents are overwritten with the [Chromatogram] and the [PDA Chromatogram]  are 
opened in the direction specified at [Cell Location]. Here, the [PDA Chromatogram] cell is overwritten to cells 
below the cell that the data file was dragged-and-dropped into. 

The cell order becomes [Chromatogram] and [PDA Chromatogram]. 

If multiple data files are dragged-and-dropped, only the data file initially selected in the [Data 
Explorer] sub-window is processed. 

Cell overwritten by drag-and-drop

Overwritten cell



 Operators Guide   285

10.1  Open the [Data Browser] Window

10

• [Open as New Cell] is selected
New cells are created to individually display the [Chromatogram]and [PDA Chromatogram]. 

If the [Row] or [Col] display reaches the maximum number of 8 each (8 rows, 8 columns), a new 
[Row] or [Col] is created to display the additional data files. 

The display does not change. 

The display does not change. 

Newly created cell

Newly created cell



10  Data Browser

286   Operators Guide

10.1.1 [Data Browser] Window Description
This section describes how to view and use the [Data Browser] window. 

• Files currently being edited in other windows are [Read Only] and cannot be edited. Close the file in the 
other window and open the file again to edit these files. 

• The arrangement of cells in the vertical direction is referred to as [Row], and the arrangement of cells in 
the horizontal direction is referred to as [Col]. 

• The maximum number of [Row] and [Col] is 8 each, which means that up to 64 cells can be displayed. 

No. Explanation

1 Displays the [Standard] and [Data Browser] toolbars. 

2 Displays the preset cell number. The cell number can be changed by clicking . If the cell fixed function is 

enabled,  is displayed. Refer to "10.3 Cell Fixed Function" P.292 for details on the cell fixed function. 

3 The focus bar is displayed in the currently selected cell.

4 Displays the content of the data file in the cell. 
Place the mouse pointer over the data file name display area to display the sample information. 

5 Clicking this button to expand the cell to the full screen view. 

6
When the focus pin is upright and green ( ), it is linked to other cells. 
Refer to "10.4.2 Link Content Between Cells" P.296 for details on linking cells. 

1

6

2

3

4

5
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10.2 Adjust Layouts

Adjust and re-arrange layouts so that the content of the currently displayed data can be easily compared. 

• Drag the boarder of the [Data Browser] cell with the mouse to resize the cell. The size of [Data Browser] is 
automatically determined so that it is split into equal lengths according to the number of displayed cells. 

• Use the cell connect function to partially create larger cells. Refer to "10.2.3 Connect Cells" P.291 for 
details on connecting cells. 

10.2.1Adjust Display Layouts
This section describes how to adjust the layout of display cells. 

1 Click the  (Layout Property) icon on the [Data Browser] assistant bar. 

The [Property] sub-window can also be opened by clicking [Property] on the [Layout] menu of the 
[Data Browser] window. 

2 Select the [Style] tab, set the number of rows and columns of the cell to display, and 

click [OK]. 

In this example, set [Row] and [Col] at [Cell Created] to “4” and “2”, respectively. 
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A 4  2 grid of cells is displayed. 

• Select [Scroll Mode] in the [Style] tab to display additional cells using the scroll bars. For example, 

when [Row] and [Col] at [Cell Displayed] are set to “3” and “2”, respectively, a 3  2 grid of cells is 

displayed in the sub-window and the remaining cells are displayed by scrolling with the scroll 
bars. 

• To delete rows or columns, either right-click a cell in the row or column to be deleted, select 

[Adjust Layout], and click [Delete Row] or [Delete Column], or click  (Delete Row) or  

(Delete Column) on the toolbar. Select the cell and click [Delete Cell] from the [Edit] menu to 
delete a single cell.

• Select [Save Layout File As] on the [Layout] menu to save cell layouts or the display information 
of data loaded to each cell. This data can be saved as layout files (file extension *.lyt). 
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10.2.2Change the Contents of Cells
The contents displayed in cells in the [Data Browser] window can be changed. 

This section describes how to change the cell content from [LC Chromatogram] to [Sample Information]. 

1 Click the desired cell. 

The focus bar is displayed. 

2 Click  (Sample Information) on the toolbar. 

The display data can also be changed by right-clicking on the cell, selecting [Change Data Type], 
and clicking [Sample Information]. 
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The display content of the cell is switched from a chromatogram to the sample information. 

• Click the  (Display Settings) icon on the [Data Browser] assistant bar to set the display mode and 

range of each cell. 

• Right-click on the source cell and click [Copy Cell] then right-click on the destination cell and click [Paste 
Cell] to copy the contents to other cells. This function is handy for displaying the contents of the same 
data file in multiple cells. 

• To swap the contents of the currently selected cell with the contents of another cell, drag the title (file 
name) of the selected cell and drop it on the target cell. 

• Right-click on the desired cell and click [Release Data from Cell] to delete the display contents of a cell. 
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10.2.3Connect Cells
Adjacent cells can be connected or disconnected. 

This section describes how to connect cells. 

1 Select the cells to connect with the [Ctrl] key held down. 

The focus bar is displayed on the multiple cells. 

2 Right-click on one of the selected cells and click [Connect Cell]. 

The cells are connected. 

• When cells are connected, data which is open in secondary cells is closed.

• Right-click on the connected cell and click [Disconnect Cell] to disconnect cell connections. 

• Select cells to be connected so that the shape of the resulting cell is a rectangle.
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10.3 Cell Fixed Function

Use the cell fixed function to efficiently compare different data files. For example, compare the peaks of the 
control sample and target sample. 

When the cell fixed function is used, the cell numbers are displayed in each cell. The contents of the same 
data file is displayed in cells of the same cell number. 

^ Reference
"10.4.1 Load a Data File in Multiple Cells" P.293

"10.4.3 Peak Integration on Chromatograms" P.298

10.3.1Use the Cell Fixed Function
This section describes how to turn the cell fixed function on. 

1 Click the  (Cell Fixed) icon on the toolbar. 

 (Cell Fixed) is selected, and cell number ( ) is displayed in the cell. 

• Click the  (Cell Fixed) icon on the toolbar again, to turn the cell fixed function off.

• The cell fixed function can also be switched on and off by clicking [Cell Fixed] on the [Edit] menu 
in the [Data Browser] window. 



 Operators Guide   293

10.4  Compare Data

10

10.4 Compare Data

10.4.1Load a Data File in Multiple Cells
This section describes how to use the cell fixed function to display the chromatograms and PDA 
chromatograms of data files 1 and 2.

1 Determine the layout and cell type. 

This example uses a 2 row  2 column layout to display a chromatogram in the 1st row and a PDA 

chromatogram in the 2nd row. 

^ Reference
Refer to "10.2.1 Adjust Display Layouts" P.287 for details on changing layouts, and "10.2.2 Change 
the Contents of Cells" P.289 for changing cell type. 

2 Click the  (Cell Fixed) icon on the toolbar. 

 (Cell Fixed) is selected and cell number ( ) is displayed in the cell display area. 
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3 Click the cell number ( ) that is to be changed, and set the cell number. 

In this example, set the cells in the 1st column to “1” and the cells in the second column to “2”. 

4 Drag-and-drop data file 1 onto the number 1 chromatogram cell from the [Data Explorer] 

sub-window.
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The contents of the data file are displayed in the number 1 cells. 

5 Drag-and-drop data file 2 onto the number 2 chromatogram cell from the [Data Explorer] 

sub-window. 
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The contents of the data file are displayed in the number 2 cells. 

10.4.2Link Content Between Cells

An upright focus pin ( ) indicates that the cell is linked to other cells. 

For example, if the [PDA Chromatogram] and [PDA Spectrum] cell are linked and the chromatogram is 
double-clicked, the displayed spectrum in the [PDA Spectrum] cell is updated. 

This section describes how to link the [PDA Spectrum] cell display with the [PDA Chromatogram] cell. 

1 Ensure that the focus pin is upright ( ) on the [PDA Chromatogram] and [PDA 

Spectrum] cells. 

If the focus pin is down ( ), click  to change it to the upright state ( ). 
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2 Double-click the desired time position in the [PDA Chromatogram] cell. 

The spectrum at that time is displayed in the [PDA Spectrum] cell. 

• Depending on the type of cell, the display may be altered to display other information. 

• The default state of the focus pin in the cell is upright. 

•  Click an upright focus pin to disable cell links. 
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10.4.3Peak Integration on Chromatograms
This section describes how to perform peak integration on [PDA Chromatogram] in the [Data Browser] 
window. 

 Perform Peak Integration

1 Open the [PDA Chromatogram] to be integrated. 

2 Click [PDA Data Processing Parameters] on the [Method] menu. 

3 Click the [Integration] tab, set each of the integration parameters, and click [OK]. 

1 Select the channel to be integrated. In this example, select [Extracted Chromatogram]. 

2 Change the [Slope] setting to “1000”. 

^ Reference
Refer to the Data Acquisition & Processing Theory Guide for details on each of the parameters. 

1

2
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If automatic peak integration is not successful, try manual peak integration. Right-click on the PDA 
chromatogram and click [Manual Integration Bar] to display the [Manual Integration Bar]. The 
[Manual Integration Bar] cannot be displayed if an overlaid PDA chromatogram is displayed. Select 
[Stack] or [Single] to display the [Manual Integration Bar]. Refer to Help for details on the [Manual 
Integration Bar]

Peak integration is performed on the extracted chromatogram and the results are displayed. 
The baseline and peak top comment are displayed on the PDA chromatogram. 
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 Examine the Peak Integration Results

The results of peak integration can be examined in the [PDA Peak Table] cell. 

This section describes how to change the displayed cell to the [PDA Peak Table] cell to examine the peak 
integration results of the extracted PDA chromatogram. 

1 Select the cell to be changed to the [PDA Peak Table] and click  (PDA Peak Table) on 

the toolbar. 

Click the cell to display the focus bar in that cell. Click  (PDA Peak Table) on the toolbar to change 

the cell to the [PDA Peak Table] cell. 
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2 Click the cell number and select the cell number in the [Select Cell Number] sub-

window.

If the cell number is not displayed, refer to "10.3.1 Use the Cell Fixed Function" P.292 to turn the cell fixed 
function off.

3 Click the [Extracted] tab. 

The peak integration results of the extracted PDA chromatogram are displayed. 

The peak integration results of chromatograms are displayed in the [Peak Table] cell. 
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 Link Cells to Check Peak Integration Results

This section describes how to link the [PDA Chromatogram], [PDA Peak Table] and [PDA Spectrum] cells 
to check peak integration results. 

1 Position the [PDA Chromatogram], [PDA Peak Table] and [PDA Spectrum] cells as 

follows. 

^ Reference
Refer to "10.2 Adjust Layouts" P.287 for details.
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2 Ensure that the focus pins of the cells are in the upright ( ) position. 

If the focus pin is down ( ), click  to change it to the upright state ( ). 

3 Click the [PDA Chromatogram] cell. 

The focus bar is displayed on the [PDA Chromatogram] cell. 

4 Click [PDA Data Processing Parameters] on the [Method] menu. 
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5 Enter the parameters in the [Data Processing Parameters] sub-window, and click [OK]. 

Peak integration is performed when [OK] is clicked, even if no changes were made in the [Data 
Processing Parameters] sub-window. 

6 After peak integration, click a row on [PDA Peak Table]. 

The information for that peak is displayed in the [PDA Chromatogram] and [PDA Spectrum] cells.
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10.5 Print a Browser Report

The [Data Browser] window has functions for printing all of the cells or only selected cells. Size, color and 
other information in the chromatogram and spectrum cells also are reflected in the printout.

10.5.1Print All of the Cells
An image of all of the cells currently displayed in the [Data Browser] window can be printed. 

This section describes how to print all of the cells. 

1 Select [Print Image for All Cells] on the [File] menu, and click [Print]. 

An image of all of the cells is printed in the preset report layout locations. 
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10.5.2Print Selected Cells
An image of the cells currently selected in the [Data Browser] window can be printed.

This section describes how to print the [PDA Chromatogram] cell. 

1 Right-click on the desired cell, select [Print Graph], and click [Print]. 

The right-click menu changes to [Print Table] or [Print Sample Information] when the cell content is a 
table or sample information, respectively. 

The image of the selected cell is printed. 
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11Data Comparison

This chapter describes how to overlay multiple data overlaid and perform calculations in the [Data 
Comparison] window. Up to 16 chromatograms can be overlaid in the [Data Comparison] window for 
comparison. 

Comparison calculations can be performed for the data of any currently specified chromatograms.

11.1 Open the [Data Comparison] Window

This section describes how to overlay the chromatograms of selected data in the [Data Comparison] 
window.

1 Click the  (Data Comparison) icon on the assistant bar in the [Postrun Analysis] 

program. 
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11.2 [Data Comparison] Window Description

This section describes how to view and use the [Data Comparison] window. 

• Right-click on the chromatogram and select [Base Shift] to shift the displayed chromatograms by an equal 
interval.

• Right-click on the chromatogram and select [Copy] to paste the chromatograms into other applications as 
image files. 

• Select [Close] on the [File] menu, then select [All Data] to close all of the open data. 

No. Explanation

1 Displays the [Standard] and [Data Comparison] toolbars.

2 Displays the information for the displayed data file.
Right-click on the data file information and click [Close] to close the data file.

3 Use these buttons to expand, reduce or moves a selected chromatogram to the top, bottom, left or right. 

• To move a chromatogram up/down or left/right, click  (Move Up/Down) or  (Move Left/Right) and 

drag the chromatogram to the move destination position. 

• Click  (Base Point) to expand or reduce a chromatogram and the click the position of the base point on 

the chromatogram to determine that point. Next, click  (Zoom Up/Down) or  (Zoom Left/Right), and 

drag the chromatogram to the expand/reduce destination point. The chromatogram is expanded or reduced 
to that point. 

4 Displays the chromatogram of the open data file as [Full Chromatogram] or [Zoomed Chromatogram]. Three 
view methods are available, [Overlay], [Stack] and [Base Shift]. 

5 Displays the Peak Table of the selected chromatogram. 

6 Displays calculation formulas for operations performed between the data of selected chromatograms.

Toolbar1 2

5

3

4

6
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11.3 Overlay Multiple Data

This section describes how to display the chromatograms of selected data overlaid in the [Data 
Comparison] window. 

1 Select the data file to overlay in the [Data Explorer] sub-window, and drag-and-drop that 

file onto the [Data Comparison] window. 

The chromatogram and Peak Table of the data files are displayed in the [Data Comparison] window. 

• A sub-window opens for channel selection when displaying a data file obtained by data 
acquisition on multiple channels. Select the checkbox of the channel to display. 

• Data files obtained by a PDA detector cannot be displayed overlaid in the [Data Comparison] 
window. 
To display in the [Data Comparison] window, select [Export Data] on the [File] menu in the [PDA 
Data Analysis] window, click [Export Chromatogram to Data File] and extract the multi 
chromatogram. 

• Click the  (Stack) icon on the [Comparison] assistant bar to display chromatograms in a 

stacked format. 
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11.4 Perform Calculations on Chromatograms

Specify any displayed chromatograms to perform arithmetic calculations (addition/subtraction/
multiplication/division) on the data.

This section describes how to perform arithmetic operations on 2 chromatograms.

1 Right-click on [Chromatogram View], and click [Show/Hide Data]. 

2 Select [Operation] to perform the arithmetic operation on the data, and click [OK]. 

Arithmetic operation can only be executed between 2 chromatograms. 
An error occurs if 3 or more chromatograms are selected. 

3 Click the desired arithmetic operation ( ) on the toolbar. 

The arithmetic operation is performed on the data of the selected chromatograms, and an additional 
green chromatogram is displayed. 
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The calculation formula can be checked by . 

• Click  (Reverse Data Order) on the toolbar to change  to 

 so that the calculation data is reversed. 

• Right-click on [Chromatogram View], and select [Save Processed Data] to save the calculation 
result.
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12AART

12.1 AART (Automatic Adjustment of Retention Time)

If the column is cut to change the length or if a column from a different lot is used, the retention times 
in the measurement data may change. In this case, the times set in the instrument parameters and 
compound table must be modified so that the target compounds can be measured and identified 
reliably. 

AART(Automatic Adjustment of Retention Time) allows you to modify all retention times based on 
retention indexes of target compounds.

Using the AART incorporated in this software makes it easier to modify the set times and helps 
reduce time-consuming work, even when analyzing various types of compounds in a batch.

This operation manual explains how to use the AART, which is based on the retention index.

<Retention Index>

The retention index is calculated using the relationship between the n-alkanes retention time and the 
target compounds retention time. Usually, the elution position of a compound in a chromatogram is 
expressed in terms of the retention time. The retention time is, however, greatly affected by the type of 
column, the temperature, and the flow rate of the carrier gas. Expressing the retention time of compounds 
in terms of a value (the retention index) that correlates with the retention times of n-alkanes with different 
carbon numbers makes it possible to express the elution position as a value that remains constant even if 
the column length and internal diameter change. AART corrects the retention time using this retention 
index.

12.2 Before Using AART

12.2.1Add the [AART] icon on the [Data Analysis] assistant bar
To use AART, it is handy to add the [AART] icon on the [Data Analysis] assistant bar. This section 
describes how to add the [AART] icon on the [Data Analysis] assistant bar. 

1 Select [Customization] on the [Tools] menu in the [Data Analysis] window, and click 

[Customization Settings].
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2 Click the [Assistant Bar] tab, add the [AART] icon to the [Display Icons] list, and click 

[OK].

1 Select [Data Analysis] in the [Windows] list. 

2 Select the [AART] icon in the [Hide Icons] list.

3 Click [Add].

The [AART] icon is added to the [Display Icons] list.

The [AART] icon is added to the [Data Analysis] assistant bar.

To change the display order of icons on the assistant bar, select the icon to move at [Display Icons], 
and click [Up] or [Down]. 

1 32
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12.2.2Display the [Retention Index] column in the Compound Table
When retention index is set in a data file or a method file, load the file in [Data Analysis] or [Calibration 
Curve] window and set [Table Style] so that the [Compound Table] can display the [Retention Index] 
column.

1 Click the [Compound] tab.

2 Right-click on the compound table, and click [Table Style].

3 Add the [Retention Index] column to the compound table in the [Table Style] sub-

window, and click [OK]. 

1 Select [Retention Index] in the [Hide Items] list.

2 Click [Add].

The [Retention Index] item is added to [Display Items] list.

Change the display order of items in the compound table, by selecting the item in the [Display Items] 
list and then clicking [Up] or [Down].

2

1
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12.3 How to run AART

 The procedure for modifying retention times using retention indexes consists of the following steps. 
(Refer to the appropriate chapter for details.)

 Setting up a method file applicable to AART

To perform AART, it is necessary to set retention index of each compound in a method file. Register the 
retention indexes in the method file's compound table beforehand. 

Start

"Identify Target Compounds" 
(Refer to 12.5.3)

"Measure Target Compounds" 
(Refer to 12.5.1)

"Create a Compound Table for Target Compounds" 
(Refer to 12.5.2)

"Measure Index Standards" 
(Refer to 12.5.4, 12.5.5)

"Create a Compound Table for Index Standards" 
(Refer to 12.5.6)

"Set Retention Indexes for Target Compounds" 
(Refer to 12.5.7)

Method is ready

Procedure for creating a new method file

Procedure for a pre-existing compound table
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 Modifying Times by AART

If the instrument environment changes (e.g., because of changes in the column information), change the 
set times in the method file.

12.4 Index Standards

Measurement of index standards is required to perform AART. 

n-alkanes are among the easiest-to-use compounds. Prepare a mixed solution of n-alkanes with the 
appropriate range of carbon numbers depending on the measurement parameters (especially the oven 
heating parameter) of the target compound. 

Restek Corporation

n-Alkane 

Cat.No.560295, Custom Retention Time Index Standard (Hexane solutions), 100ug/mL, 1mL, C7-C33 (n-
alkane), Concentration C15, C30-C33 in 200ug/mL, Others in 100ug/mL

12.5 Set up a Method File Applicable to AART

To perform AART, it is necessary to set retention index of each compound in a method file. Register the 
retention indexes in the method file's compound table beforehand.

Files used here are the method file (AART_30m.gcm) and data file (AART_30m.gcd) for the target 
compounds, and the method file (alkane_30m.gcm) and data file (alkane_30m.gcd) for the index 
standards. This section describes an example using a 30 m column.

12.5.1Measure Target Compounds
Prepare standard sample of target compounds and perform measurement with GC.

Start

"Modify Set Times in a Method File by AART" 
 (Refer to 12.6.3)

"Measure Index Standards"
 (Refer to 12.6.1)

"Identify Index Standards" 
 (Refer to12.6.2)

Confirming and Adjusting Set Times
  "Measure Target Compounds" (Refer to 12.7.1) 
  "Confirm and Adjust Retention Times in the Compound Table" (Refer to12.7.2)

Method has been modified.
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(Exsample: Method file AART_30m.gcm, Data file AART_30m.gcd)

 

• It is recommended that " Linear Velocity " is used as the GC control mode to perform AART.

• The actual column length must be entered in order to more accurately estimate the retention time. In 
particular, enter the value obtained for column length if the offset between the adjusted results and the 
actual retention time is significant, and if using a column that has been cut in the past. The column length 
can be calculated by subtracting the cut length from 30 m, or by counting the number of column coils and 
multiplying 3.14 x (column coil diameter) x (number of column coils).

^ Reference
Refer to "3.4.1 Execute Single Run" P.52 for details on single run.

12.5.2Create a Compound Table for Target Compounds
Create a Compound Table for target compounds using chromatograms (AART_30m.gcd) measured in 

"12.5.1 Measure Target Compounds". Retention Indexes are set in "12.5.7 Set Retention Indexes for 
Target Compounds".

^ Reference
Refer to "6.5 Compound Table" P.163 for details on creating the compound table.

12.5.3 Identify Target Compounds
Load the data file (AART_30m.gcd) in the [Data Analysis] window, perform data processing with the 
method file (AART_30m.gcm), and verify that the peak has been correctly identified.

1 Drag-and-drop the the data file (AART_30m.gcd) in measured "12.5.1 Measure Target 

Compounds" onto the [Data Analysis] window from the [Data Explorer] sub-window. 

The data file (AART_30m.gcd) for the target compounds is opened.

2 Click [Load Method Parameters] on the [File] menu.
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3 Select the method file (AART_30m.gcm) saved in "12.5.2 Create a Compound Table for 

Target Compounds", and click [Open].

4 Select [Data Processing Parameters], click [OK].

The compound table saved in "12.5.2 Create a Compound Table for Target Compounds" is loaded.
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5 Check whether or not the target compounds registered in the compound table have 

been identified correctly.

If they have not, change the retention time on the [Compound] tab in [Method View] to identify them.

6 If the compound table have been changed in step 5, save the method file.

1 Click the  (Apply to Method) icon on the [Data Analysis] assistant bar. 

2 Select the method file (AART_30m.gcm), and click [Save].
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3 Select [Data Processing Parameters], and click [OK].

The compound table are saved to the method file (AART_30m.gcm).

12.5.4  Create a Method File for Index Standards
Creating a method file for measuring index standards (e.g. n-alkanes), which are used to calculate 
retention indexes.

1 Select [Open Method File] on the [File] menu in the [Data Acquisition] window.

2 Select the method file (AART_30m.gcm)  for measuring index standards, and click 

[Open].

The method file (AART_30m.gcm) for measuring index standards is opened.
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3 Click [Save Method File As] on the [File] menu.

4 Enter the file name, and click [Save].

The file is saved as the method file (alkane_30m.gcm) for measuring index standards.

Use the same parameters for measuring target compounds as they are to perform GC 
measurements.

5 Click [Data Processing Parameters] on the [Method] menu.

6 Click the [Compound] tab in the[Data Processing Parameters] sub-window.
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7 Delete the settings of the compound table, click [OK].

8 Click [Save Method File] on the [Method] menu.

The method file (alkane_30m.gcm) for measuring index standards is saved.

12.5.5  Measure Index Standards
Prepare the index standards (e.g., n-alkane samples) used to calculate the retention indexes, and perform 
single run using method files (alkane_30m.gcm) that were created in "12.5.4 Create a Method File for 
Index Standards".

(Example: Data file alkane_30m.gcd)

^ Reference
Refer to "3.4.1 Execute Single Run" P.52 for details on single run.
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12.5.6Create a Compound Table for Index Standards
In the [Data Analysis] window, create a compound table for index standards and save it in a method file 
(alkane_30m.gcm).

1 Drag-and-drop the data file (alkane_30m.gcd) measured in "12.5.5 Measure Index 

Standards" onto the [Data Analysis] window from the [Data Explorer] sub-window. 

The data file (alkane_30m.gcd) for the index standards is opened.

2 Click  (Edit Mode) in [Method View].

The mode changes to the edit mode.
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3 Referring to "6.5 Compound Table", create the Compound Table for the index standards.

4 Click [Compound] tab, and enter the Retention Index for the index standards.

^ Reference
Refer to "12.2.2 Display the [Retention Index] column in the Compound Table" P.315 if [Retention 
Index] column is not displayed in the compound table. 

The retention index of n-alkane is defined as follows.

  Retention Index = carbon number x 100

  Example:

    Retention Index of Hexa (C16H34) = 16 x 100 = 1600

5 Click  (View Mode) in [Method View].

Postrun analysis is performed on the data.

6 Click the  (Apply to Method) icon on the [Data Analysis] assistant bar.
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7 Select the method file (alkane_30m.gcm) created in "12.5.6 Create a Compound Table for 

Index Standards", and click [Save].

8 Select [Data Processing Parameters], and click [OK].

The compound table are saved to the method file (alkane_30m.gcm).
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12.5.7Set Retention Indexes for Target Compounds
The retention indexes in the compound table can be entered automatically using the data file for index 
standards.

This section describes two methods: how to set the retention index for an already created Compound Table 
and how to set the retention index during the creation of a Compound Table.

 Set Retention Indexes for a Pre-existing Compound Table as One Batch

1 Drag-and-drop the data file (AART_30m.gcd) saved in "12.5.3 Identify Target 

Compounds" onto the [Data Analysis] window from the [Data Explorer] sub-window. 

The data file (AART_30m.gcd) for the target compounds is opened.

2 Click  (Edit Mode) in [Method View].

The mode changes to the edit mode.
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3 Click the [Retention Index] tab in [Method View].

Use , if [Retention Index] tab is not displayed.

4 Click [Load from Data File].
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5 Select the data file (alkane_30m.gcd) saved in "12.5.6 Create a Compound Table for 

Index Standards", and click [Open].

The compound names, retention times and indexes are set in the [Index Table of Standards] table. 

The compound names set in the compound table for the index standards' measurement data are set 
in the [Name] column and the identified retention times in the compound result table are set in the 
[Ret. Time] column. The compounds not identified in the compound result table are not displayed in 
the [Index Table of Standards].

6 Edit [Index Table of Standard] as required.

All compounds needs retention indexes.

7 Click the [Compound] tab.
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8 Right-click on the compound table, and click [Update Retention Index].

Retention indexes for each compound is calculated and displayed in the [Retention Index] column.

^ Reference
Refer to "12.2.2 Display the [Retention Index] column in the Compound Table" P.315 if [Retention Index] 
column is not displayed in the compound table. 

9 Click  (View Mode) in [Method View].

10 Click the  (Save) button on the toolbar.

The compound table are saved to the data file (AART_30m.gcd).

11 Click the  (Apply to Method) icon on the [Data Analysis] assistant bar.
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12 Select the method file (AART_30m.gcm), and click [Save].

13 Select [Data Processing Parameters], and click [OK].

The compound table are saved to the method file (AART_30m.gcm).

 Create a New Compound Table

1 Drag-and-drop the data file (AART_30m.gcd) measured in "12.5.1 Measure Target 

Compounds" onto the [Data Analysis] window from the [Data Explorer] sub-window. 

The data file (AART_30m.gcd) for target compounds is opened.
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2 Click  (Edit Mode) in [Method View].

The mode changes to the edit mode.

3 Click the [Retention Index] tab in [Method View].

Use , if [Retention Index] tab is not displayed.
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4 Click [Load from Data File].

5 Select the data file (alkane_30m.gcd) saved in "12.5.6 Create a Compound Table for 

Index Standards", and click [Open].

The compound names, retention times and indexes are set in the [Index Table of Standards] table.

The compound names set in the compound table for the index standards' measurement data are set

in the [Name] column and the identified retention times in the compound result table are set in the

[Ret. Time] column. The compounds not identified in the compound result table are not displayed in

the [Index Table of Standards].
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6 Edit [Index Table of Standard] as required.

All compounds needs retention indexes.

7 Click the [Compound] tab.

8 Click the  (Wizard) icon on the [Data Analysis] assistant bar.

9 Referring to "6.5.1 Compound Table Wizard", create the Compound Table for the target 

compounds. 

[Retention Index] displayed in [Compound Table Wizard 5/5] sub-window are calculated using the 
retention index parameters and the retention times in the compound table.

Refer to [Data Acquisition & Processing Theory Guide] regarding the method for calculating the 
retention indexes from the retention index parameters and retention times.
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10 Proceed to [Compound Table Wizard 5/5] sub-window and click [Finish]. 

The compound table is created.

11 Click the  (Save) button on the toolbar.

The compound table are saved to the data file (AART_30m.gcd).

12 Click the  (Apply to Method) icon on the [Data Analysis] assistant bar.

13 Select the method file (AART_30m.gcm), and click [Save].



12  AART

336   Operators Guide

14 Select [Data Processing Parameters], and click [OK].

The compound table are saved to the method file (AART_30m.gcm).

12.6 Modify Times by AART

If the instrument environment changes (e.g., because of changes in the column information), the change of 
the elution time makes it difficult to identify compounds. The AART corrects the retention times in a 
compound table for the target compound's method file, which uses the retention times for index standards.

12.6.1Measure Index Standards
Prepare the index standards used to calculate the retention indexes, and perform single run using method 
files (alkane_30m.gcm) that were created in "12.5.4 Create a Method File for Index Standards".

(Example: Data file alkane_24m.gcd)

^ Reference
Refer to "3.4.1 Execute Single Run" P.52 for details on single run.
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12.6.2 Identify Index Standards
In the [Data Analysis] window, perform identification processing for the index standards using the 
compound table. Identified information is used for AART in "12.6.3 Modify Set Times in a Method File by 
AART".

1 Drag-and-drop the data file (alkane_24m.gcd) measured in "12.5.5 Measure Index 

Standards" onto the [Data Analysis] window from the [Data Explorer] sub-window. 

The data file (alkane_24m.gcd) for the index standards is opened.

2 Check whether of not the index standards registered in the Compound Table have been 

identified correctly.

If they have not, change the retention time on the [Compound] tab in [Method View] to identify them.

Due to differences in the column length, the retention time for index standards deviates from the 
settings in the Compound Table. Perform identification with care not to confuse the index standards 
for compounds with different carbon numbers.
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3 Click the  (Save) button on the toolbar.

The data file (alkane_24m.gcd) is saved.

This data file is used as reference information when modifying the retention times as described in "12.6.3 
Modify Set Times in a Method File by AART".

12.6.3Modify Set Times in a Method File by AART
After conducting the steps in "12.6.2 Identify Index Standards", conduct the operations below after loading 
the index standards measurement data into the [Data Analysis] window.

1 With the data file for the index standards open, click the [AART] icon on the [Data 

Analysis] assistant bar.

Click [Automatic Adjustment of Retention Time [AART]] on the [Edit] menu if the [AART] icon is not 
displayed on the assistant bar. 

^ Reference
Refer to "12.2.1 Add the [AART] icon on the [Data Analysis] assistant bar" if the [AART] icon is not 
displayed on the assistant bar. 
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2 Select the method file to correct the preset time for, and click [Save].

Times modified by AART are directly set in the method file selected here. To retain the original 
method file, copy the method file using Windows Explorer or by some other method. In this example, 
AART_30m.gcm is copied to create AART_24m.gcm.

3 Check the settings, and click [Next].

If there are compounds whose retention indexes are 0 or that are not required to perform AART for 
the method file, click to clear the [Proc.] columns for these compounds. Click [Next].

Identification results of index standards are displayed on the [Automatic Adjustment of Retention 
Time [AART] 1/2] sub-window.
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The retention times modified using the retention indexes of compound table in the method file selected in 
step 2 and the identification results for the index standard data are displayed in the [Automatic Adjustment 
of Retention Time [AART] 2/2] sub-window.

4 Check the settings, and click [Finish].

^ Reference
Refer to [Data Acquisition & Processing Theory Guide] for details on the retention time calculation 
method.

This completes the procedure for modifying the set times in the method file's compound table.

• Linear retention indices available for a ramped temperature measurement are used in the 
Automatic Adjustment of Retention Time (AART). The accuracy of the adjusted time may be lower 
under the measurement with a fixed temperature step or multi-ramped steps than a single ramped 
one.

• The modified retention times obtained here are only reference values. Before using them in actual 
measurement or analysis, confirm the set times with reference to "12.7 Confirm and Adjust Seting 
Times".
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12.7 Confirm and Adjust Seting Times

The set times in the compound table modified by AART are only reference values. Before using them in 
actual measurement or analysis, confirm and adjust the set times with reference to a data file for target 
compounds.

12.7.1Measure Target Compounds
Measure target compounds to confirm the set times modified by AART. The data file obtained here is used 
for confirmation and adjustment in "12.7.2 Confirm and Adjust Retention Times in the Compound Table".

(Example: Method file AART_24m.gcm, Data file AART_24m.gcd)

^ Reference
Refer to "3.4.1 Execute Single Run" P.52 for details on single run.

12.7.2Confirm and Adjust Retention Times in the Compound Table
Perform identification processing for the target compounds using the compound table. The identified times 
are reflected in the compound table of the method file for measuring target compounds.

1 Drag-and-drop the data file (AART_24m.gcd) measured in "12.7.1 Measure Target 

Compounds" onto the [Data Analysis] window from the [Data Explorer] sub-window. 

The data file (AART_24m.gcd) for the target compounds is opened.
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2 Check whether or not the target compounds registered in the compound table have 

been identified correctly.

If they have not, change the retention time on the [Compound] tab in [Method View] to identify them.

3 Click the  (Apply to Method) icon on the [Data Analysis] assistant bar.

4 Select the method file (AART_24m.gcm), and click [Save].
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5 Select [Data Processing Parameters], and click [OK].

The compound table are saved to the method file (AART_24m.gcm).
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13Appendices

This chapter describes how to locate operation details on the Help menu or in the online manuals. 
Use this information in the event that you are having problems with software operation, and the basic 
operations in software screens. 

13.1 Operation Problems

This software provides the Help menu and online manuals. Use the Help menu and online manuals to 
learn more about software operations or the terms displayed on screen. 

This section describes how to use the Help menu and online manuals. 

13.1.1Help
Use the following procedures to open the Help menu. 

Type of Operation Operation Procedures

[Help] Click [Help] on the sub-window. 
The section Help for the current sub-window is displayed. 

 (Help) Click  (Help) on the toolbar. 

[Help] menu Click [Contents] on the [Help] menu. 

[F1] key Press the [F1] key on your keyboard. To locate the details relating to the current 
sub-window.
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 Keyword Search

If the term or parameter is unknown, enter a keyword to perform a search, and a list of topics that match 
the keyword is displayed. This allows for review of Help topics that pertain to the terms and parameters. 

1 Open Help.

2 Click the [Index] tab, and execute the search.

1 Enter the keyword to search for, and press the [Enter] key on your keyboard. 

Topics matching the keyword are displayed in an alphabetical order. 

2 Click the topic. 

3 Click [Display]. 

The contents of the selected topic is displayed. 

• The [Topic Found] sub-window opens if there are multiple matching keywords. Select the 
desired keyword in the list in this sub-window, and click [Display]. 

• Use the [Search] tab in the Help window to search the entire text of the Help topic for the 
keyword terms.

1

2

3
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13.1.2Online Manuals
The “Operators Guide”, “System Users Guide”, “Data Acquisition & Processing Theory Guide” and “Getting 
Start Guide“ online manuals are installed in PDF format when this software is installed. 

This section describes how to display online manuals. 

1 Click the  icon in the [LabSolutions Main] window.
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2 Click the icon of the desired instruction manual.

This opens Adobe Acrobat Reader and the instruction manual.

• The “Operators Guide” online manual can also be opened by clicking [Online Manual] on the 
[Help] menu in the window. 

• Adobe Reader is required to open online manuals. 

• Visit Adobe's website for details on Adobe Reader. 

No. Explanation

1 Go directly to the desired page by clicking the hierarchically structured bookmarks (table of contents). 

2 Search for desired terms. 

3 Go directly to a related page by clicking the references or the terms in blue. 

1

3

2
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13.2 Common Screen Operations

The windows, assistant bars, toolbars and other graphical user interface elements in this software can be 
customized.

13.2.1Resize the View
Many of the windows such as [Data Acquisition] and [Data Analysis] are comprised of sections (views) that 
are separated by dividers. Drag the dividers to resize the views to make on-screen operations more 
efficient. 

 Resize Icons

To resize a view, click  (Full Size) in each view. This changes the normal size display to its full size. 

Alternatively, click  (Normal Size) to return the full size display to its normal size. 

[Results View] and [Method View] in the [Data Analysis] window contain a  (Wide Size) icon for displaying 

views at the full horizontal size and a  (Normal Size) icon to return the wide size view to the normal size.

 Drag the Dividers to Resize Views

Views can be resized as desired by dragging the dividers of each view. 

Full sizeNormal size
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13.2.2Customize Windows
This software allows a customized view layout for a specific operation to be saved. 

For example, since the [Data Analysis] and [PDA Data Analysis] windows have many views, data can be 
more easily analyzed by saving various layouts with unwanted views hidden. 

This section describes the procedure for saving the [Data Analysis] window layouts. 

 Save Layouts

1 Click [Save Layout] on the [Layout] menu. 

2 Enter the name of the layout, and click [OK]. 

The layout of the currently open window is saved. 
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 Open a Saved Layout

1 Click [Select Layout] on the [Layout] menu. 

2 Select the name of the layout, and click [Select]. 

The window is opened using the selected layout. 
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13.2.3Customize Assistant Bars
This software allows the addition or deletion of icons displayed on assistant bars to customize assistant 
bars for specific operations. 

This section describes how to delete the [Batch Editor] icon from the [Main] assistant bar in the [Realtime 
Analysis] program. 

1 Open the [Data Acquisition] window. 

2 Select [Customization] on the [Tools] menu, and click [Customization Settings]. 

3 Click the [Assistant Bar] tab, select the icon to delete, and then click [OK]. 

1 Select [Main] at [Windows]. 

2 Select the [Batch Editor] icon at [Display Icons]. 

3 Click [Remove] to move the [Batch Editor] icon to [Hide Icons]. 

The [Batch Editor] icon is no longer displayed on the [Main] assistant bar in [Realtime Analysis].

• It is only possible to customize the icons for the functions used in each window of the [Realtime 
Analysis], [Postrun Analysis] and [Browser] programs. Customize windows by editing [Available] 
on the [Application Windows] tab. 

1 3 2
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• Select the icon at [Display Icons], and click [Up] or [Down] to change the display order of icons on 
the assistant bar. 

13.2.4Customize Toolbars
This software allows the addition or deletion of icons displayed on toolbars to customize the toolbars for 
specific operations. 

This section describes how to add the [Open Reference Data File] icon to the [Data Acquisition] toolbar.

1 Open the [Data Acquisition] window. 

2 Select [Customization] on the [Tools] menu, and click [Toolbar Customization Settings]. 

3 Click the [Command] tab, customize the [Data Acquisition] toolbar, and then click 

[Close]. 

1 Select [Data Acquisition] at [Categories]. 

2 Drag-and-drop  (Open Reference Data File) onto the [Data Acquisition] toolbar. 

The button is added to the [Data Acquisition] toolbar. 

• Deselect the check mark of a displayed toolbar on the [Toolbar] tab to hide a toolbar.

• Drag-and-drop a button on the toolbar to an area outside of the toolbar to delete the button from 
the toolbar.

21
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13.2.5Copy Sub-Windows to the Clipboard
Chromatograms and Calculation Results Tables displayed in the sub-windows of this software can be 
copied to the Clipboard and pasted to other application software. 

This section describes how to copy chromatograms and Calculation Results Tables displayed in the [Data 
Analysis] window. 

 Copy Chromatograms to the Clipboard

Right-click on the graph in [Chromatogram View], and click [Copy]. The currently displayed content of the 
chromatogram is copied to the Clipboard. 

The chromatogram is displayed as follows when it is pasted from the Clipboard to other applications (In this 
example Paint is used). 
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 Copy Results Tables to the Clipboard

Select and right-click on the cell or row of a Compound Table or Peak Table, and click [Copy]. The currently 
displayed table information is copied to the Clipboard. 

Click [Copy Entire Table] to copy all of the information included in the table (displayed and hidden).
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13.3 Common File Operations

The contents of the files displayed in the [Data Explorer] sub-window can be displayed by double-clicking 
the files in the [Data Explorer] sub-window or dragging-and-dropping them onto each window. 

This section describes how to open files in this software. 

13.3.1Double-Click Files in the [Data Explorer] Sub-window
This section describes the action when a file in the [Data Explorer] sub-window is double-clicked. 

 If the File Display Window Is Not Open

• The windows for each of the files are opened from the program according to the file relationships set 
during installation.

• Double-click a file to load the file in the window indicated in the “Open Window” column. 
If the window is already open, the file is loaded to that window. 

File Name Program Name Open Window

Method file [Realtime Analysis] program [Data Acquisition] window

[Offline Editor] program [Method Editor] window

[Postrun Analysis] program [Calibration Curve] window
• If the method file contains calibration curve information, all 

data files for the standard samples that make up the 
calibration curve are loaded in the [Data Files] tree view. 

[Browser] program [Quant Browser] window
• If the method file contains calibration curve information, all 

standard sample data files that make up the calibration 
curve are loaded in the [Quantitative Results View]. 

Data file [Realtime Analysis] program [Data Analysis] window
[PDA Data Analysis] window

• The [PDA Data Analysis] window opens when data 
acquisition was performed by a photodiode array detector. 

[Offline Editor] program

[Postrun Analysis] program

[Browser] program [Quant Browser] window
• If the method file is not open in the [Quant Browser] window, 

the method file used to process the data files opens at the 
same time. 

Batch file [Realtime Analysis] program [Realtime Batch] window

[Offline Editor] program [Batch Editor] window

[Postrun Analysis] program [Postrun Batch] window

[Browser] program [Quant Browser] window
• The method file in the initial row of the Batch Table and all 

data files in the Batch Table open at the same time. 

Report format file [Realtime Analysis] program [Report] window

[Offline Editor] program

[Postrun Analysis] program

[Browser] program

Browsing file [Browser] program [Quant Browser] window
• The method file and data files open at the same time. 

Layout file [Browser] program [Data Browser] window
• All data files attached to the layout file open. 
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 If the File Display Window Is Open

An exclusive [Report] window for opens for displaying data report format data. 

File Name Double-Clicked File Handling Window

Method file [Data Acquisition] window

[Method Editor] window

[Calibration Curve] window
• If the method file contains calibration curve information, all data files for the 

standard samples that make up the calibration curve are loaded to the [Data Files] 
tree view. 

[Quant Browser] window
• If the method file contains calibration curve information, all standard sample data 

files that make up the calibration curve are loaded to [Quantitative Results View]. 

Data file [Data Analysis] window
[PDA Data Analysis] window

• The [PDA Data Analysis] window opens when data acquisition was performed by a 
photodiode array detector. 

[Data Comparison] window

[Data Browser] window

[Quant Browser] window
• If the method file is not open in the [Quant Browser] window, the method file used 

to process the data files opens at the same time. 
• If the method file contains calibration curve information, all data files for the 

standard samples that make up the calibration curve are loaded to the [Data Files] 
tree view. 

Batch file [Realtime Batch] window

[Batch Editor] window

[Postrun Batch] window

[Quant Browser] window
• The method file in the initial row of the Batch Table and all data files in the Batch 

Table open at the same time. 

Report format file [Report] window

Browsing file [Quant Browser] window
• The method file and data files open at the same time. 

Layout file [Data Browser] window
• All data files attached to the layout file open. 
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13.3.2Drag-and-Drop Files from the [Data Explorer] Sub-Window
The following table describes the operations equivalent to drag-and-drop to display the method file in a 
specific window. 

 Operations Equivalent To Drag-and-Drop

• Only the currently displayed data can be displayed in the exclusive [Report] window. 

• The method file cannot be opened in a [Calibration Curve] window opened from the [Quant Browser] 
window. 

File Name Drop Destination Window Operations Equivalent to Dragging-and-Dropping 

Method file [Data Acquisition] window [File] - [Open Method File]

[Method Editor] window

[Calibration Curve] window

[Quant Browser] window

[Data Analysis] window [File] - [Load Method Parameters]
• Default method parameter are set when the method 

file data does not match the instrument configuration. 
[PDA Data Analysis] window

Data file [Data Analysis] window [File] - [Open Data File]

[PDA Data Analysis] window

[Data Comparison] window [File] - [Open] - [Add Data File]

[Data Browser] window [File] - [Load Data to Cell]

[Calibration Curve] window [Data] - [Add]
• The data file is displayed in the [Data Files] tree view. 

[Quant Browser] window [Data] - [Add]
• If the method file is not open in the [Quant Browser] 

window, the method file used to process the data file 
opens at the same time. 

[Postrun Batch] window [Edit] - [Add Rows with Selected Data File]

[Report] window [File] - [Load Data File]

Batch file [Realtime Batch] window [File] - [Open Batch File]

[Batch Editor] window

[Postrun Batch] window

[Quant Browser] window [File] - [Load from Batch File]
• The method file in the initial row of the Batch Table 

and all data files in the Batch Table open at the same 
time. 

Report format file [Report] window [File] - [Open Report Format File]

Library file [UV Library Editor] window [File] - [Open Library File]

Browsing file [Quant Browser] window [Layout] - [Open Browsing File]
• The method file and data files in the browsing file 

open at the same time. 

Layout file [Data Browser] window [Layout] - [Open Layout File]
• All data files in the layout file open. 
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 Drag-and-Drop Onto a Report with the [Shift] Key Held Down

The following table describes the action when a file is dragged-and-dropped from the [Data Explorer] sub-
window onto a report item with the [Shift] key held down.

File Name Drop Destination Item Action

Method file [System Configuration] The system configuration information in the method file is 
displayed. 

[Method] The instrument parameters and data processing parameters 
in the method file are displayed. 

[Calibration Curve] The calibration curve information in the method file is 
displayed. 

Data file All places where data files 
can be loaded

Items are displayed individually. The chromatogram of the 
standard sample and the chromatograms of unknown 
samples can be displayed in a single report by dropping data 
files onto each item. 

• Multiple data files can be dragged-and-dropped onto 
the [Summary (Concentration)], [Summary 
(Compound)], and [Summary (Data)] items.

• Data files cannot be loaded in the [Line], [Arrow], 
[Rectangle], [Ellipse], [Picture], [UV Spectrum], and 
[UV Library] items.

Batch file [Batch Table] The table and batch table information are displayed. 

Batch files saved in text format cannot be loaded. 

Library file [UV Library] The spectrum information in the library file is displayed. 

System check result 
file

[System Check] Displays the results of the system check. 
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13.3.3Batch Table File Operations
This section describes the action when each cell in the method file, data files and report format files set to 
the Batch Table are clicked with the [Alt] key on your keyboard held down. 

While performing an operation on a file in the Batch Table, either select the file with the [Alt] key held down or 
double-click the file. To make changes, select [Options] on the [Tools] menu, and enter the changes on the 
[Batch Table Edit] tab in the [Setting Options] sub-window that opens.

File Name Program Name Open Window

Method file [Realtime Analysis] program [Data Acquisition] window

[Offline Editor] program [Method Editor] window

[Postrun Analysis] program [Calibration Curve] window
• If the method file contains calibration curve information, all 

data files for the standard samples that make up the 
calibration curve are loaded to the [Data Files] tree view. 

Data file [Realtime Analysis] program [Data Analysis] window
[PDA Data Analysis] window

• If data acquisition was performed with a photodiode array 
detector, the [PDA Data Analysis] window opens. 

[Offline Editor] program

[Postrun Analysis] program

Report format file [Realtime Analysis] program [Report] window

[Offline Editor] program

[Postrun Analysis] program
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